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1 Introduction

1.1 Hints for Using this Manual

Please consider the following hints:

For safe use of your device in all life cycles, we request that you carefully
read and consider this manual. The following hints serve as orientation for
the use of this manual.

1.2 Restriction of the User Group

This manual describes the use of the product exclusively for qualified
application programmers and software engineers that are familiar with the
safety concepts of the automation technology and the nationally valid
standards. Phoenix Contact does not assume any liability in case of
erroneous handling and damages resulting on products of Phoenix
Contact and external products because of disregarding of information in
this manual.

1.3 Explanation of Symbols Used

ATTENTION

The attention symbol refers to erroneous handling which
could lead to damage of the hardware or software in
indirect connection with dangerous process peripherals to
personal injury.

Note: The text marked in this way informs you of system-related
conditions that must absolutely be observed to achieve error-
free operation. Furthermore, notes give you tips and advice on
the efficient use of hardware and on software optimization.
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1.4 Statement of Legal Authority

This manual, including all illustrations contained herein, is copyright
protected. Use of this manual by any third party in departure from the
copyright provision is forbidden. Reproduction, translation or electronic
and photographic archiving or alteration requires the express written
consent of Phoenix Contact. Violations are liable for damages.

Phoenix Contact reserves the right to make any technical changes that
serve for the purpose of technical progress.

Phoenix Contact reserves all rights in the case of patent award or listing
of a registered design. External products are always named without
reference to patent rights. The existence of such rights shall not be
excluded.

The INTERBUS configurator CMD is mainly based on the INTERBUS
configurator IBS CMD G4 of

Phoenix Contact GmbH & Co.

Flachsmarktstr. 8-28

D-32825 Blomberg

Parts of this manual are extracted from the manual of Phoenix Contact. It
describes the functionality of CMD in combination with WinPCL in
System 200 of Rexroth Indramat. The original tool of Phoenix Contact
possibly offers more features that can not be used in combination with
System 200.

The original software was not adapted to the system and/or company
specifications.

Rexroth Indramat assumes the responsibility and the support for CMD
and this manual.
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2 Important Directions for Use

2.1 Appropriate Use

Introduction
Rexroth Indramat products represent state-of-the-art developments and
manufacturing. They are tested prior to delivery to ensure operating safety
and reliability.

The products may only be used in the manner that is defined as
appropriate. If they are used in an inappropriate manner, then situations
can develop that may lead to property damage or injury to personnel.

Note: Rexroth Indramat, as manufacturer, is not liable for any
damages resulting from inappropriate use. In such cases, the
guarantee and the right to payment of damages resulting from
inappropriate use are forfeited. The user alone carries all
responsibility of the risks.

Before using Rexroth Indramat products, make sure that all the pre-
requisites for  appropriate use of the products are satisfied:

• Personnel that in any way, shape or form uses our products must first
read and understand the relevant safety instructions and be familiar
with appropriate use.

• If the product takes the form of hardware, then they must remain in
their original state, in other words, no structural changes are permitted.
It is not permitted to decompile software products or alter source
codes.

• Do not mount damaged or faulty products or use them in operation.

• Make sure that the products have been installed in the manner
described in the relevant documentation.
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Areas of Use and Application
The INTERBUS configurator CMD is a global fieldbus configurator that
can be used in combination with the programming software WinPCL in
the system 200. CMD is for use in the following cases:

• Commissioning of INTERBUS devices

• Diagnostics

 Note: The INTERBUS configurator CMD may only be used with the
accessories and parts specified in this document. If a
component has not been specifically named, then it may not
be either mounted or connected. The same applies to cables
and lines.

Operation is only permitted in the specified configurations and
combinations of components using the software and firmware
as specified in the relevant function descriptions.

2.2 Inappropriate Use

Using the INTERBUS configurator CMD outside of the above-referenced
areas of application or under operating conditions other than described in
the document and the technical data specified is defined as “inappropriate
use".

The INTERBUS configurator CMD may not be used

• if it is subject to operating conditions that do not meet the above
specified ambient conditions,

• for applications that Rexroth Indramat has not specifically released for
the intended purpose. Please note the specifications outlined in the
general Safety Instructions!
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3 Safety Instructions for Electric Drives and Controls

3.1 Introduction

Read these instructions before the initial startup of the equipment in order
to eliminate the risk of bodily harm or material damage. Follow these
safety instructions at all times.

Do not attempt to install or start up this equipment without first reading all
documentation provided with the product. Read and understand these
safety instructions and all user documentation of the equipment prior to
working with the equipment at any time. If you do not have the user
documentation for your equipment, contact your local Rexroth Indramat
representative to send this documentation immediately to the person or
persons responsible for the safe operation of this equipment.

If the equipment is resold, rented or transferred or passed on to others,
then these safety instructions must be delivered with the equipment.

WARNING

Improper use of this equipment, failure to follow
the safety instructions in this document or
tampering with the product, including disabling
of safety devices, may result in material
damage, bodily harm, electric shock or even
death!

3.2 Explanations

The safety instructions describe the following degrees of hazard
seriousness in compliance with ANSI Z535. The degree of hazard
seriousness informs about the consequences resulting from non-
compliance with the safety instructions.

Warning symbol with signal
word

Degree of hazard seriousness according
to ANSI

DANGER

Death or severe bodily harm will occur.

WARNING

Death or severe bodily harm may occur.

CAUTION

Bodily harm or material damage may occur.

Fig. 3-1: Hazard classification (according to ANSI Z535)
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3.3 Hazards by Improper Use

DANGER

High voltage and high discharge current!
Danger to life or severe bodily harm by electric
shock!

DANGER

Dangerous movements! Danger to life, severe
bodily harm or material damage by
unintentional motor movements!

WARNING

High electrical voltage due to wrong
connections! Danger to life or bodily harm by
electric shock!

WARNING

Health hazard for persons with heart
pacemakers, metal implants and hearing aids in
proximity to electrical equipment!

CAUTION

Surface of machine housing could be extremely
hot! Danger of injury! Danger of burns!

CAUTION

Risk of injury due to improper handling! Bodily
harm caused by crushing, shearing, cutting and
mechanical shock or incorrect handling of
pressurized systems!

CAUTION

Risk of injury due to incorrect handling of
batteries!
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3.4 General Information

• Rexroth Indramat GmbH is not liable for damages resulting from
failure to observe the warnings provided in this documentation.

• Read the operating, maintenance and safety instructions in your
language before starting up the machine. If you find that you cannot
completely understand the documentation for your product, please ask
your supplier to clarify.

• Proper and correct transport, storage, assembly and installation as
well as care in operation and maintenance are prerequisites for
optimal and safe operation of this equipment.

• Only persons who are trained and qualified for the use and operation
of the equipment may work on this equipment or within its proximity.

• The persons are qualified if they have sufficient knowledge of the
assembly, installation and operation of the equipment as well as
an understanding of all warnings and precautionary measures
noted in these instructions.

• Furthermore, they must be trained, instructed and qualified to
switch electrical circuits and equipment on and off in accordance
with technical safety regulations, to ground them and to mark them
according to the requirements of safe work practices. They must
have adequate safety equipment and be trained in first aid.

• Only use spare parts and accessories approved by the manufacturer.

• Follow all safety regulations and requirements for the specific
application as practiced in the country of use.

• The equipment is designed for installation in industrial machinery.

• The ambient conditions given in the product documentation must be
observed.

• Use only safety features and applications that are clearly and explicitly
approved in the Project Planning Manual.
For example, the following areas of use are not permitted: construction
cranes, elevators used for people or freight, devices and vehicles to
transport people, medical applications, refinery plants, transport of
hazardous goods, nuclear applications, applications sensitive to high
frequency, mining, food processing, control of protection equipment
(also in a machine).

• The information given in the documentation of the product with regard
to the use of the delivered components contains only examples of
applications and suggestions.
The machine and installation manufacturer must

• make sure that the delivered components are suited for his
individual application and check the information given in this
documentation with regard to the use of the components,

• make sure that his application complies with the applicable safety
regulations and standards and carry out the required measures,
modifications and complements.

• Startup of the delivered components is only permitted once it is sure
that the machine or installation in which they are installed complies
with the national regulations, safety specifications and standards of the
application.

• Technical data, connections and operational conditions are specified in
the product documentation and must be followed at all times.
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• Operation is only permitted if the national EMC regulations for the
application are met.
The instructions for installation in accordance with EMC requirements
can be found in the documentation "EMC in Drive and Control
Systems".
The machine or installation manufacturer is responsible for
compliance with the limiting values as prescribed in the national
regulations.

3.5 Protection Against Contact with Electrical Parts

Note: This section refers to equipment and drive components with
voltages above 50 Volts.

Touching live parts with voltages of 50 Volts and more with bare hands or
conductive tools or touching ungrounded housings can be dangerous and
cause electric shock. In order to operate electrical equipment, certain
parts must unavoidably have dangerous voltages applied to them.

 
DANGER

High electrical voltage! Danger to life, severe
bodily harm by electric shock!
⇒ Only those trained and qualified to work with or on

electrical equipment are permitted to operate, maintain
or repair this equipment.

⇒ Follow general construction and safety regulations when
working on high voltage installations.

⇒ Before switching on power the ground wire must be
permanently connected to all electrical units according
to the connection diagram.

⇒ Do not operate electrical equipment at any time, even
for brief measurements or tests, if the ground wire is not
permanently connected to the points of the components
provided for this purpose.

⇒ Before working with electrical parts with voltage higher
than 50 V, the equipment must be disconnected from
the mains voltage or power supply. Make sure the
equipment cannot be switched on again unintended.

⇒ The following should be observed with electrical drive
and filter components:

⇒ Wait five (5) minutes after switching off power to allow
capacitors to discharge before beginning to work.
Measure the voltage on the capacitors before beginning
to work to make sure that the equipment is safe to
touch.

⇒ Never touch the electrical connection points of a
component while power is turned on.

⇒ Install the covers and guards provided with the
equipment properly before switching the equipment on.
Prevent contact with live parts at any time.

⇒ A residual-current-operated protective device (RCD)
must not be used on electric drives! Indirect contact
must be prevented by other means, for example, by an
overcurrent protective device.

⇒ Electrical components with exposed live parts and
uncovered high voltage terminals must be installed in a
protective housing, for example, in a control cabinet.
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To be observed with electrical drive and filter components:

DANGER

High electrical voltage on the housing!
High leakage current! Danger to life, danger of
injury by electric shock!
⇒ Connect the electrical equipment, the housings of all

electrical units and motors permanently with the safety
conductor at the ground points before power is
switched on. Look at the connection diagram. This is
even necessary for brief tests.

⇒ Connect the safety conductor of the electrical
equipment always permanently and firmly to the
supply mains. Leakage current exceeds 3.5 mA in
normal operation.

⇒ Use a copper conductor with at least 10 mm² cross
section over its entire course for this safety conductor
connection!

⇒ Prior to startups, even for brief tests, always connect
the protective conductor or connect with ground wire.
Otherwise, high voltages can occur on the housing
that lead to electric shock.

3.6 Protection Against Electric Shock by Protective Low
Voltage (PELV)

All connections and terminals with voltages between 0 and 50 Volts on
Rexroth Indramat products are protective low voltages designed in
accordance with international standards on electrical safety.

WARNING

High electrical voltage due to wrong
connections! Danger to life, bodily harm by
electric shock!
⇒ Only connect equipment, electrical components and

cables of the protective low voltage type (PELV =
Protective Extra Low Voltage) to all terminals and
clamps with voltages of 0 to 50 Volts.

⇒ Only electrical circuits may be connected which are
safely isolated against high voltage circuits. Safe
isolation is achieved, for example, with an isolating
transformer, an opto-electronic coupler or when
battery-operated.  

3.7 Protection Against Dangerous Movements

Dangerous movements can be caused by faulty control of the connected
motors. Some common examples are:

• improper or wrong wiring of cable connections

• incorrect operation of the equipment components

• wrong input of parameters before operation

• malfunction of sensors, encoders and monitoring devices

• defective components

• software or firmware errors
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Dangerous movements can occur immediately after equipment is
switched on or even after an unspecified time of trouble-free operation.

The monitoring in the drive components will normally be sufficient to avoid
faulty operation in the connected drives. Regarding personal safety,
especially the danger of bodily injury and material damage, this alone
cannot be relied upon to ensure complete safety. Until the integrated
monitoring functions become effective, it must be assumed in any case
that faulty drive movements will occur. The extent of faulty drive
movements depends upon the type of control and the state of operation.

 
DANGER

Dangerous movements! Danger to life, risk of
injury, severe bodily harm or material damage!
⇒ Ensure personal safety by means of qualified and

tested higher-level monitoring devices or measures
integrated in the installation. Unintended machine
motion is possible if monitoring devices are disabled,
bypassed or not activated.

⇒ Pay attention to unintended machine motion or other
malfunction in any mode of operation.

⇒ Keep free and clear of the machine’s range of motion
and moving parts. Possible measures to prevent
people from accidentally entering the machine’s range
of motion:

- use safety fences

- use safety guards

- use protective coverings

- install light curtains or light barriers

⇒ Fences and coverings must be strong enough to
resist maximum possible momentum, especially if
there is a possibility of loose parts flying off.

⇒ Mount the emergency stop switch in the immediate
reach of the operator. Verify that the emergency stop
works before startup. Don’t operate the machine if the
emergency stop is not working.

⇒ Isolate the drive power connection by means of an
emergency stop circuit or use a starting lockout to
prevent unintentional start.

⇒ Make sure that the drives are brought to a safe
standstill before accessing or entering the danger
zone. Safe standstill can be achieved by switching off
the power supply contactor or by safe mechanical
locking of moving parts.

⇒ Secure vertical axes against falling or dropping after
switching off the motor power by, for example:

- mechanically securing the vertical axes

- adding an external braking/ arrester/ clamping
mechanism

- ensuring sufficient equilibration of the vertical axes

The standard equipment motor brake or an external
brake controlled directly by the drive controller are
not sufficient to guarantee personal safety!
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⇒ Disconnect electrical power to the equipment using a
master switch and secure the switch against
reconnection for:

- maintenance and repair work

- cleaning of equipment

- long periods of discontinued equipment use

⇒ Prevent the operation of high-frequency, remote
control and radio equipment near electronics circuits
and supply leads. If the use of such equipment cannot
be avoided, verify the system and the installation for
possible malfunctions in all possible positions of
normal use before initial startup. If necessary, perform
a special electromagnetic compatibility (EMC) test on
the installation.

3.8 Protection Against Magnetic and Electromagnetic Fields
During Operation and Mounting

Magnetic and electromagnetic fields generated near current-carrying
conductors and permanent magnets in motors represent a serious health
hazard to persons with heart pacemakers, metal implants and hearing
aids.

WARNING

Health hazard for persons with heart
pacemakers, metal implants and hearing aids in
proximity to electrical equipment!
⇒ Persons with heart pacemakers, hearing aids and

metal implants are not permitted to enter the following
areas:

- Areas in which electrical equipment and parts are
mounted, being operated or started up.

- Areas in which parts of motors with permanent
magnets are being stored, operated, repaired or
mounted.

⇒ If it is necessary for a person with a heart pacemaker
to enter such an area, then a doctor must be
consulted prior to doing so. Heart pacemakers that
are already implanted or will be implanted in the
future, have a considerable variation in their electrical
noise immunity. Therefore there are no rules with
general validity.

⇒ Persons with hearing aids, metal implants or metal
pieces must consult a doctor before they enter the
areas described above. Otherwise, health hazards will
occur.
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3.9 Protection Against Contact with Hot Parts

CAUTION

Housing surfaces could be extremely hot!
Danger of injury! Danger of burns!
⇒ Do not touch housing surfaces near sources of heat!

Danger of burns!
⇒ After switching the equipment off, wait at least ten (10)

minutes to allow it to cool down before touching it.
⇒ Do not touch hot parts of the equipment, such as

housings with integrated heat sinks and resistors.
Danger of burns!

3.10 Protection During Handling and Mounting

Under certain conditions, incorrect handling and mounting of parts and
components may cause injuries.

CAUTION

Risk of injury by incorrect handling! Bodily
harm caused by crushing, shearing, cutting and
mechanical shock!
⇒ Observe general installation and safety instructions

with regard to handling and mounting.
⇒ Use appropriate mounting and transport equipment.
⇒ Take precautions to avoid pinching and crushing.
⇒ Use only appropriate tools. If specified by the product

documentation, special tools must be used.
⇒ Use lifting devices and tools correctly and safely.
⇒ For safe protection wear appropriate protective

clothing, e.g. safety glasses, safety shoes and safety
gloves.

⇒ Never stand under suspended loads.
⇒ Clean up liquids from the floor immediately to prevent

slipping.
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3.11 Battery Safety

Batteries contain reactive chemicals in a solid housing. Inappropriate
handling may result in injuries or material damage.

CAUTION

Risk of injury by incorrect handling!
⇒ Do not attempt to reactivate discharged batteries by

heating or other methods (danger of explosion and
cauterization).

⇒ Never charge non-chargeable batteries (danger of
leakage and explosion).

⇒ Never throw batteries into a fire.
⇒ Do not dismantle batteries.
⇒ Do not damage electrical components installed in the

equipment.

Note: Be aware of environmental protection and disposal! The
batteries contained in the product should be considered as
hazardous material for land, air and sea transport in the sense
of the legal requirements (danger of explosion). Dispose
batteries separately from other waste. Observe the legal
requirements in the country of installation.

3.12 Protection Against Pressurized Systems

Certain motors and drive controllers, corresponding to the information in
the respective Project Planning Manual, must be provided with
pressurized media, such as compressed air, hydraulic oil, cooling fluid
and cooling lubricant supplied by external systems. Incorrect handling of
the supply and connections of pressurized systems can lead to injuries or
accidents. In these cases, improper handling of external supply systems,
supply lines or connections can cause injuries or material damage.

 CAUTION

Danger of injury by incorrect handling of
pressurized systems !
⇒ Do not attempt to disassemble, to open or to cut a

pressurized system (danger of explosion).
⇒ Observe the operation instructions of the respective

manufacturer.
⇒ Before disassembling pressurized systems, release

pressure and drain off the fluid or gas.
⇒ Use suitable protective clothing (for example safety

glasses, safety shoes and safety gloves)
⇒ Remove any fluid that has leaked out onto the floor

immediately.

Note: Environmental protection and disposal! The media used in the
operation of the pressurized system equipment may not be
environmentally compatible. Media that are damaging the
environment must be disposed separately from normal waste.
Observe the legal requirements in the country of installation.
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Notes
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4 Quick-start CMD and WinPCL

4.1 General Information

The configuration of the fieldbus modules as for example INTERBUS and
PROFIBUS in combination with the programming interface WinPCL is
executed by special external configuration tools. Thereby, the advantage
is that powerful programs are available allowing an easy configuration,
operation and diagnostics of the fieldbuses.

The following sections only describe the essential proceeding for the
configuration of a fieldbus. For further information refer to the
corresponding manual.

4.2 INTERBUS Configuration

Software Tool IBS CMD G4
To configure the INTERBUS, software IBS CMD G4 (for short: CMD) is
available. Besides the bus configuration this program also allows the
monitoring and diagnostics in case of an error.

Component Selection
After starting the installation program and entering the serial number a
dialog appears with which the components to be installed have to be
selected. Besides the program IBS CMD driver RS 232 has to be
selected. Then, the IBS ISA SC driver has to be deactivated.

Furthermore, ensure that the directories of the destination folder has not
more than eight letters.

04_komponenten_waehlen.bmp

Fig. 4-1: Selection of the components to be installed
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Password Entry
The following dialog requests passwords. These must not be entered:

04_passworte.bmp

Fig. 4-2: Password dialog

Offline/Online Operation
As the bus structure planning of an installation and the configuration of
the individual devices is also possible during offline operation (i.e. without
connection to the controller board), monitoring and bus diagnostics is only
possible during online operation. To start the online operation, connect
the diagnostics interface X64 of the INTERBUS module via a serial
interface RS232 (KB0030) with a serial COM1 to COM4 interface of the
PC. If this cable is not available, alternatively, a serial connection (Pin 2 ->
2, Pin 3 -> 3 and Pin 5 -> 5) can be created.

Proceedings INTERBUS Configuration
The following sections describe an INTERBUS online configuration
without process data preprocessing.
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Create New Project
Select menu File/New. A new project is created as in Abb. 4-3.

04_datei_neu.bmp

Abb. 4-3: New project

Select Controller Board Type
Select the element "Controller Board" with the right mouse button. Chose
the entry "Type …" in the context menu.

04_select_typ.bmp

Fig. 4-4: Selection of controller board type
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Mark type "IBS PC104 SC-T" in the "Select Controller Board" window and
confirm with OK (see Fig. 4-5: Selection of the controller board type).

04_select_pc104_typ.bmp

Fig. 4-5: Selection of the controller board type



INTERBUS Configurator CMD Quick-start CMD and WinPCL 4-5

DOK-CONTRL-IBS*CMD****-AW01-EN-P           

Communication Path Settings
To read in the configuration, it is necessary that a connection from CMD
to the controller board is created (see offline/online operation). The
corresponding communication path has to be set depending on the
interface connected with the controller board. To do so, call-up the
"Controller Board" context menu with the right mouse button and select
"Communication Path …". Then, set the corresponding interface project-
specific in window "Communication Path Settings".

04_communciation1.bmp

Fig. 4-6: Setting of the communication path
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In the following dialog box the corresponding interface can be selected
project-specific or generally (standard).

04_communciation2.bmp

Fig. 4-7: Dialog box to set the communication path

Read In Configuration Frame (from memory)
To read in the bus configuration, select the element "Configuration
Frame" with the right mouse button. Select then entry "Read In (from
memory)" in the context menu.

04_config_rahmen1.bmp

Fig. 4-8: Read in configuration frame

Thereupon, the dialog box "Set Operating State" appears which has to be
confirmed with "Yes". In this case, the existing configuration frame is read
in and the bus devices are represented corresponding to the bus
structure.
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Note: If the bus configuration is changed without resetting the
controller board (control reset, voltage reset), the changed bus
configuration is not recognized (e.g. after extension of the bus
configuration) during reading in the configuration frame (bus
configuration). The configuration frame is read out of the
memory and represented.

In this case, deactivate the configuration frame with the
"Controller Board" context menu Å ’Operate’ Å ’Read In
Configuration Frame’ and afterwards read it in again.

04_busaufbau_einlesen.bmp

Fig. 4-9: Read in bus configuration

A precondition that the configuration frame is read in completely is that
there’s no error in the bus structure. Otherwise, the status changes
automatically to "Diagnostics". In this state an error localization is
executed and corresponding hints to localize the errors are given. If an
error occurs, the status changes from OFFLINE to BUS ACTIVE.
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Process Data Assignment
After the bus configuration has been read in, the addresses of the
individual devices are automatically assigned corresponding to their
physical position in the ring of CMD. You will receive an overview of all
device addresses when opening the entry "Process Data …" in the
controller board's context menu.

04_Prozessdaten.bmp

Fig. 4-10: Process data of all devices

In the right column "Assignment" you will find the addresses assigned by
CMD. A changing of the addresses is possible by double-clicking the left
mouse button.

Note: Bit modules are summarized to common byte addresses until
the byte is occupied or the module does not fit in the byte
anymore, i.e. the individual bits of a module are not divided up
to different bytes.

Word modules (16 bit) are always starting with even
addresses.

In combination with WinPCL this addresses correspond to the respective
start address in the Dual Port RAM.
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Standard and Function Register
If the INTERBUS control blocks (DIAG_OFF, DIAG_ON, START_D,
STOP_D, CLR_DIAG) in the PLC program or the two diagnostics and
status registers of the INTERBUS are used, the addresses of this
registers have to be determined. To do so, open the ’Settings’ menu in the
context menu of the controller board.

04_adressen_register.bmp

Fig. 4-11: Address assignment of the standard register

Principally, the addresses of the individual registers can be freely
selected, as they don’t come into conflict with the existing addresses of
the modules (process data). A double addressing is not possible, if
addresses offered in the pull-down menu are used.

Note: If the register addresses are assigned before the configuration
frame is read in, there will occur address conflicts after the
configuration frame is read in. These are recognized with the
execution of the parameterization and displayed in a dialog
box.
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Starting-up Behavior/Parameterization of the INTERBUS
Parameterizations allow to realize different starting-up behaviors, for
example, with or without process data processing. To do so, call-up the
"Controller Board" context menu and select ’Parameterization’ ->
’Execute’.

04_parametrierung1.bmp

Fig. 4-12: Context menu ’Parameterization’
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Exemplary, ’Start-up without PDP’ is selected in the following window,
because no process data preprocessing should be executed on the
INTERBUS controller board. For further information about the process
data preprocessing refer to the CMD online help.

After a successful parameterization the status of the INTERBUS changes
from "Bus Active’ to "Bus Runs’, i.e. data cycles are run.

In case of an address conflict the parameterization can not be executed.
A corresponding message specifying the coinciding addresses appears.

04_parametrierung2.bmp

Fig. 4-13: Parameterization without preprocessing

Save Project
Select the "File/Save As …" menu and assign a project name (max. 8
characters).
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Parameterization Memory
The parameterization memory is used for resident storage of INTERBUS
parameterization, program and diagnostic data. After each control reset
the INTERBUS is re-initialized with data from the parameterization
memory.

To save the data, select the element "Parameterization Memory" with the
right mouse button and in the context menu entry "Write".

04_save_para1.bmp

Fig. 4-14: Write parameterization memory

In the appearing dialog box you can chose whether only INTERBUS data
shall be written in the parameterization memory or in addition, project-
specific data. Only in the last-mentioned case, the entire project can be
re-read from the parameterization memory, i.e. all settings, descriptions of
the devices, etc. are stored on the controller board.

Note: With the programming interface WinPCL a new controller
board with configuration memory has been introduced. It has
the designation ’LK IBM02/02 PC104’. For the versions lower
than V21 controller boards without configuration frame have
been used (designation: ’LK IBM 2 PC104’ ). These modules
can not be used.
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Programming Interface WinPCL

I/O Editor
To assign the addresses between the INTERBUS controller board and
the variables, the I/O editor is available in the programming interface
WinPCL ("View/IO editor" menu) on resource level.

04_io_editor1.bmp

Fig. 4-15: Call-up I/O editor on resource level

Principally, there are several possibilities to select an I/O data assignment
of the INTERBUS to the logic devices of the programming interface. For
further information refer to the documentation "Programming with
WinPCL" (German edition MN: 291135; English edition MN: 291134).

For example, it is possible to assign logic number 1 to the module inputs,
logic number 10 to the standard registers (input), logic 2 to the module
outputs and logic number 20 to the standard register (outputs).

Referring to Fig. 4-10: Process data of all devices the 4 bytes length if
the module’s input bytes result in:

1 byte on byte0: 2 bit module + 4 bit module,

1 blank byte on byte1 (16 bit modules starting on even addresses)

2 bytes for the 16 bit module on byte2 and 3.

The 4 byte length of the modules’ output byte result in:

1 byte on byte0: 4 bit module,

1 byte on byte0: 8 bit module and,

2 bytes for the 16 bit module.
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04_io_editor_ausgefuellt.bmp

Fig. 4-16: I/O editor

Declaration Editor
Based on the I/O editor definition you can access the inputs and outputs
of the individual modules and/or the standard registers by the following
variable declarations:

04_dekl-editor.bmp

Fig. 4-17: Declaration editor
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4.3 Installation and Use of the Indramat Device Database

Creation of the Bus Structure
Principally, there are several possibilities to create the bus structure.

1. Online with the configuration frame’s context menu "Read In (From
memory)

2. Offline with the context menu "Insert With ID Code"

3. Offline with the context menu "Insert With Description"

Regarding the first two possibilities the bus devices are only represented
as standard devices containing the following information:

• IDENT Code

• Process data channel length

• Standard icon

If the individual bus devices are represented with a device description
form the Indramat device database, these manufacturer-specific
information (device type, article no., etc.) appears as well as with a
product-specific icon.

Installation of the Indramat Device Database
Proceeding to install the Indramat device database:

Start the SETUP.EXE. You will find the Indramat device database in
directory …\Database\de on the C DSWD-WinPCL-PO*-0*VRS.

Specify the source directory of the database file INDRAMAT.MDB.

Specify the destination directory and/or the installation directory of CMD;
e.g. C:\IBSCMD

Specify the database name. Under this name the Indramat database
appears in CMD. Indramat is preselected as default name.

Selection of the options to be installed. Select both options. The selection
can be later changed in CMD.

Application of the Indramat Device Database
After creating the bus structure, you can link the standard device
descriptions with the device descriptions of the Indramat device database.
The proceeding is described in chapter menu "Edit … Link With
Description" on page 6-16.
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5 General Information

5.1 Basic Principles

INTERBUS, the fast, universal sensor/actuator bus system.

The INTERBUS network (or IBS for short) shifts the I/O level from the
master PLC or PC system (Host) directly to the machine or system. A
serial bus cable connects the host with the I/O modules installed in the
system. This reduces the amount of wiring involved to a minimum
compared to conventional parallel wiring.

05_ser-par.bmp

Fig. 5-1: Basic principles

5.2 Automation with INTERBUS

The constantly growing degree of automation and the more complex
requirements of production and process engineering demand more and
more powerful sensors and actuators for the special application. Today,
the INTERBUS system is already supported as open bus system by more
than 600 equipment manufacturers with various products. This enables
you, as the user, to select the most efficient and economical system
components for your application.
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5.3 Device Types

Controller boards for

• Programmable logic controls (PLC)

• Computer systems such as PCs, VME systems and industrial
computers

Input/output units for

• Analog input/output

• Digital input/output

• Degree of protection IP 20/65/67

High-tech modules for

• Wrenching controls

• Positioning controls

• Robot controls

• Drives

• DRIVECOM standard

• Frequency converter, servo drives

• General drive engineering

• Pneumatic valve terminals

• Hydraulic valve terminals

• Encoders

• ENCOM standard

• Identification systems

• Operating and display equipment

• MMICOM standard
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5.4 Topology

The INTERBUS network is installed as compact line following one
direction. Starting at the controller board, the bus system connects the
respective PLC or PC system (Host) with the INTERBUS devices installed
in the periphery (e.g. digital and analog I/O modules).

05_topo.bmp

Fig. 5-2: INTERBUS topology

The main line installed through the system is known as the remote bus
and bridges the distances between the distributed sub-stations. The
whole remote bus may be up to 12.8 km long (from the controller board to
the last remote bus device). The remote bus branch or local bus may
branch off from the remote bus.

From the remote bus, side lines (branching lines) are possible as local
branching lines. These are known – depending on their type – as remote
bus, installation remote bus or local bus.

The local bus is designed for low-cost, flexible configuration of a
distributed sub-station in cabinets and terminal boxes. A bus terminal
module (BK module) starts the local bus. The local bus cables connect
the various local bus modules to the respective BK module and to each
other.

The installations remote bus corresponds in its configuration to the
remote bus but offers the option of carrying a supply voltage for sensors
in the cable (hybrid cable structure). The installation remote bus can be
configured with CDI, CDO, DIO modules and other installation remote bus
devices. It is suitable for configuring distributed sub-stations with direct
connection of sensors and actuators. This results in a shorter and less
expensive sensor/actuator connection.

Remote Bus

Local Bus

Installation Remote Bus
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5.5 Program Description

IBS CMD G4 is a software which enables interactive and control-
independent configuration, operation and diagnostics of all connected
devices in an INTERBUS network.

05_cmdlogo.bmp

Fig. 5-3: Parameterization of all INTERBUS devices

IBS CMD G4 runs on standard PCs under MS-Windows and can be used
for a number of INTERBUS controller boards. The connection to a
controller board can be realized on two communication paths:

Through a serial interface (RS 232 level) Connect one the serial ports of
your PC (COM1 to COM4) with the diagnostic interface on the front panel
of the host controller board. The connection is realized by a serial
connecting cable.

For PC controller boards through the respective slot (e.g. ISA bus). If
there are several PC controller boards in one PC, the respective board
number of the controller board must be specified. Board numbers from 1
to 8 are possible.

If you press the right mouse button on a selected element, a context
menu containing all functions available for this element opens. In addition,
the entries in the main menu are adapted accordingly to the functions
assigned to the device.
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Connecting Cable
You use the serial connecting cable (IKB0030/000,0, MN: 291736) to
connect the serial interface of your PC with the diagnostic interface of the
controller board or the system coupler.

05_kabel.bmp

Fig. 5-4: Connecting cable

5.6 Configuration

With the aid of these menu commands in IBS CMD G4 you can design a
complete bus configuration for a system and configure all devices
connected to INTERBUS. For example, you can add new devices or
search for devices. It is possible to assign addresses, variables and direct
links (other process data descriptions) to the input/output channels of the
bus devices. You can combine individual bus segments to form groups. It
is also possible to check the bus configuration before startup.

05_desi-1.bmp

Fig. 5-5: Configuration
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5.7 Monitoring

With the aid of these add-on programs you can monitor and manipulate
the data of all connected devices. The process data of connected devices
can be displayed or output states can be changed during system
operation. The presentation of the displayed data depends on the
individual device and/or the device description supplied by the
manufacturer. Furthermore, it is possible to select an optimized
presentation (e.g. numerical value or bar chart).

05_desi-2.bmp

Fig. 5-6: Monitoring
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5.8 Diagnostics

This operating status  offers you fast and effective help concerning the
recognition, localization and elimination of error sources in the system.
This includes, for example, the recognition of defective bus devices,
missing local bus voltage and errors in the connected sensors and
actuators.

05_desi-3.bmp

Fig. 5-7: Diagnostics

5.9 Add-on Programs

The software IBS CMD G4 enables the integration of add-on programs
(monitoring, diagnostics and configuration programs) which are, for
example, specially provided by the device manufacturers for their devices.

Add-on programs that can be integrated via a standardized interface can
manufacturer-independently parameterize and monitor the connected
devices of an INTERBUS network.

Manufacturers of INTERBUS devices can use the fixed interface to
develop own programs especially for their devices and link them into IBS
CMD G4.

Note: You can request a description of the standardized interface(s)
from the INTERBUS-S Club e. V.

INTERBUS-S Club e.V.

Branch

Postfach 1108

32817 Blomberg, Germany

Phone: +49-(0)-52 35 - 34 21 00

Fax: +49-(0)-52 35 - 34 12 34
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5.10 Hardware Requirements

You should at least have the following hardware/software equipment to
operate IBS CMD G4:

• 80486 processor with 33 MHz (Pentium 90 MHz recommended)

• 8 Mbytes RAM (32 Mbytes recommended)

• 35 Mbytes free hard disk space

• 3,5” floppy disk drive and/or CD_ROM

• Mouse

• Windows 3.1 or higher

• Serial interface (COM1 … COM4)

• Parallel interface (LPT1 … LPT2)

• INTERBUS Generation 4 controller board

Occasionally, the free conventional memory may not be sufficient. In this
case, remove unnecessary memory resident programs and drivers such
as the DOS mouse driver, CD-ROM, scanner, sound driver or load these
programs into a memory area above 640 Kbytes.

5.11 Checking the Hardware

ATTENTION

⇒ When installing the INTERBUS system, several
regulations must be considered which cannot be
checked by the IBS CMD G4 software or are
presently not being checked.

Examples:

You may not exceed the maximum distance between two INTERBUS
devices. Depending on the device type (remote bus, local bus, installation
local bus, ST …) the maximum distance between two devices may differ.

The wiring of INTERBUS, especially the remote bus cables and the
connection of the sensors/actuators, must meet special regulations.
These regulations include:

• a large-area shield

• shielded, twisted pair sensor lines

• a correct PE connection
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5.12 General Operating Instructions

05_all-bes.bmp

Fig. 5-8: Main window

Operating and Display Elements
The name of the program (IBS CMD G4), the path, and the name of the
central project file are displayed.

The menu bar contains the menu entries to control the programs. Every
menu item is assigned a pop-up window in which the menu commands
are listed. The content of a sub-menu is variable. These are the context-
sensitive menus that offer the convenient menu for the respective
element.

The function key bar permits a faster program operation. The most
important menu commands are included in the function key bar as
buttons. You can execute the appropriate command by pressing the
buttons.

The representation area is the area between the function key bar and the
status line. It displays the devices and the bus topology. When the
available display structure is exceeded, scroll bars appear which you can
use to move the bus topology within the window.

The status line is located at the bottom of the screen and contains various
status information. Among other things, you will see the operating status
of IBS CMD G4. The “Status” box is displayed in gray in the
“Configuration (Offline)” operating state. In the “Online operating states” it
may adopt the colors green or red depending on whether there is fault or
the bus is in operation.

Title Bar

Menu Bar

Function Key Bar

Representation Area

Status Line



5-10 General Information INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P

Operation with the Keyboard
After changing to menu bar with <ALT>, use <Right> or <Left> arrow key
to select the menu items. You open the marked menu with <ENTER<
Menus which contain an underscored letter can be called with the key
combination <Alt> + <Letter>. You exit the menu and return to the
representation area with the <Alt> or <F10> key.

On the one hand, you can select menu items from sub-menus with the
arrow key <Up> or <Down> and then confirm with <Enter> or, on the
other hand, by entering the underscored letter directly. A grayed out menu
entry is inactive. A check marks an active command or a selected feature.
Often a command can be called directly by function keys or a <CTRL>
key combination.

Press the <TAB> key to move forwards or the <SHIFT> + <TAB> key to
move backwards in the dialog box. If the name of the dialog element
contains an underscored letter, press the <Alt> + <Letter> keys to jump
directly to the dialog selection.

5.13 Project Structure

An automation project can be divided as follows:

A project may consist of several PLCs/PCs. Several controller boards
may be installed in one PLC/PC system. There may be several
configuration frames on one controller board which contains INTERBUS
devices.

The representation of a project in IBS CMD G4, therefore, always
contains the following basic structure:

• Project

• PLC/PC

• Program

• Controller board

• Parameterization memory

• Preprocessing

• Configuration frame

05_projekt.bmp

Fig. 5-9: Description of the single elements

Selecting or Canceling Menus

Selecting Menu Items

Moving around in the Dialog Box



INTERBUS Configurator CMD General Information 5-11

DOK-CONTRL-IBS*CMD****-AW01-EN-P

5.14 Project Files

IBS CMD G4 generates the following project files:

Contains the actual bus topology, the configuration, the addressing, etc.

Diagnostics message file. This file only appears if you change to the
“Diagnostics” operating state and messages arrive.

Diagnostics statistics file. This file only appears if you change to the
“Diagnostics” operating state.

Project initialization file.

All files of a project are stored on the hard disk in a common directory.
Loading and saving is carried out using a Windows file menu. With the
“Save As” dialog box, all files with this project name are copied. If files
already exist with the same name in the target directory, an overwrite
warning is issued.

Other files:

There are a number of other file types in addition to the central project
files.

In this files you can store individual worksheets from the preprocessing.

In this files you can store the parameterization of your INTERBUS
projects. For example, the parameterization contains the startup behavior
of INTERBUS and the bus topology.

The SVC file contains the complete parameterization and can be used in
controller boards without parameterization memory. The SVC file is an
ASCII file.

Comma Separated Value. The SVC file is used to make the project data
(*.BG4) available in binary format accessible to other programs.

The PEX file is a CSV-format text file that can be re-imported. It contains
all project information in the BG4 file.

You can transfer the INTERBUS structure and the process data
assignments to the “EPLAN” program via these files.

In the FCX files you can save macros, user functions and events. These
are listed under the menu item “Functions” in the context menu of the
controller board.

5.15 Description of Elements

The elements available in the workspace are:

Project, PLC/PC, program, controller board, parameterization memory,
preprocessing and configuration frame as well as every device can be
described respectively by a special dialog box. In these dialog boxes,
information about the type, programmer, position, comment, etc. can be
assigned to the individual elements.

<PROJEKT>.BG4

<PROJEKT>.MES

<PROJEKT>.STC

<PROJEKT>.INI

*.GP

*.PAX

*.SVC

*.CSV

*.PEX

*.EPL

*.FCX



5-12 General Information INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P



INTERBUS Configurator CMD Menu Structure 6-1

DOK-CONTRL-IBS*CMD****-AW01-EN-P

6 Menu Structure
Some of the menu items are context menus. The entries in these context
menus depend on the selected element in the representation area. Only
the menu items valid and useful for an element are displayed. For
example, the element “Device” or the element “Project” are assigned to a
corresponding menu. The context menu can be called with the right
mouse button.

06_menue.bmp

Fig. 6-1: Main menu

In order to reach the unmarked elements of the context menus at any
time, the menu commands of these elements can be found as sub-menus
under their designation in the menus “Edit”, “Configuration”, “Monitor”,
and “Diagnostics” .

06_untermen.bmp

Fig. 6-2: Context menu of unmarked elements

6.1 Menu "File ..."

06_m1-datei.bmp

Fig. 6-3: Menu "File ..."
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Menu "File ... Operating State"

06_betr-ein.bmp

Fig. 6-4: Set operating state

The operating state “Configuration (Offline)” offers the possibility of
creating a parameterizing a bus configuration without being connected to
a controller board. You can assign addresses, define groups and link
process data “Offline”.

Note: In this operating state no data exchange takes place between
IBS CMD G4 and the controller board. It is, therefore, possible
to configure an INTERBUS system without additional
hardware.

In this operating state a connection to the controller board is established.
Furthermore, you can read in a physically available bus configuration or
copy data configured in IBS CMD G4 to the controller board and have
them executed there. In addition to that, you can write to the
parameterization memory of a PLC controller board.

Error messages are reported to IBS CMD G4 and displayed. When
changing from the “Configuration (Offline)” to the “Configuration (Online)”
operating state it is checked whether the right controller board type and
an adequate firmware version are available.

In the “Diagnostics” operating state it is ensured that the displayed
INTERBUS configuration of IBS CMD G4 matches the currently activated
configuration frame of the controller board. This means the position of the
devices and the process data lengths are compared with the bus
configuration loaded in IBS CMD G4. in the “Diagnostics” add-on program
you can evaluate among other things statistics for data transmission and
view and analyze message files.

When changing to the “Monitoring” operating state, not only the device
position and the process data lengths but also the process data
descriptions and the process data assignments are checked. You can
visualize the data of an INTERBUS network in the “Monitoring” operating
state with various monitor programs.

Configuration (Offline)

Configuration (Online)

Diagnostics

Monitoring
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Menu "File ... New"
This command creates a new, empty project.

A project consists of a file set (*.ini, *.bg4, *.stc, *.mes) which can be
created in any directory (Default=C:\IBSCMD\PROJECT).

The empty project is assigned the name "NONAME" (also NONAME.INI,
NONAME.BG4 etc.). The file with the extension *.BG4 is the central
project file which you specify when opening a project. If changes to the
old project are not saved, the “Save As …” dialog box is called up.

The new project contains, by way of default, the following elements:
“Project”, “PLC/PC”, “Program”, “Controller Board”, “Parameterization
Memory”, “Preprocessing” and “Configuration Frame”. You can only
create a new project in the “Configuration (Offline)” operating state.

Menu "File ... Open ..."
This commands opens an existing project. Pay attention to the correct
path specification in order to be able to view the desired project with the
ending "*.BG4" in the selection box. Only one project can be opened at a
time.

06_laden.bmp

Fig. 6-5: Open project

You have the possibility to load projects from older IBS CMD versions. To
do this, select the file name extension *.BUS under “File Format”. This is
the file format of IBS CMD up to Version 1.x. You can save these projects
as *.BG4 files with IBS CMD G4.
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Conversion Instructions (BUS -> BG4)
If you open a project from an older IBS CMD G4 version the text file is
started with the program "NOTEPAD.EXE". The text file contains hints to
adapt the old BG4 project to the new IBS CMD G4 version.

Note that the following changes will occur during conversion:

The input of the host controller board type Generation 3 is converted into
a corresponding type of Generation 4, insofar as this is possible.
Otherwise the type “Other” or “Firmware universal” is entered.

Note: Of the process data links, only the byte and bit copy
commands are converted.

New process data descriptions may be created in certain cases which are
marked by a number in square brackets [4] after the process data name.
These process data descriptions may be deleted if they have no
assignment.

The former diagnostic bit register is now entered under diagnostic status
register. The diagnostic parameter register and the communication
register (IBS S5 DSC/I-T) are also maintained.

Menu "File ... Save"
With this command you save a currently open project under the current
name. If the project has the name NONAME or an old project has been
changed „Save As …“ is called up.

If you have loaded an older project file with the file name extension
“*.BUS”, the “Save As …”  command is called and the file is saved as
“*BG4”.

Menu "File ... Save As ..."
“Save As” is used to save a project under a different name and, by
changing the path specification, into another directory. All project files
(*.INI, *.BG4, *.STC, *.MES, *.ZWT) which carry the old project name are
copied into the above displayed directory with a different name. You can
use this command when a second project is to be generated from a
similar, existing project.

06_speicher.bmp

Fig. 6-6: Save project as
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Menu "File ... Delete ..."
A project (filename.bg4) is deleted from the hard disk after a security
prompt. All project files that have this project name are also deleted.

06_loeschen.bmp

Fig. 6-7: Delete project

Note: Only projects which are not opened can be deleted. It is not
possible to delete the NONAME project.

Menu "File ... Print ..."
With this dialog box you select which parts of your project you would like
to print.

06_drucken.bmp

Fig. 6-8: Print

Here you select one of the printers installed under Windows.

If this option box is marked, the printout is routed to a file instead of a
printer.

With this button you call a dialog box to select special settings for the
printout. This includes among other things paper format and orientation.
Further settings are available depending on the printer driver used.

Printer

Print to File

Setup
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The bus topology of the currently opened project is output in tabular or
graphic form. The tabular printout is usually faster than the graphic form.

Here you can select individual parts of the configuration which you like to
print. To do this, mark a line in the following dialog box. If you want to
select several specific, keep the <Ctrl> key pressed while clicking the
desired lines. If you want to select a certain range, click the first desired
line and then the last desired line with the <Shift> key pressed.

06_druck3.bmp

Fig. 6-9: Print ..." More …

Menu "File ... Exit"
Use this command to exit IBS  CMD G4.

06_beenden.bmp

Fig. 6-10: End IBS CMD G4?

Before exiting, the program checks whether open projects were changed
but not yet saved. If so, you decide in a dialog box whether you want to
save the changes.

06_end-frag.bmp

Fig. 6-11: Save changes?

Then the program is ended.

Bus Topology

More …
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6.2 Menu "Edit ..."

The menu “Edit” has context menu entries. The commands in this menu
change with the element selected in the representation area.

Undo

Search

Cut

Copy

Delete

Replace

Insert

Insert with Ident Code …

Insert with Device Description …

Link with Description

Controller board and bus terminal:

Renumber

06_m1-bear.bmp

Fig. 6-12: Menu "Edit ..."

Menu "Edit ... Undo"
With this menu item deletion of a device can be undone. However, only
the last removed device can be restored.

General Commands for All
Elements:

Device:

Controller Board and Devices:
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Menu "Edit ... Search ..."
Use this command to search for a bus device in the current bus
configuration.

06_suchen.bmp

Fig. 6-13: Search for a bus device

Left digit: Bus segment Right digit: Position in the bus segment

The two digits are separated by a point (.). After successful search the
section of the bus topology is shifted so that the searched device is visible
and marked.

Menu "Edit ... Cut"
The marked device is removed and copied into the clipboard. Use this
function to restructure the bus configuration in connection with the “Paste”
command by moving devices (and the assigned data).

The “Cut” function is not possible for the elements “Project”, “PLC/PC”,
“Program”, “Controller Board”, “Configuration Frame”, “Preprocessing”
and “Parameterization Memory”.

Note: The data of the device that you have cut can also be pasted as
ASCII data into other programs (e. g. a word processing
application).

Besides of this command you can also use the “Drag and Drop” function.

Menu "Edit ... Copy"
The marked device is copied into the clipboard. Use this command to
restructure the bus configuration in conjunction with the “Paste” command
by shifting devices. The “Copy” function is not possible for the elements
“Project”, “PLC/PC”, “Program”, “Controller Board”, “Configuration
Frame”, “Preprocessing” and “Parameterization Memory”.

Note: The data of the device that you have cut can also be pasted as
ASCII data into other programs (e. g. a word processing
application).

Besides of this command you can also use the “Drag and Drop” function.

Format of the Input:
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Menu "Edit ... Paste"
With the “Paste” command a device is copied from the clipboard to the
right of or underneath the marked device. An error message appears if
you try to paste a cut or copied device into an invalid position. (Example:
Cut the local bus device and re-paste it into the remote bus.)

06_einfueg.bmp

Fig. 6-14: Insertion not possible

To “Paste” the elements “Project”, “PLC/PC”, “Program”, “Configuration
Frame”, “Preprocessing” and “Parameterization Memory” is not possible.

Note: The data of the device that you have cut can also be pasted as
ASCII data into other programs (e. g. a word processing
application).

Besides of this command you can also use the “Drag and Drop” function.

Menu "Edit ... Delete"
The marked device is deleted. The “Delete” function is not possible for the
elements “Project”, “PLC/PC”, “Program”, “Controller Board”,
“Configuration Frame”, “Preprocessing” and “Parameterization Memory”.

A deleted device can only be restored if you use the “Undo” command
directly after “Delete”.

Menu "Edit ... Replace"
Use this command to replace a device by assigning a new device
description. You can select the device description to be replaced from the
device database. If the type of the new device manipulates the
consistency of the bus topology, the address or group assignment is only
replaced after a security prompt. If replacement is not possible (e.g. local
bus device in the remote bus), an error message appears.

Note: Note that all previous changes and assignments of the old
device description of this bus will be lost.
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Menu "Edit ... Insert with ID Code"
With this menu item you insert a new device at a marked device in the
bus configuration. To do this you enter the ID code and the process data
channel length of the device to be inserted. If you don’t know these
values, please refer to the appropriate data sheet.

06_einf-cod.bmp

Fig. 6-15: Insert device with ID code …

Enter the ID code of the device to be inserted here. After each entered
digit the device type is determined and displayed in the appropriate box.

The ID code is printed on most of the devices in decimal form.

These options allow you to specify a format for the ID code you enter. You
can choose between decimal (dec.) and hexadecimal (hex.) format. If you
already have entered and ID code, it is automatically converted to reflect
the option you select.

Enter the process data channel length in bits. Upon pressing the “OK”
button, the input in the “Device type” box is compared with the ID code.

If you have entered a value in the ID code box that points to a PCP device
with a variable parameter data channel length, you can enter the length of
the parameter data channel here.

The device types are stored here. The display of the “ID code” is
automatically updated depending on the value of the ID code and if the ID
code is clear. The following device types exist:

• Local bus: Is displayed, if the appropriate bit is set in the ID code.

• Remote bus: Is displayed, if this is a remote bus device without bus
terminal functionality.

• Bus coupler with local bus branch: Is displayed, if the ID code
refers to a bus terminal.

• Bus coupler with remote bus branch: Is displayed, if the ID code
has the value of 12.

ID code

Hex./dec.

Process Data Channel

Parameter Channel

Device Type
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Menu "Edit ... Insert with Description"
With this menu item you insert a new device at a marked device in the
bus configuration. A device description must exist in the in the database
for the device to be inserted. If this is not the case you will have to insert
the new device with its ID code and process data channel width with the
aid of the menu item “Insert with ID Code”.

If the marked device is a bus terminal, you must first determine whether
the device to be inserted belongs in the local bus (branching (OUT1)) or
in the remote bus (outgoing (OUT1)).

A bus terminal links a local bus or an installations remote bus with the
remote bus.

06_schnitt.bmp

Fig. 6-16: Selection of the outgoing interface

After selecting the interface select a device from the device data base.

If you have inserted a with variable ID code and/or variable process data
length you will be requested to determine this data for the inserted device.

Bus Terminal
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Dialog Box "Define Process Data Length"
In the following dialog boxes you define the length of the process data or
for the device to be inserted. This dialog boxes are only available on
devices with a variable ID code or with a variable process data length (e.g
Slave devices, DZIs etc.)

06_id-lang.bmp

Fig. 6-17: Select process data length

06_pd-lang.bmp

Fig. 6-18: Define process data length
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Dialog Box "Device Database"
In the device data base, every device is stored in lines with “Group”,
“Manufacturer”, “Type”, “ID” and “PD length”.

06_datenba.bmp

Fig. 6-19: Device database

Here you specify from which data source the device database is to be
loaded.

The internal IBS CMD G4 program database is supplied on the
installation disks. Check this option if you wish to utilize the internal
database.

The product directory is a CD-ROM which is published at regular intervals
by the INTERBUS-S Club e.V. and contains device descriptions of the
various INTERBUS devices. To use the CD-ROM, you need to specify in
the dialog box “Extras … Options … Device Database” the drive letter of
your CD-ROM drive.

You can install additional IBS CMD G4 databases besides the internal
database and the product directory. These databases are available from
third-party vendors for their devices. If you mark the option “Others”, a
selection box is displayed in which you can select the required device
database.

Here you can enter search filters for selecting certain devices. To do this,
you can use the wild card character “*” (as in MS DOS) to select certain
areas. Click the “Search” button to search through the database
according to your criteria.

Data Source

Internal Database

Product Directory

Others

Select
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Example:

Entering “P*” in the “Group” box lists all group entries which start with the
letter “P”.

The most important search filters are predefined in the “Group” and
“Type” boxes. You can select these predefined search filters by clicking
on the selection box at the right hand side of the box.

In the selection box “Group”, INTERBUS devices are listed by
manufacturer.

These are for the internal database:

PHOENIX: Current Phoenix Contact devices

PHOE-OLD Devices of Phoenix Contact which are not included in the
current catalog (expiry models)

PHOE-PRJ Special Phoenix Contact variants and 
developments

MMICOM Devices based on the MMICOM specification

ENCOM Devices based on the ENCOM specification

DRIVECOM Devices based on the DRIVECOM specification

The device descriptions found according to the criteria entered in the
“Select” area are listed here and can be selected by clicking-on.

Here is displayed whether data records are currently read in and how
many data records have been read in.

Menu "Edit ... Link with description"
If you have determined the bus configuration with “Read Again” or created
with “Insert with ID Code”, only standard devices are represented in the
bus configuration. A standard device contains the following information:

• IDENT Code (ID Code)

• Process data channel length (PD length)

• Standard Icon

The ID Code contains the low-order byte of the device code which
describes the function of the device.

To link the bus devices with a device description from the device
database and thus with real existing products, use the “Link with
Description command”.

Only device descriptions can be assigned whose ID code and process
data channel length match the data of the respective standard bus device.

Depending on whether you call the command “Link with Description” from
the “Controller Board” element or from a device, the function of the
command changes.

Link with description (from "Controller Board" element)

All bus devices can be linked consecutively with a device description. You
can end the link at any time with the "Cancel" button.

Output

Status
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Link with description (from "Device" element)

Only the devices in the current bus segment are linked, starting with the
selected device. For every device in the bus segment you can select
whether you want to link this device.

06_verknue2.bmp

Fig. 6-20: Link?

Use this command to link the displayed device with a device description
from the database whose ID code and process data channel length match
those of the current device.  After this link, the dialog box is called for the
next bus device in the bus segment.

Use this command if you don’t want to link the displayed device with a
device description from the database. After this selection, the dialog box
is called for the next bus device in the bus segment.

If several suitable entries for a device are found in the database, you can
select the entry suitable for your application from a list in the following
dialog box.

06_verkausw.bmp

Fig. 6-21: Select device for connection

In this column, the device group is displayed. All INTERBUS devices in
the database are assigned to a group.

The device manufacturer appears in this column (e.g. Phoenix Contact).

The device name (e.g. IBS ST 24 BK-T) appears here.

In this column, the ID code appears in decimal notation.

The process data channel length appears here.

Yes

No

Group

Manufacturer

Type

ID

PD Length
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Menu "Edit ... Re-assigning Device Numbers"
You can use this command to re-assign the device numbers. The
command works differently depending on whether it is accessed from the
controller board’s context menu or a bus terminal.

When a command is accessed from controller board’s context menu, all
the INTERBUS devices are renumbered. Starting with device 1.0 all the
remote bus segments (1.x, 2.x…etc.) and all local bus devices are
numbered consecutively.

When the command is accessed from a bus terminal's context menu, all
the local bus devices connected to the module are numbered
consecutively.

06_neunum.bmp

Fig. 6-22: Re-assigning device numbers

Note: If you are using the device numbers as parameters in your
application program or in the IB function blocks, you will have
to renumber the parameters accordingly to the devices.

The assignment between process data descriptions and preprocessing
variables remains unaffected by the new numbering. When devices are
renumbered, all device numbers are automatically transferred to the
process data assignments.

Controller Board

Bus Terminal
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6.3 Menu "View ..."

You determine the representation of the bus devices with this menu.

06_m1-ansi.bmp

Fig. 6-23: Menu "View ..."

Menu "View ... Reduced Representation"
With this command you can change between the standard representation
and the reduced representation of the bus configuration display.

A check next to this menu item indicates that the reduced representation
is used at the moment.

06_komprim.bmp

Fig. 6-24: Reduced representation

Use this command to get an overview of the bus topology.
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Menu "View ... Box Display"
You can use this command to change the way in which the device bus
configuration is displayed. You can toggle between standard and box
display.

06_boxdarst.bmp

Fig. 6-25: Box display

In this mode, you can display the essential device information. The device
icon can be selected in an icon library (ICL file). You can specify which
device data is displayed in the dialog box "Settings" on the menu "View".

In box display mode, you can select the device information (select one
item) that is to appear on the standardized device icon (box). The box
display is specially designed for Inline devices; however, it can also be
used for any INTERBUS device.

This display mode is designed to provide an overview of the entire bus
configuration connected to the controller board.

Standard Display

Box Display

Reduced Representation
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Menu "View ... Settings …"
Use this command to define the standard box display, the box display and
the reduced display of the bus topology.

Decide on what information should be displayed and their respective
representation type using the option and dialog boxes.

06_darstell.bmp

Fig. 6-26: Set representation

Indicate all option boxes in this column which shall be displayed in the
standard representation of the bus devices.

Indicate all option boxes in this column which shall be displayed in the
reduced representation of the bus devices.

The individual boxes can also be selected with the keyboard by entering
the letter or number, respectively, on the right hand side of the option box

Standard Representation

Reduced Representation
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06_ansicht.bmp

Fig. 6-27: Representation of a device

Note: In the representation area, only the program addresses of the
standard process data descriptions are displayed!

If the display of the program address contains the wild card character "*"
(e.g.  IN:*), another process data description or a variable is assigned to
process data description of this device.

in the bus configuration, the Service Info is displayed in three brackets
([1234][1234][1234]). Each pair of brackets may contain up to four
characters. This display method was chosen because it matches the
Service Info display on certain controller boards. The diagnostic display
has three rows each of which can display four characters.

Buttons

Here, you can define the box display and the size of the local bus.

Dialog Box "Display Options"

06_daropt.bmp

Fig. 6-28: Display Options

Program Address

Service Info

Options
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Local Bus Size
Set the horizontal extents of the bus configuration as a value in
centimeters. This value is only of relevance when printing the graphical
bus structure. A line break is forced on local buses with many devices
when the specified width is exceeded.

06_busda.bmp

Fig. 6-29: Box display

Box Display
Here you can set the height of the device icon in the box display. You can
vary the height in order to adapt the box display to the length of the label.
Set a low box height for a label with ID code and a higher value for a label
with device name.

You can specify which device data is used to label the devices in the box
display.

The setting you make applies – as well as the height setting - to all
devices in the project.

Menu "View ... Refresh"
After renaming devices or changing the bus configuration, it may be
necessary to update the representation area. To do this, use the menu
item "Refresh". When this command is executed, the bus configuration
with all current settings is refreshed on the screen.

The graphic representation of malfunctions or errors is also updated.

06_fehler.bmp

Fig. 6-30: Error at device x.y

Line Break After:

Height

Label
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6.4 Menu "Configuration ..."

If you press the right mouse button on a selected element in the
representation area, a context menu containing all functions available for
this element opens. In addition to that, the entries in the menus are
adapted to the element.

The following menu items are available for the elements:

Project

Description …

Export project data (<Project_name>.PEX) …

EPLAN Viewer

PLC/PC

Description …

Program

Description …

Controller Board

Description …

Process Data …

Settings …

IB Function Blocks >

Parameterization >

Control >

Type …

Device Registration

Parameterization Memory

Description …

Write ASCII File >

Write …

Read …

Compare …

Delete

Format

File >
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Preprocessing

Description …

Variables …

Programming

Import

Configuration Frame

Description …

Read Again

Compare

Device

Description …

Process Data …

Device Registration

Device Parameterization

Menu "Project ... Description"
All data serves to describe the current project clearly with its features.

06_pro-be.bmp

Fig. 6-31: Project description
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The entry in the input box "Name" is also displayed in the representation
area of the main window.

In the input box "Comment" you can insert the text in order to describe the
project in more detail. For this purpose, eight text lines with the width
displayed in the dialog box are available.

Menu "Project ... Export Project Data (<Projekt_name>.PEX)"
You can use this command to export the IBS CMD G4 project for further
processing in other applications. The exported data contains the entire
BG4 project and is available as PEX file. The PEX file is an ASCII file in
which the individual entries are separated by commas (CSV = Comma
Separated Value).

You can process the PEX file in a word processing application, a spread
sheet program or a database and you can import it back into IBS CMD G4
if required.

Menu "Project ... EPLAN Viewer ..."
If you have installed the viewer for EPLAN projects, you can start it by
clicking-on this menu item.

You can export the bus structure, the process data assignments and
other parameters of the opened INTERBUS project for use in EPLAN. To
do this, use the command "Write ASCII file … EPLAN Data (*:EPL)" on
the parameterization memory's context menu.

EPLAN is a CAE system to issue electrical documentation. Terminal
drawings, wiring diagrams, assembly drawings, parts schedules can be
created easily and quickly by using EPLAN.

06_eview.bmp

Fig. 6-32: EVIEW main menu
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Menu "PLC/PC ... Description"
In this dialog box you describe the PLC or PC where the controller board
is installed.

The entry in the input box "Name" is also displayed in the representation
area of the main window.

06_be-ste.bmp

Fig. 6-33: PLC/PC description

Depending on the set controller board type, the icon of the PLC or PC
changes in the representation area. The displayed icon depends on
whether the it is a controller board for a PLC or for a PC.

06_typ-re.bmp

Fig. 6-34: Element "PLC/PC ...

Menu "Program ... Description ..."
With this dialog box you describe your application program.

The "Name" is also displayed in the representation area. Furthermore,
there is an input box for remarks and one for the name of the author of
the application program.

06_be-prog.bmp

Fig. 6-35: Program description
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Menu "Controller Board ... Settings"

06_einstel.bmp

Fig. 6-36: Controller board settings

The dialog box consists of several "file cards". When you click-on a file
card in the top section, the dialog part of this card is displayed.
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Dialog Box "Settings ... Standard Register"
Here you determine the addresses for the INTERBUS-specific registers.

06_einst-st.bmp

Fig. 6-37: Standard register

Diagnostic register:

The operating and error states of the controller board are stored here.

Error type and error location are stored here as additional data.

Standard function register:

The firmware on the controller board provides the standard functions
which can be started by setting individual bits in this register.

Every standard function is assigned one bit of the standard function start
register.

The status of the standard functions during execution can be read from
this register.

If a standard function has been executed, you can determine the result of
the execution from this bit. The standard function result bit is a bit from
the diagnostic status register.

You can assign parameters to the standard functions. This parameters
are communicated to the standard function by means of this register.

Diagnostic Status Register

Diagnostic Parameter Register

Standard Function Register

Standard Function Start Register

Standard Function Result Bit

Standard Function Parameter
Register
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Diagnostic Status Register / Parameter Register

06_diag-reg.bmp

Fig. 6-38: Diagnostic register

Byte n+1:

0 User User error

1 PF Peripheral fault

2 BUS Remote bus (RB) – or local bus (LB) - fault

3 Ctrl Controller board error

4 DTC Detection (bus error localization is running)

5 RUN Data cycles are running

6 ACT The bus is active (only ID cycles are running)

7 RDY Controller board is ready

Byte n:

0 BSA One or several bus segments are switched off

1 Sys-Fail Sys-Fail of the host system (lock the output data)

2 RES Result of a standard function (1 = negative)

3 Sync-Res Synchronization error (only in synchronous mode of
operation)

4 DCR Data cycle error (only in synchronous mode of operation)

5 Warn Bus warning time has run out (parameterizable)

6 Qual Bus quality has deteriorated (parameterizable)

7 SS-Info There is still a message in the standard signal interface.

The diagnostic parameter register contains additional information on the
malfunction reported in the diagnostic status register. This may be the
location of a malfunction (bus errors) or the type of malfunction as
indicated by the error code (e.g. 0A50h for address overlapping).

Diagnostic Status Register

Diagnostic Parameter Register
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Standard Function Start Register / Status Register /
Parameter Register

06_statusre.bmp

Fig. 6-39: Standard function register

With the standard function start register you can execute predefined and
frequently used functions by setting a bit in this register. The individual
bits of the standard function start register are assigned the following
functions:

Byte n+1 bit 0: Start the INTERBUS system

Byte n+1 bit 1: Stop the INTERBUS system and the reset 
the outputs

Byte n+1 bit 2: Clear diagnostic display

Byte n+1 bit 3: Switch off device

Byte n+1 bit 4: Switch on device

Byte n+1 bit 5: Jumper device

Byte n+1 bit 6: Cancel device jumpering

You can monitor the running process with the standard function status
register. As long as a function is processed, the corresponding bit is set in
the standard function status register. The bit is reset to zero after
processing irrespectively of whether or not the service could be executed
successfully.

The functions on the bits

Byte n+1 bit 1:

Byte n+1 bit 3:

Byte n+1 bit 4:

Byte n+1 bit 5 and

Byte n+1 bit 6:

require another parameter for execution. You can enter this parameter in
the standard function parameter register. This parameter represents the
configuration frame number for the function on bit 1 and the device
number for the functions on bit 3 to bit 6

Standard Function Start Register

Standard Function Start Register

Standard Function Parameter
Register



6-30 Menu Structure INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P

This bit indicates whether the currently executed function has been
terminated successfully or not. The "RES" bit is part of the diagnostic
status register (byte n bit 2).

RES = 1 function not terminated successfully

RES = 0 function terminated successfully

06_ablauf.bmp

Fig. 6-40: Flow chart "Standard functions"

The function execution which you start with the standard function
start bit is displayed by the status bit.

You have to reset the start bit after recognizing the status bit.

You should only set the start bit if the status bit indicates that the
function is completely executed.

ATTENTION

⇒ Only one function can be executed at one time. The
next function cannot be started until the execution of
the first function has been completed.

Standard Function Result Bit
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Dialog Box "Settings ... Bus Mode"

06_einst-b1.bmp

Fig. 6-41: Settings "Bus Mode"

Bus mode

Running of the bus cycles takes place in the shortest possible time for the
configuration and is not linked to any further events.

The application program receives a message (interrupt) as soon as a bus
cycle is terminated. In this mode of operation the application program
waits for the end of the current running INTERBUS cycle.

The controller board receives a message (interrupt) as soon as an
application program is terminated. In this mode of operation the controller
board waits for the end of the current running application program cycle.

The default cycle time must be greater than the minimum cycle time for
the respective bus configuration. Depending on the bus configuration, the
length of the minimum cycle time can vary.  If no default cycle time is
specified, or the specified default cycle time is too small, the minimum
cycle time is adopted as default value. The minimum cycle time is
calculated during an ID cycle of the controller board.

The entry of a default cycle time is only effective in the "Asynchronous"
and "Bus triggered" operating modes.

If you want to have the cycle time specified automatically from the
controller board, mark this option box.

The current cycle time is displayed in this info box. The current cycle time
is determined by the controller board when the bus is running. This
display is not active in the "Configuration (Offline) operating state.

Enter the amount of time that is to elapse between the switching on the
power supply and starting up the controller board. The start-up delay
ensures that all the INTERBUS devices can be initialized before the
INTERBUS starts up with the controller board.

When this option box is selected, the start-up delay is disabled.

Mode of Operation:
Asynchronous

Mode of Operation: Bus
Triggered

Mode of Operation: Program
Triggered

Default Cycle Time

Automatic

Current Cycle Time

Start-up Delay

Automatic
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Monitoring times

If a fault in the data transmission occurs on the INTERBUS network, the
application program receives a warning message after the bus warning
time. The default value for the bus warning time is 0 ms, i.e. no warning
messages are generated.

Even if a bus warning time was defined, you can deactivate this in this
option box. If the option box is marked, the bus warning time is not taken
into account.

If a fault lasts longer than the bus timeout, the bus cycles are stopped and
the INTERBUS network is switched off. The outputs are reset. The default
value for the bus timeout is 20 times the cycle time but at least 200 ms. If
a default cycle time is specified, the bus timeout is not automatically set
to 20 times the value.

If you have marked this option box, the bus timeout is assigned
automatically on the basis of existing bus parameters. One of this
parameters is e.g. the current cycle time.

Buttons

Pressing this button transfers and applies the changed settings to the
controller board.

Dialog Box "Operating Mode Options"
Use this dialog box in the synchronous operating modes to synchronize
the controller board with the control system or other controller boards by
using interrupts.

06_einst-o1.bmp

Fig. 6-42: Operating mode options

Bus Warning Time

Warning Off

Bus Timeout

Automatic

Execute
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Interrupt mode

Mark this option box, if you want to use the control system’s interrupt
lines. The interrupt lines A to F are physical leads on the backplane (data
and control bus on the back of the control rack).

The option "Interrupt Line" option enables the "Event from Preprocessing"
and "Synchronous (Output) options.

To see the interrupts in the address area (process data area) select
"Board ID" in this selection box. Depending on the board ID the interrupts
are displayed within the EW0 process data word. If you select the entry
"Process Data" in the "EW0" selection box instead, the input word 0 is not
used for interrupts but to represent process data.

Operating mode

You can send interrupts from the preprocessing to the control system and
other controller boards. If you want to use this option, select this option
box. A special function block is used in the preprocessing to generate the
event.

When this option is selected the controller board will react to external
interrupts (e.g. from other controller boards). Thus, you can synchronize
the INTERBUS with other controller boards.

When this option is selected the controller board sends interrupts to the
control system. Select this option if you want to use the controller board
as clock pulse generator for the control system.

When this option is selected the controller board sends interrupts to the
control system. Select this option if you want to use the controller board
as clock pulse generator for other controller boards of the control system.

This option is available when the entry "Board ID" has been selected in
the "EW0" selection box. The EWO’s low-order byte is then used to
represent direct communication. The group messages are in the EWO’s
high-order byte. Direct communication also has to be selected in the S5
control system’s synchronization block.

This option is available when the entry "Board ID" has been selected in
the "EW0" selection box. The EWO’s low-order byte is then used to
represent synchronous operation. The group messages are in the EWO’s
high-order byte. Direct communication also has to be selected in the S5
control system’s synchronization block.

Board ID

Specify whether the controller board is to operate as master or slave
within the control system. At least one of the controller boards used has to
be configured as a master.

Note: Identical board Ids may not be assigned within a control
system.

Mark this option box to configure the board as a master.

Interrupt Line

EW0

Event from Preprocessing

Synchronous (input)

Synchronous (output to PLC)

Synchronous (output to IBS)

Direct Communication / Group
Message

Synchronous Operation / Group
Message

Master
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Mark this option box to configure the controller board as slave. Select a
bit that will serve as unique identification for the board in the control
system.

Select the controller board’s slave here. You can configure up to seven
controller boards in the control system as slaves in this way. Bit 0 is
reserved for the "Master" board ID and is automatically set.

Interrupt mode of the host system

The following settings have to be made in the S7 environment in the
same way.

The interrupt mode’s function is set to "Process Alarm" by default.

Set the control system’s interrupt line that is to be used. The interrupt
lines 1 to 4 are physical leads on the backplane (data and control bus on
the back of the control rack).

Select the operation block (OB) to be invoked with an interrupt.

Note: The settings should match those in the S7 environment.

Dialog Box "Settings ... Controller Board"

06_einst-a1.bmp

Fig. 6-43: Settings "Controller Board" (S5, S7 400 and BA)

Slave

Bit (7..0)

Function

INT-Line to CPU

Alarm OB
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Dialog Box "Settings ... I/O Coupling"
System couplers and some controller boards have, in addition to the
function of a controller board, the property of appearing as a device in the
INTERBUS system or connecting another bus system to the INTERBUS
system. The properties of this device can be freely defined by the ID code
and the process data channel length to be assigned and thus any device
with process data and parameter data can be generated.

Note: When you change the process data channel length, all the
device’s process data descriptions are re-intialized. In other
words, this will delete process data descriptions (except the
new, default ones) and assignments!

06_abb.bmp

Fig. 6-44: Settings I/O Coupling

ID data

Set the ID with which the device is to appear in the INTERBUS system. In
the case of system couplers, this is the ID code used for the device in the
higher-level INTERBUS system.

In this selection box you can choose the process data channel length of
the device in the INTERBUS or in the higher-level INTERBUS system in
case of system couplers.

The length of the parameter data channel is displayed here. This value is
derived from the ID code.

CR in the higher-level bus

To exchange data with higher-level bus, the communication reference
(CR) of the PCP device (system coupler) must be specified in the higher-
level bus.

You can activate or deactivate the use of CR. The CR is activated if you
have marked the option box.

ID Code

Process Data Channel

Parameter Channel

CR

Activate
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Menu "Controller Board ... Parameterization"

Menu "Controller Board ... Edit Parameterization ..."
Use this menu item to define one or more sequences (parameterizations)
of INTERBUS actions. You can select one of the defined
parameterizations to have it executed when starting up the controller
board.

An action is a service assigned with parameters or a predefined service
sequence.

06_funkzu.bmp

Fig. 6-45: Context menu "Edit Parameterization"

Parameterizations

Contains the name of a defined action sequence. The name must not be
longer than 64 characters. The parameterization name must be
unambiguous and may only be assigned once.

A parameterization is assigned the BOOT attribute if it is to be executed
when starting up the controller board. Only one of the defined
parameterizations can be assigned to the BOOT attribute.

You can describe the selected parameterization in more detail in this input
box.

This table indicates which actions are assigned in what order to the above
selected parameterization. When you have marked a box, you can select
an action from the selection list appearing here.

This column indicates the name of the selected action. With the button
"Action Library" you can edit the action or add a new action. The texts in
the boxes of this column cannot be edited directly.

You can describe the selected action in more detail in this input box.

You can activate or deactivate individual actions within a
parameterization. If the option box is marked, the action is taken into
account while executing the parameterization.

Parameterization Name

BOOT

Comment

Action Sequence

Action Name

Comment

Active
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Buttons

To define new actions, use the button "Action Library".

Use this button to undo all the changes you have made and restore the
original (default setting) parameterizations.

The following diagram shows the relationship between parameterization,
action and (firmware) service. A parameterization is composed of actions.
An action is a service assigned with parameters or a non-editable
sequence.

06_fun-dien.bmp

Fig. 6-46: Parameterization/action/ service

This button only appears when a BG4 project of an earlier IBS CMD G4
version is loaded. Here you can determine and change the addresses that
were assigned to actions in the old project.

Context Menu "Edit Parameterization"
The "Edit Parameterization" dialog box has a context menu for easy-to-
use operation of the dialog box. Like the other context menus, you call up
this menu with the right mouse button or with <Shift> + <SPACE> or
<Shift> + <F10>.

06_kont-fun.bmp

Fig. 6-47: Context menu "Edit Parameterization"

Depending on whether the mouse pointer is in the "Parameterization" or
"Action Sequence" area, the appropriate context menu appears.

This command inserts a new parameterization/action in the dialog box
above the marked line.

The command deletes the marked line from the dialog box.

Action Library

Standard

More …

Insert Parameterization/Action

Delete Parameterization/Action
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Dialog Box "Action Library"
In this dialog box you can edit an existing action (or one selected in the
"Edit Parameterization" dialog box). You can also create new actions, i.e.
services parameterized to meet your requirements.

After selecting the action, the "Comment" and "Used in Parameterization"
info box are always updated. When this dialog box is called, the selected
action name is transferred to the "Action Name" input box.

06_dienstbi.bmp

Fig. 6-48: Action library

This selection box contains the name of the action which is to be edited or
changed. If an action already exists, the button "Rename" is enabled (the
"New" button is disabled). The "Comment" and "Used in
Parameterization" boxes are automatically updated. As soon as you enter
a character to create a new action, the button "New" is enabled  (the
button "Rename" and "OK" are disabled).

Here you can describe the respective action in more detail, e.g. to clarify
your function. This comment is then indicated in the action sequence.

This input box shows you in which parameterizations the above displayed
action is already used.

Buttons

After the complete input of the new action name, confirm this name with
the "New" button. Then you go to the action editor with the "Edit" button to
enter the parameters necessary for the new action.

With this button you can rename the selected action.

With this button you can delete the selected action from the list.

To edit an action, select the "Edit" button.

Action Name

Comment

Used in Parameterization

New

Rename

Delete

Edit
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Dialog Box "Action Editor"
In this dialog box you can assign parameters to the firmware services
(requests) and store them under a previously selected action name. The
structure of the firmware services cannot be changed. With the action
editor, however, you have the possibility to adapt all services to your
requirements by using corresponding parameters. This parameterized
and commented services can then be combined in parameterizations and
stored on the controller board.

06_editor.bmp

Fig. 6-49: Action editor without parameter

Service

This box contains the value of the firmware service. Each firmware
service has a four-digit hexadecimal code.

This box contains the service name in its original form. This name is
clearly linked to the four-digit code. Select the service which you want to
use and parameterize from this list.

If parameters follow the firmware service you have selected, this option
box is marked and the dialog box is extended by the following area:

06_editor2.bmp

Fig. 6-50: Action editor with parameter

Code

Name

Parameters
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Parameters

This area shows the parameters of the service specified above. Pre-
requirement is that appropriate parameters are defined for the service.

The list contains the parameters of the service. There is always a blank
entry at the end of the list so that at least one blank entry exists. You can
append a maximum of 510 parameters to a service. The parameter list is
pre-assigned from a service data base.

The input boxes above are updated according to the selected line.

Here you can see how many parameters follow the service or how many
parameters you have entered in the parameter list.

The line under the info box "Amount" is the input line for the parameters.
Here you enter your changes for "Value", "Format" and "Comment".

Consecutive number of the parameter.

Enter the value in this input box which you want to assign to the
parameter. While entering the value please note the data format set in the
option box "Format".

Format

Here you can enter a text to describe the respective parameter.

Buttons

Enter a new value for the parameter values in the input box and press this
button. Then, the entry is transferred to the parameter list.

The function of this button refers to the line which has just been selected.
The entries in the input boxes are checked. In case of a positive result,
the entries are written in one line that is inserted before the marked line.
The button cannot be selected, if the service does not allow you to insert
further parameters.

The function of this button refers to the currently marked line. The marked
line is deleted. The button cannot be selected, if the service does not
allow you to delete parameters.

The format of the entry "Value" can be selected. An already inserted value
is converted into the appropriate format, if you change its display format in
this box.

The following formats exist:

hex Hexadecimal

dec Decimal

dec,dec Decimal input for the high-order or the low-order byte of a 16
bit integer. The order is: <high>, <low>.

Bin Binary

When the list window is opened, a selected format is not transferred until
the list window is closed again. The original status of the opened list
window can be restored by pressing the <ESC>-key.

Transfer of a list becomes valid with a column change or by pressing the
<Return>-key.

Amount

No.

Value

Comment

Change

Insert

Delete

Format
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Parameterization, Actions and Their Services
Every INTERBUS parameterization consists of a sequence of actions.
The actions, in turn, consist of a firmware service assigned with
parameters. Some actions are special because they consist of several
services. This (special) actions cannot be edited or deleted. All actions
take their parameters from the currently loaded project.

Actions of the "Start-Up With Processing" parameterization:

Action Name (Service) Code

Alarm Stop 1303h

Lock Preprocessing 0750h

Update Diagnostic Display 0760h

Initiate Parameterization 030Eh

Send Bus Structure (Special) action

Set Operating Parameters (Special) action

Send Process Data Channel Descriptions (Special) action

Send Process Data Assignments (Special) action

Send Process Data Channel Settings (Special) action

Delete Macros 0144h

Send Macros (Special) action

Delete User Functions 0149h

Send User Functions (Special) action

Delete Events 014Eh

Send Events (Special) action

Exit Parameterization 030Eh

Send Preprocessing (Special) action

Activate Configuration Frame 0711h

Release Preprocessing 0750h

Start Data Transmission 0701h

Release Exclusive Rights 014Fh

Fig. 6-51: Actions of the "Start-Up With Processing" parameterization
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Actions of the "Start-Up With Processing" parameterization:

Action Name (Service) Code

Alarm Stop 1303h

Update Diagnostic Display 0760h

Initiate Parameterization 030Eh

Send Bus Structure (Special) action

Set Operating Parameters (Special) action

Send Process Data Channel Descriptions (Special) action

Send Process Data Assignments (Special) action

Send Process Data Channel Settings (Special) action

Delete Macros 0144h

Send Macros (Special) action

Delete User Functions 0149h

Send User Functions (Special) action

Delete Events 014Eh

Send Events (Special) action

Exit Parameterization 030Eh

Activate Configuration Frame 0711h

Start Data Transmission 0701h

Release Exclusive Rights 014Fh

Fig. 6-52: Actions of the "Start-Up With Processing" parameterization

Actions of the "Start-Up With Physical Addressing"
parameterization:

Action Name (Service) Code

Alarm Stop 1303h

Update Diagnostic Display 0760h

Read Configuration Frame From Bus 0710h

Start Data Transmission 0701h

Release Exclusive Rights 014Fh

Fig. 6-53: Actions of the "Start-Up With Physical Addressing" parameterization
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(Default) Actions:

Alarm Stop

• Alarm_Stop_Request (1303hex)

Delete User Functions

• Delete_Signal_Object_Request (0149hex)

Start Data Transmission

• Start_Data_Transfer_Request (0701hex)

Update Diagnostic Display

• Confirm_Diagnostics_Request (0760hex)

Delete Events

• Delete_Event_Object_Request (014Ehex)

Request Exclusive Rights

• Change_Exclusiv_Rights_Request (014Fhex)

Release Exclusive Rights

• Change_Exclusiv_Rights_Request (014Fhex)

Activate Configuration Frame

• Activate_Configuration_Request (0711hex)

Read Configuration Frame From Bus

• Create_Configuration_Request (0710hex)

Delete Macros

• Delete_Action_Object_Request (144hex)

Exit Parameterization

• Control_Parameterization_Request (030Ehex)

Initiate Parameterization

• Control_Parameterization_Request (030Ehex)

Release Preprocessing

• Set_Value_Request (0750hex)

Lock Preprocessing

• Set_Value_Request (0750hex)
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(Special) actions:

Send Bus Structure

• Initiate_Load_Configuration_Request (0306hex)

• Load_Configuration_Request (0307hex)

• Terminate_Load_Configuration_Request (0308hex)

Set Operating Parameters

• Set_Value_Request (0750hex)

Send Process Data Channel Descriptions

• Initiate_Put_Process_Data_Description_List_Request (0320hex)

• Put_Process_Data_Description_List_Request (0321hex)

• Terminate_Put_Process_Data_Description_List_Request (0322hex)

Send Process Data Assignments

• Initiate_Load_Process_Data_Reference_List_Request (0324hex)

• Load_Process_Data_Reference_List_Request (0325hex)

• Terminate_Load_Process_Data_Reference_List_Request (0326hex)

Send Process Data Channel Settings

• Load_CRL_Attribute_Loc_Request (0264hex)

Send Macros

• Initiate_Load_Action_Object_Request (0140hex)

• Load_Action_Object_Request (0141hex)

• Terminate_Load_Action_Object_Request (0142hex)

Send User Functions

• Initiate_Load_Signal_Object_Request (0145hex)

• Load_Signal_Object_Request (0146hex)

• Terminate_Load_Signal_Object_Request (0147hex)

Send Events

• Initiate_Load_Event_Object_Request (014Ahex)

• Load_Event_Object_Request (014Bhex)

• Terminate_Load_Event_Object_Request (014Chex)

Send Preprocessing (03A0hex)
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Dialog Box "Parameterization Data"
This dialog box only appears, when a project from IBS CMD G4 Version
4.16 or earlier is opened. In the projects in these versions of IBS CMD G4
it was possible to assign each action (a row or parameterization
sequence) a control or computer address. Actions were executed via
these addresses.

To create new, user-defined parameterization sequences (user
functions), please use the IB function blocks.

To determine and utilize the start, status and result addresses in the old
BG4 projects, the following dialog box is provided for each line in the
parameterization sequence.

06_paradat.bmp

Fig. 6-54: Parameterization data

The edit boxes with a white background show the syntax of the address
as it was entered in the old BG4 project. The syntax of the converted
addresses for the currently selected controller board type is displayed in
the gray display boxes below.

To be able to start an action via an assigned address, the address
assignments have to be transferred to the controller board. Mark this
option box to be able to execute and monitor the actions via the assigned
addresses.

Menu "Controller Board ... Parameterization … Check"
All parameterization data of the bus configuration is checked. If an error
could be localized, the affected device and the cause of the error are
output in a message window.

ATTENTION

⇒ A bus terminal’s current is not checked. If you load a
bus terminal with too many local bus devices, it may
not have enough power for all devices.

Menu "Controller Board ... Parameterization … Import ..."
With this menu item, you can import a parameterization (or several
parameterization sequences) from a file. The file has the file name
extension "PAX". The file is opened in a Windows standard dialog.

The entire parameterization is saved in a PAX file which has been there at
a certain time in an opened project.

Resident
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Menu "Controller Board ... Parameterization …
Export ..."
With this menu item, you can export the parameterization in a file. The file
has the file name extension "PAX". The file is saved in a Windows
standard dialog.

The entire parameterization available in the current projects is saved in
the PAX file.

Menu "Controller Board ... Parameterization … Execute"
With this dialog box, you can execute individual actions or action
sequences, so-called parameterizations. The parameters of these actions
and parameterizations are taken from the currently open IBS CMD G4
project or you defined them in the action library.

06_paraaus.bmp

Fig. 6-55: Execute parameterization

In the above selection box, you can choose whether you want to execute
a parameterization or an action. Depending on the setting in this box you
will see a list of available actions or parameterizations.

In the input box "Comment" you can comment on the parameterization or
action you have just selected.

Different start-up behaviors of the INTERBUS can be realized with the
parameterizations. For example, a start-up with or without preprocessing.
The parameters of the actions of which the parameterization consists, are
taken from the currently open IBS CMD G4 project and the actions you
have defined.

This list contains individual actions. Actions are services assigned with
parameters or also pre-defined service sequences. Some actions are
permanently defined and cannot be deleted or edited. This non-editable
actions consist of several services and take their parameters from the
current bus configuration.

Comment

Parameterizations

Actions
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Menu "Controller Board ... Control ..."
With these commands you can easily operate your controller board and
thus activate the individual operating states of the controller board.

06_bedienen.bmp

Fig. 6-56: Control parameterization

All commands listed under this menu item can only be executed in the
"Extended" range of functions and only after confirming a security prompt.

Operating States of the Controller Board
The Generation 4 controller boards know the following operating states:

The controller board has run the self-test successfully and is ready to
function. However, a configuration frame may exist which is not activated.

You can only change from the "READY" state to "ACTIVE" state with
"Controller Board, Control, Activate Configuration", if there is a
configuration frame on the controller board. If no configuration is frame is
active, you can change from "READY" to "ACTIVE" with the
"Configuration Frame, Read Again" command.

A configuration frame is active on the controller board. ID cycles are
transmitted at regular intervals ("BA" LED flashes on the devices).

Data cycles are transmitted.

READY (RDY)

ACTIVE (ACTV)

RUN (RUN)
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06_zustand.bmp

Fig. 6-57: Operating states of the controller board
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Menu "Controller Board ... Control ... Other ..."
You can select individual services from this dialog box and execute them
directly. If you have marked the "Display Service Results" option, you will
be shown the result (the CONFIRMATION) of the service in dialog box.
This dialog box is the "Action Service Editor" dialog box which you will
also find under the "Parameterization Edit …" menu command.

06_dienstab.bmp

Fig. 6-58: Action/service editor

If you have selected a service and entered parameters where necessary,
you can transfer the service to the controller board with the "OK" button
where it can be executed.

Menu "Controller Board ... Control ... Create
Configuration Frame"
This command creates a configuration frame on the controller board that
contains the physically connected bus configuration. This command does
not affect the bus configuration displayed in IBS CMD G4, nor does it
affect the current project. After a configuration frame has been created on
created on the controller board, the bus can be put into operation using
"Start Data Transmission".

Menu "Controller Board ... Control ... Activate
Configuration Frame"
This command checks that IBS CMD G4's configured data of the
configuration frame matches the currently connected configuration. If no
error is found, the controller board switches the bus devices of the
configuration frame active. The controller board displays the "ACTIVE"
state (BA LEDs flash).

To activate a configuration frame, the controller board must be in the
"READY" state. IBS CMD G4 always activates the configuration frame "1".
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Menu "Controller Board ... Control ... Deactivate
Configuration Frame"

Note: The active configuration frame can be deactivated with this
command, if the controller board is in the "ACTIVE" state. If
the configuration frame is not active or if the if the controller
board is in the "RUN" state, an error message is output.
You have the possibility to configure different configuration
frames in the configuration phase by deactivating a
configuration frame and to activate and deactivate them for
testing.

Note: Before a new configuration frame is activated, the previous
one must be deactivated as only one configuration frame may
be active at any time.

Menu "Controller Board ... Control ... Start Data
Transmission"
This program command activates the cyclic data traffic on an INTERBUS
network. The controller board must be in the "ACTIVE" state. The
controller board is in the "RUN" state after successfully executing this
command.

Menu "Controller Board ... Control ... Stop Data
Transmission"
This program command stops the cyclic data traffic on an INTERBUS
network. The controller board changes from the "RUN" to the "ACTIVE"
state.

ATTENTION

⇒ The moment at which this program command is
executed, must be timed to the current system state,
as the actuator outputs of the active bus devices
remain in the current state at the stop time. The
controller board displays the "ACTIVE" state.

Note: To ensure that the outputs are reset at the same time as the
INTERBUS system is stopped, use the "Alarm Stop"
command.

Menu "Controller Board ... Control ... Alarm Stop"
This program command stops the cyclic data traffic on an INTERBUS
network. The outputs of all bus devices are reset. The command is
executed immediately after completion of the current data cycle. The
controller board changes from the "RUN" to the "READY" state.
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Menu "Controller Board ... Control ... Reset Controller"
This program command resets the controller board and thus the outputs
of the bus devices. Then, the controller board runs its self-test until it
reaches the "READY" state. If a parameterization memory with a valid
and bootable parameterization exists, this parameterization is loaded and
executed.

ATTENTION

⇒ Note that the outputs are also reset by resetting the
controller board. This may lead to dangerous
situations depending on which functions you have
assigned to this outputs.

Menu "Controller Board ... Control ... Update Diagnostic
Display"
This command updates the diagnostic display on the front panel of the
controller board and the contents of the diagnostic register.

Menu "Controller Board ... Control ... Reset Statistics
Counter"
You can use this menu item to delete all the statistical data like TOP Ten
and Peripheral Bus Malfunctions stored on the controller board. You can
call-up this command also from the "Diagnostics" add-on program.
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Menu "Controller Board ... Description"
The controller board controls the data traffic on the INTERBUS network.
Here you can describe the controller board with name and remarks. All
other boxes are not editable.

The input boxes "Manufacturer" and "Type" are read from the initialization
of the project. The input box "Version Info" is read from the controller
board as soon as the first online connection was established.

Among other things, the input box "Version Info" contains information on
the firmware version.

06_be-ans.bmp

Fig. 6-59: Controller board description
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Menu "Controller Board ... IB Function blocks ..."

06_funktion.bmp

Fig. 6-60: User functions/events/parameters

You can define user functions and events with the "IB Function Blocks"
menu. These user functions and events are each assigned one macro
and – depending on the selected service primitives – different numbers of
parameters.

User functions can be started by setting a bit in the application program.

Events are started, when the INDICATION defined in an event appears.

06_men-awf.bmp

Fig. 6-61: Menu "IB Function Blocks"
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Menu "Controller Board ... IB Function blocks ... User
Functions ..."
You create the user functions in this dialog box. A user function is a
macro assigned with parameters. You can start and monitor an user
function from your application program. The addresses (bit addresses)
with which you start the user functions can be freely defined.

06_awf-awf.bmp

Fig. 6-62: User functions

Function table

In this column assign an unambiguous name for the user function.

In this column assign the address of the bit which starts the user function.
If you set this bit to "1", you will start the user function.

After you have started the user function, you can recognize from this bit
whether the user function is still being executed. This bit has the "1" state
during execution of the user function. Assign the status bit address in this
column.

If an user function cannot be successfully executed, the result bit is set.
Enter the address of the result bit in this column.

A function is assigned the BOOT attribute if it is to be executed when
booting the controller board.

In this column the macro name is displayed which you have assigned to
the user function. To assign a macro, first mark the line of the desired
user function and then select the desired macro in the "Macro for:" box.

You can comment directly on every user function in this input box. The
created comment is displayed depending on the marked user function.

Select the desired macro for the marked user function in this input box.
The services used in this macro are displayed in the info box below.

In this input box the addresses of the start, status and result bit are
displayed which you can select with the "Assign" button.

Name

Start

Status

Result

Boot

Macro Name

Comment

Macro for:

Addresses for:
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Buttons

With this button you go to a dialog box in which you can supply the macro
of the current user function with parameters.

Press this button to assign the user function with the addresses for one
start, status and result bit respectively.

This button opens the dialog box "Macros" in which you can create,
change or delete macros.

Dialog Box "Bit Selection User Function"
In this dialog box you can select the addresses for the start, status and
result bit.

First select the byte addresses for "Start", "Status" and "Result" and then
the "Bit" number within the byte.

The bit number must be the same for all three addresses. After ending
the dialog box, the selected settings are entered in the function table.

06_awf-reg.bmp

Fig. 6-63: Bit selection "User functions"

Parameters …

Assign …

Edit …
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Menu "Controller Board ... IB Function blocks ... Events
..."
In this dialog box you define the events. An event is macro assigned with
parameters which can be started by an INDICATION. You have to define
the INDICATION which causes the start of the "Event"

06_awf-erre.bmp

Fig. 6-64: Events

Event table

Assign an unambiguous name for the event in this column.

In this column you select to which INDICATION the event is to react. You
can create one event for every INDICATION (e.g. Write_Indication). The
event is started as soon as the INDICATION arrives. An indication can,
for example, be sent by a PCP device that requests a service.

Enter the communication reference (CR) of the PCP device for which the
event is to apply.

Enter here the address of the confirmation bit. You have to acknowledge
an INDICATION by setting the confirmation bit. You can recognize an
indication from the notification bit.

ATTENTION

⇒ You have to confirm every INDICATION. An
unconfirmed INDICATION prevents the process of
other INDICATIONS.

Enter here the address of the notification bit. The notification bit signals
the application program that an INDICATION has occurred.

In this column the macro name is displayed which you have assigned to
the event. To assign a macro, first mark the line of the desired event then
select the desired macro in the "Macro for:" box.

Name

Indication

CR

Confirmation

Notification

Macro Name
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You can comment directly on every event in this input box. The created
comment is displayed depending on the marked event.

Macro for:

Select the desired macro for the marked event in this input box. The
services used in this macro are displayed in the info box below.

Addresses for:

In this input box the addresses of the confirmation and notification bit are
displayed which you can select with the "Assign" button.

Buttons

With this button you go to a dialog box in which you can supply the macro
of the current event with parameters.

This button opens the dialog box "Macros" in which you can create,
change or delete macros.

Press this button to assign the addresses for confirmation and notification
bit to an event.

Dialog Box "Bit Selection Events"
In this dialog box you select the addresses for the confirmation and
notification bit.

First select the byte addresses for "Confirmation" and "Notification" then
the "Bit" number within the byte.

The bit number must be the same for all three addresses. After ending
the dialog box, the selected settings are entered in the event table.

06_awf-ereg.bmp

Fig. 6-65: Bit selection "Events"

Menu "Controller Board ... IB Function blocks ... Export
..."
In order to manage macros, events and application functions easily, you
have the option to export your definitions into files.

The file format for these files is "FCX". You can import existing FCX files
with menu item "Import".

Import and export of the FCX files takes place in a Windows standard
dialog box for file selection.

Comment

Parameters …

Edit Macro …

Assign …
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Structure of a Service
A full service (firmware and PCP) consists of four service primitives.

REQUEST (RES) Request a service

INDICATION (IND) Receipt of the service request

RESPONSE (RES) Response to the service request

CONFIRMATION (CON) Confirmation of the service

06_dienst.bmp

Fig. 6-66: Service primitives

A service primitive consists of a block of data words. The parameters
contained in this block are represented in hexadecimal numbers (hex) or
binary (bin). All services are structured according to the following pattern:

Code of the service primitive in hexadecimal representation.

Number of following words. If no other words follow, Parameter_Count
has the value 0000hex.

With the parameters you define, for example, which device you want to
address with this service or in which way a service is to be executed.
Please refer to the firmware and PCP manuals or the "Parameters" table
the dialog box "Edit Parameters" for an exact description.

06_primitiv.bmp

Fig. 6-67: Structure of a service

Service_Code

Parameter_Count

Parameter 1..n
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Dialog Box "Edit Parameter"
In this dialog box you provide the services with parameters, in order to
create a functional user function in the marked macro.

06_awf-par.bmp

Fig. 6-68: Edit parameter

If you mark a service primitive from the macro, a table of parameters is
read in from a provided database. According to the selected service
primitive, the respective parameter table is displayed. As soon as you
have marked a service primitive and the parameter table was displayed,
the service primitive is marked with "OK" to indicate that it is selected.
This gives you an overview which of the service primitives you have
already selected.

Depending on whether you define an user function or an event, you must
supply different service primitives with parameters (REQUEST /
RESPONSE) or assign the incoming parameters to addresses
(INDICATION / CONFIRMATION).

You can edit this parameter table, when you define a REQUEST to a
service provider.

You can edit this parameter table, when you define a REQUEST to a
service provider.

You can edit this parameter table, when you define a RESPONSE to a
service provider.

You can edit this parameter table, when you define a RESPONSE or a
REQUEST to a service provider.

06_reqpara.bmp

Fig. 6-69: Overview available service primitives

Macro

Parameters

Request

Confirmation

Response

Indication
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The parameter values and addresses can be entered in different formats.

Number format Abbreviation Syntax

Decimal dec nnn

decimal in bytes dec,dec nn,nn

hexadecimal hex $nnnn

binary bin %nnnnnnnn

The data types BYTE, WORD, BYTE_ARRAY and WORD_ARRAY are
available. If you use one of the arrays, you can only use addresses
(ADDR) as a value type. The length of the array is entered in the "Length"
column. A WORD_ARRAY of length n allocates n*16 bits and starts at the
address entered under "Value".

CONST (Constant), ADDR (Address) and IGN (Ignore) are available as
value types.

CONST

With the "CONST" value type you assign the parameter a constant value.
Enter this constant value in column "Value". The value type "CONST" is
only valid for the REQUEST and RESPONSE service primitives.

ADDR

With the "ADDR" value type you refer to an address. In the "Value"
column you enter this PLC and PC address and thus refer to the actual
value of the parameter. With the service primitives REQUEST and
RESPONSE is read from this address. With the service primitives
REQUEST and RESPONSE is read from this address.

IGN

With the "IGN" value type you ignore the value of the parameter. The
parameter is ignored in the service primitives CONFIRMATION and
INDICATION, the parameter is not transferred to the service provider in
the REQUEST and RESPONSE service primitives.

Enter the length of the array for WORD_ARRAY and BYTE_ARRAY data
types in this column. Enter the value in words or bytes, as appropriate for
the array’s data type.

A description of the parameter is displayed in this columns. You can edit
this description as you wish. To display CONFIRMATINS the description
was divided into positive and negative descriptions. If a service could not
be executed correctly, the service provider transfers a negative
confirmation. Positive confirmation is given, if the service is executed
properly. Since the parameter contents differ from each other, these
parameters are described in two columns.

Menu "Controller Board ... IB Function blocks ...
Import ..."
In order to manage macros, events and application functions easily, you
have the option to export your definitions into files.

The file format for these files is "FCX". You can import existing FCX files
with menu item "Import".

Import and export of the FCX files takes place in a Windows standard
dialog box for file selection.

Value

Data Type

Value Type

Length

Description Positive /
Description Negative
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Menu "Controller Board ... IB Function blocks ...
Macros ..."
You can create macros with this dialog box. A macro is a sequence of the
service primitives "Request" and "Response".

You can use a macro in different user functions or events, but only one
macro per user function or event.

If you assign parameters to this macro or the services in this macro, you
create an user function or event.

06_awf-mak.bmp

Fig. 6-70: Edit macro

Macro table:

The defined macros are listed in this table. You can select a macro
respectively to

• change or delete the name,

• display and edit the services or to

• comment on macro and services.

This input box shows you in which user functions or in which events the
selected macro is used.

In this input box the comment belonging to the macro is displayed. This
info box cannot be edited directly. You can change/enter the comment for
the selected macro by clicking the "Change" button.

Buttons

you create a new button with this macro. Assign an ambiguous name to
the new macro and a comment if necessary.

Defined

Used in

Comment

New
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This dialog box affords the opportunity to change the name of the macros
and of its comment.

06_awf-mneu.bmp

Fig. 6-71: Comment or rename macro

You delete the selected macro with this button.

Macro contents:

This table shows you which services have already been assigned to the
selected macro. These services or service primitives represent the actual
macro.

With these option boxes you select which service primitives you want to
assign to your selected macro. You can select between:

• REQUEST (request a service)

• RESPONSE (response to a service request (INDICATION))

You can comment on every service primitive. To do this, select the
desired primitive in the "Service Sequence" box and then click the
"Comment" button. This info box cannot be edited directly.

Buttons

With this button you assign service primitives to your macro. Mark the
desired service and click then on the "<<Assign" button. The service
primitive is entered in the "Service Sequence" input box above the
marked line.

With this button you delete the marked service from your macro.

Use this button to comment on the service marked under "Service
Sequence".

06_awf-komm.bmp

Fig. 6-72: Comment service

Change ...

Delete

Service Sequence

Request/Response

Comment

<<Assign

Delete

Comment
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Menu "Controller Board ... (Device ...) Device
Registration"
Device registration (abbreviated BMK) allows you to clearly identify your
INTERBUS devices.  The data already available in the bus configuration
can be used to generate the BMK automatically. The device registration
can be used within the IBS CMD G4 project for the controller board and
all existing devices in the bus configuration. If you click on the command
"Device Registration" of a device’s context menu, you see the BMK for
this device in a dialog.

The device registration is part of DIN 40719 and consists of four
registration fields. The first three fields can be filled out in IBS CMF G4.

Note: Only alphanumeric characters and the decimal point are
permitted in device registrations. Blanks and symbols are not
allowed.

06_bmk01.bmp

Fig. 6-73: Device registration

Device identification

Registration field 1 of the device registration. Here you can enter the
name of the system. This device identifier is preceded by an equal sign
(=) in the bus display.

Registration field 2 of the device registration Enter here the location of the
device registration (of the INTERBUS devices). This device identifier is
preceded by a plus sign (+) in the bus display.

Registration field 3 of the device registration Here you can enter, for
example, the device number or name. This device identifier is preceded
by a minus sign (-) in the bus display.

Buttons

The device registration of single or all devices can be generated
automatically based on existing project data. Click this button to access a
dialog box where you can select the parameters for the automatic device
registration.

System

Location

Type, Counter, Function

Automatic
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Dialog Box "Device Registration (Automatic)"
You can use the tools in this dialog box to generate the device identifiers
automatically based on data in the current project. Eight parameters are
provided for this purpose. Each parameter is preceded by a "$" symbol
followed by identification letters for the parameter in question. You can
use several parameters in an identification field. Besides parameters, you
can also enter alphanumeric text.

Let us assume that you want to insert the device number for each device
as a device identifier for the "System" dialog box.

To do this, enter "$N" in the "System" dialog box. Select the option box
"All Devices" in the "Type of Replacement" area and in the "Replacement
Mode" area "All Fields". If you want to enter a series of parameters, avoid
to use blanks and special characters as these are not allowed for the
device registration.

06_bmk02.bmp

Fig. 6-74: Automatic device registration

Device Labeling

Registration field 1 of the device registration Here you can enter the
parameter for the system’s name.

Registration field 2 of the device registration Enter here the parameters to
specify the location of the device (of the INTERBUS devices).

Registration field 3 of the device registration Here you can enter, for
example, the parameter for the device number or name.

This area includes a list of the used parameters for the automatic BKM.
Enter one or several parameters in the desired input box.

Example:

System

Location

Type, Counter, Function

Parameters
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Type of Replacement

Select this option box if you want to generate only the device registration
of the device on which the dialog was opened.

When you check this option, the device registrations will be generated for
all devices and for the controller board according to your settings.

Replacement Mode

Select this option to re-generate the entire device registration. All fields of
all devices are re-written.

Select this option if you simply want to fill out empty registration fields.

When you have selected this option, the device registration of a device is
only re-generated if all fields for this device are empty.

If one or more device identifiers are identical in all fields, this is indicated
in the "Item Designation (Automatic)" dialog box.

Change the BMK so that there are no identical registrations.

06_bmkdoppl.bmp

Fig. 6-75: Double BMK

Current Device Only

All Devices

All Fields

Empty Fields Only

Entire BMK Only

Double BMK
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Menu "Controller Board ... Type ..."
Select the required controller board in this dialog box.

06_typ.bmp

Fig. 6-76: Select controller board

You can select a controller from the "Available Types" list. The selected
type appears in the "Current Controller Board" input box.

Depending on the set controller board type, the icon of the controller
board in the representation area.

06_typ-abg.bmp

Fig. 6-77: Element "Controller Board"

When you change the controller board type, all already assigned
addresses are converted to the address format of the new controller
board (e.g. "P20" in a IBS S5 DSC I/T will become "20" in a IBS PC ISA
I/T). Addresses that cannot be converted to the new address format or
that are not valid are displayed in brackets.

Firmware Version

The range of available functions depends on the firmware version on the
controller board. To adapt the functional range of IBS CMD G4 to the
functionality of the firmware on the controller board, you can define a
firmware version number. Enter the desired firmware version in the input
box or select one of the default values.

When you select this option, IBS CMD G4 determines the firmware
version of the controller board as soon as it switches to one of the online
operating states. The online operating states are "Configuration (online)",
"Monitoring" and "Diagnostics".

Address Conversion

Auto-Detect
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Menu "Controller Board ... Process Data"
The process data dialog is used to create process data descriptions of
your INTERBIS device according to your needs and to reproduce them on
addresses, variables or other process data descriptions.

The standard process data description available after the insertion of a
device can be divided into individual components by creating further
process data descriptions to meet your requirements (e.g. a channel of an
Al-device in a process data description).

In the "Process Data" dialog box you can assign the following destinations
to the process data descriptions of the INTERBUS devices.

• Addresses of the PLC or the PC in the respective address format

(e.g. P20 for S5 or 20 for PCs).

• Direct links to other process data descriptions
Input data are copied to output data.

• Variables used in the preprocessing.

Note: If you open the process data dialog box from the "Controller
Board" element, you will see the process data descriptions of
all devices in the current INTERBUS project. If you open the
"Process Data" dialog box from a device, you will only see the
process data descriptions of that device.

Device: "Process data"

06_adressen.bmp

Fig. 6-78: Dialog box "Process data"

Display

This display shows the whole process data channel length that is
assigned by one device in the INTERBUS process data channel. Thereby,
the process data channel length of the device’s process data description
you have selected is displayed.

Standard Device Data
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Buttons

When you press this button, the context menu of the dialog opens. The
commands of this menu allow you to edit the process data descriptions in
the dialog box.

Option Box

If you have restricted the representation of the process data descriptions
in the "Filter" dialog box, you can activate or deactivate the filter function
with this option box.

Enter the device name with the device description.

The ID code can be taken from the data sheet and is printed on every
device.

The device number designates the logical position of the device in the
INTERBUS data ring.

The process data name clearly designates the selected process data
description.

I/O displays whether it is input (I) or output (O) data.

Enter the process data length in bit in this input box.

Enter here the byte number at which the process data description has to
be started within the standard process data description.

For process data descriptions < 8 bit you can specify the bit of the byte at
which the process data description is to be started.

If you want to assign several addresses or variables to a process data
description, you have to activate the option box "MA" = Multiple
Assignment. If you select the "MA" box of a standard process data
description, all process data descriptions derived from the first can also
be assigned several times.

This column serves to enter the assignments. These are variables,
addresses or also other process data descriptions. Use the context menu
to select the assignments or enter the assignment directly.

Example:

Create a process data description for the third channel of a 4-channel Al-
device.

The device has a process data length of 4 * 16 bits = 8 bytes = 4 words.

A channel has a length of 16 bits = 1 word. The third channel starts at
byte 4, as channel 1 and 2 are assigned to the bytes 0 to 3 (2 words).
Within this word the process data description starts with bit 0 because the
process data description is > 8 bit.

06_4kanal.bmp

Fig. 6-79: Example of a process data description

Edit

Filtered

Device name

ID Code

Device Number (D. No.)

Process Data Name

I/O

Length

Byte

Bit

MA

Assignments
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Note: The number specifications for length, byte and bit must be
within the maximum values of the greatest process data items,
e.g. a 16-bit device may not have an entry > 2 in the "Bytes"
column.

mark a process data description of the device’s process data description
you want to copy. You can copy this process data description with the
<Ins>-key. Then, you only need to change the data in the "Process Data
Name", "Length", "Byte" and "Bit" input box according to you
requirements.

Assignments
In the column of the "Process Data" dialog box the destinations are
assigned to the process data descriptions. You can assign the following
destinations:

• Addresses of the PLC or PC in the respective address format (e.g. 20
for PCs).

• Process data descriptions, i.e. input data are copied to output data.

• Variables used in the preprocessing.

Note: You can only change the "Length" box, if no destinations were
selected in the "Assignment" column.

Syntax of the assignments:

Enter the addresses of the PLC or PC in the host-specific format.

Examples:

• 20; 22.1; 24.5 for PC addresses

• N20:0; N30:0.4 for Allen Bradley addresses

If you prefix a ("$") sign, you enter the address in hexadecimal format.
Example: $2a for the PC address 42.

You can enter consistency areas by identifying the required consistency
together with a colon (":") behind the assignments.

Example: P20 :16 for the S5 address P20 with the consistency 16 bit.

Process data links have the following syntax:

’Device segment.’device position.’process data name.’

Example: 1.2.Emergency_Off for a direct link to the process data item
"Emergency_Off" of the device in the bus segment 1 at position 2.

Variables are input with the syntax: ART.variable name. The variables
TYPE distinguishes between:

VAR = Variable for PROGRAM WORX

PDP = Variable for the preprocessing (process data preprocessing)

Example:

PDP.Emergency_Off for linking the process data item with the
preprocessing variables "Emergeny_Off".

The separating character in case of multiple addressing is the semicolon
(";"). Example: P20; P22; P24 for the assignment of a process data item
to three S5 addresses.

Addresses

Input in HEX Format

Consistency Area

Process Data Descriptions

Variables

Separating the Entries in Case of
Multiple Addressing
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Context Menu "Process Data"
The "Process Data" dialog box has a context menu for easy-to-use
operation of the dialog box. Like the other context menus, you call up this
menu with the right mouse button or with <Shift> + <SPACE> or <Shift> +
<F10>.

06_kon-pdov.bmp

Fig. 6-80: Select controller board

This command inserts a new line in the dialog box above the marked line.
Every line represents a process data item of a defined length.

Deletes the marked line from the dialog box.

Select this menu item to assign addresses of the PLC or PC to the
process data descriptions.

Select this menu item to link process data descriptions with other process
data descriptions. The input process data item is thereby immediately
copied to the assigned output process data item.

Select this menu item to link process data descriptions with variables of
the preprocessing.

With this menu item, you can assign free addresses automatically to the
process data descriptions of the PLC or the PC. An address is only
assigned to those process data descriptions for which no assignment
exists.

With this menu item, you delete the assignments to the process data
descriptions. If  you want to delete several assignments simultaneously,
you must mark the desired process data descriptions at first with the
mouse. To mark process data descriptions move the mouse along the
line numbers of the process data descriptions while continually pressing
the mouse button.

With this menu item, you can determine the address range that you want
to use in the automatic addressing.

With this menu item, you open a dialog box for filtered representation of
the process data descriptions.

You can search for an error occurred during the execution of the
parameterization.

Copies the marked line to the Windows clipboard.

Insert Process Data Description

Delete Process Data Description

Assignment … Addresses

Assignment …  Process Data
Description

Assignment …  Preprocessing

Autom. Addressing

Delete Assignments

Address Range

Filter

Search Error Location

Copy to Clipboard
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Dialog Box "Address Range"
With this menu item, you can determine the address range that you want
to use in the automatic addressing.

06_addber.bmp

Fig. 6-81: Dialog Box "Address Range"

Digital

Here you enter addresses at which the address assignment for digital
process data is to start. The addresses have to be separated respectively
according to input and output data.

Here you enter addresses at which the address assignment for digital
process data is to end. The addresses have to be separated respectively
according to input and output data.

06_adddig.bmp

Fig. 6-82: "Digital" address range

Analog

Here you enter addresses at which the address assignment for analog
process data is to start. The addresses have to be separated respectively
according to input and output data.

Here you enter addresses at which the address assignment for analog
process data is to end. The addresses have to be separated respectively
according to input and output data.

06_addana.bmp

Fig. 6-83: "Analog" address range

Start Address

End Address

Start Address

End Address
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Addresses

Specify here how many addresses you want to have offered at the same
time in the address assignment. The less free addresses you want to
have faded in the better is the performance of your system. As long as
free addresses are available, these are displayed in the "free addresses"
input box, but only the maximum number that you have defined.

06_addadr.bmp

Fig. 6-84: Max. number of addresses

Dialog Box "Automatic Assignment"
With this dialog box, you can assign individual (marked area) or all
process data, free addresses of the PLC or the PC.

Standard process data descriptions are the process data description of a
device as it is available in the physical addressing. Every device is
assigned a maximum of one process data description for input data and
one for output data. The standard process data descriptions cannot be
deleted.

06_autom.bmp

Fig. 6-85: Automatic assignment

Process data type

If this option is activated, addresses are only assigned to the standard
process data descriptions.

If this option is activated, addresses are only assigned to non-standard
process data descriptions.

Max. Number of Addresses

Standard Process Data

Non-standard Process Data
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Assign to

Within the defined address area the free addresses of the PLC or PC are
assigned to the process data descriptions. This assignment is
independent of the current filter setting and addresses all process data
descriptions even if they are not standard.

If this option is activated, addresses are only assigned to process data
descriptions previously marked.

Dialog Box "Search Error Location"
If an error should occur during execution of the parameterization, you can
have the error location displayed in the error message determined with
this dialog box. An error during execution of the parameterization may
occur for example, due to an illegal multiple addressing.

06_such-fe.bmp

Fig. 6-86: Search error location

Dialog Box "Direct Link/Variables"
In this dialog box you can select process data descriptions or variables
that match the selected process data description in terms of length and
data direction. Select the required process data description or variable
and press "OK". This assigns the variable or process data description to
the selected process data description.

When you assign process data descriptions to other process data
descriptions, input data can be copied directly on the output data without
stressing an application program or the preprocessing.

All

Selected Range



6-74 Menu Structure INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P

06_durch.bmp

Fig. 6-87: Direct link

Dialog Box "Address Assignment"
In this dialog box you can assign (PLC or PC) addresses to process data
descriptions.

06_zuordnu.bmp

Fig. 6-88: Address assignment

Selection boxes

This selection box contains all addresses that are available for the
process data descriptions selected beforehand; i.e. it contains addresses
that have not been used yet. You can reduce the number of the displayed
addresses.

This list contains addresses that have been assigned to the currently
selected process data description.

Free Addresses

Assignments
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Buttons

Select an address in the "Available Addresses" box and press this button.
The selected address is transferred to the "Assignments" box and is thus
assigned to the process data description.

Select an address in the "Assignments" box and press this button. The
selected address is removed from the list. Addresses that have been
removed from the list are re-inserted in the list of available addresses.

Dialog Box "Filter (Process Data)"
Here you select the options that restrict the representation of the process
data descriptions. Only the process data descriptions matching all the
requirements specified here are displayed.

Several options can be selected simultaneously.

06_filter.bmp

Fig. 6-89: Filter for process data descriptions

Display of the "Standard" or Non-standard process data descriptions".

Display of all process data descriptions or the process data descriptions
with input or output data.

Display of all process data descriptions or the process data descriptions
with length specified in bits.

Display of all process data descriptions or the process data descriptions
with specified names.

Display of all process data descriptions or the process data descriptions
with specified addressing (addresses, direct link, etc.).

Note: The displayed devices or process data descriptions are
possibly not complete when the option "filtered" is active.

Assign >>

Remove

Process Data Type

Process Data Direction

Process Data Length

Process Data Name

Addressing Type
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Data Consistency
In order to ensure that the INTERBUS process data read out of the
controller board memory in one program or PLC cycle originate from one
INTERBUS cycle, you can create consistency areas.  Consistency areas
can also be used to ensure that certain data from the application program
is written in one INTERBUS cycle.

Without consistency areas, related data may be read in from different
INTERBUS cycles in an application program cycle in asynchronous mode
of operation.

06_konzykl.bmp

Fig. 6-90: Data consistency

You can create consistency areas of 8, 16, 32 and 64 bits. To do this,
enter a colon followed by the value of the consistency area after the
program or PLC address in the "Assignments" column of the "Process
Data" dialog box.

An analog value with 16 bytes in length should be read in consistently.
After every INTERBUS cycle, all input process data is updated in the
controller board memory. The analog word is in the memory after the first
INTERBUS cycle. Shortly after the first INTERBUS cycle the application
program has received the access rights to the memory and reads the first
byte of the analog word. Now, INTERBUS receives the access rights
again and updates both bytes of the analog word. If the application
program now reads the second byte of the analog value, both bytes
originate from to different INTERBUS cycles. However, the analog value
may have changed between both cycles so that it cannot be established
without consistency that the data read from the controller board memory
is the correct analog value. With consistency the second byte will not be
overwritten until it is called from the application program. enter "IP20:16"
for a consistency area of 16 bits starting from address P20. This
guarantees that the 16 bit analog values starting from address P20 and
read in by the application program originate from an INTERBUS cycle.

Example:
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Menu "Parameterization Memory ... Write ASCII File"

06_men-asci.bmp

Fig. 6-91: Menu "Write ASCII File"

Menu "Parameterization Memory ... Write ASCII File …
Project Data (*.CSV)"
With this command you write the data of the opened project in an ASCII
file (*.CSV). The CSV file (Comma Separated Value) contains the data
from the IBS CMD G4 file. The CSV file is used to make the project data
(*.BG4), otherwise available in binary format, also accessible to other
programs.

Define in the following dialog box the project data that you want to store in
the CSV file.

After selecting the project data you have to determine the file name and
the path of the CSV file in a Windows standard dialog box.

06_csv-para.bmp

Fig. 6-92: Create CSV file

Here you select the areas of the BG4 file which you want to save as CSV
file.

With this option box you write the information about all devices such as
type, number, Id etc. in the CSV file.

Area

Device Data
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With this option box you save all information concerning the process data.
These are the full process data descriptions including their assignments.

INTERBUS controller boards with slave functionality and system couplers
have a process data area of a defined length in their slave part. With this
option box you can write the description of these slave process data in the
CSV file.

All information about variables can be written in the CSV file with this
option boxes. PDV variables are the preprocessing variables. Program
variables are the variables of the application program which you can use
in the "PC WORX" software.

You can use this option to add the name of the PCP services that support
the controller board for the respective device to the CSV file. The entry is
coded and can also be accessed in the "Device …  Description …
Parameter Channel …" dialog box.

The area of the configuration data contains the following entries that can
be displayed or hidden with the respective option box:

Consecutive Number (No)

Device Number (LogDevNo)

Group Number (GrpNo)

Device ID (UniqueId)

ID Code (Ident)

Device Level (BusLevel)

PD Length (PDLen)

Station Name (StationName)

Device Name (DeviceName)

Diagnostics Name (DiagName)

Manufacturer (VendName)

Device Type (DevType)

Database Group (DbGroup)

Icon Library (IconLib)

Icon Number (IconNo)

Incoming Interface Type (TypA1)

Branching Interface Type (TypW1)

Outgoing Interface Type (TypW2)

Device Status (DevState)

Process Data

Slave Process Data

PDV Variables / Program
Variables

Parameter Channel

Configuration Data
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The area of the process data contains the following entries that can be
displayed or hidden with the respective option box:

Index (PdIdx)

Process Data Name (PdName)

Direction (I/O) (PdDir)

PD Length (PdLen)

Byte Position (PdBytePos)

Bit Position (PdBitpos)

Process Data Type (A/D) (PdType)

Virtual Process Data (Virtual)

Multiple Addressing (MultAdr)

Process Data Assignments (PdAss)

Initial Value (InitVal)

Program Instance Name (InstName)

Configuration name (CfgName)

Resource Name (ResName)

Buttons:

With this button you activate all option boxes in the appropriate area.

With this button you deactivate all option boxes in the appropriate area.

With this button you select the other options to create the CSV file. The
entries of the interface types "TypA1", "TypW1" and "TypW2" in the CSV
file are coded as follows:

0 Not assigned

1 Universal

2 2-wire local bus

3 2-wire remote bus

4 8-wire local bus

5 Reserved

6 Fiber optics remote bus

7 Fiber optics local bus

8 2-wire installation remote bus

9 INTERBUS Loop

The entry of the "DevState" in the CSV file is coded as follows:

1hex Normal state

2hex Software has localized error

4hex Device grayed out

10hex Bus error localized

20hex Device message

Process Data

Select All

Delete All

CSV Options
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Dialog Box "CSV Options"
You can set the CSV file parameters with this dialog box. The separating
characters separate the individual entries. If you want to import the CSV
file to another program later, you can react to this separating character by
setting the program import filter to the separating character set here.

06_csv-opti.bmp

Fig. 6-93: CSV file options

Selection boxes

Here you set the character which separates the individual column entries
from each other.

The "Process Data Assignment Separator" and the "Text Separator" are
used within these column separators.

You separate the individual process data assignments from each other
with this character. Particularly, this is significant for multiple assignments.

This character marks text within a column. The text is "framed" by the text
separator.

Option box

If you have marked this option box, the first line of the CSV file is
displayed as a header line. The header line marks each individual column
with an abbreviation.

Menu "Parameterization Memory ... Write ASCII File …
EPLAN Data (*.EPL)"
You can use the "EPLAN Data (*.EPL)" command to export the bus
structure and the process data assignment of the current INTERBUS
project for use in EPLAN. Additionally, you can export further information
in three labeling fields.

06_eplan01.bmp

Fig. 6-94: EPLAN export

Column Separator

Process Data Assignment
Separator

Text Separators

Generate Header Line
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EPLAN export

Select this option if you want to export the bus structure of your
INTERBUS system.

The exported bus structure contains the following data:

• Serial number (starting at 0)

• Device type (coded as hexadecimal value)

• Remote bus level

• Interface similarity (a 1 indicates an interface that is compatible with
the preceding device)

• Device identifier (all used fields are exported)

• Macro name (if a specific macro is to be used for a device in EPLAN)

• Manufacturer

• Order number

• Labeling fields 1 to 3 (these can be defined by clicking "Settings")

Buttons

You can define three labeling fields for each of your INTERBUS devices.
Click this button to access the dialog box for selecting the labels. The
export of the labeling fields is linked to the export of the bus structure.

06_eplan02.bmp

Fig. 6-95: EPLAN settings

Select an option to use the corresponding labeling field. You can enter
parameters and plain text in the input box below. The parameters are
preceded by a "$" symbol followed by identification letters for the
parameter in question. You can use several parameters in a labeling field.
As opposed to device registration, blanks and symbols are allowed here.

Bus Structure

Settings

Labeling Field x
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A list of parameters that can be used to automatically generate the device
labels is displayed here. Enter one or several parameters in the desired
input box.

After pressing "OK" to confirm the "EPLAN" dialog box, a Windows dialog
box will appear where you must enter a name and specify a path for the
export file. The filename extension for the EPLAN data is "EPL".

If during the export of the EPL file devices are found whose
"Manufacturer" and "Order Number" fields are empty, you will be
prompted to enter a macro name. The macro will be used by EPLAN to
interpret the device. In the case of devices from Phoenix Contact the
macros are automatically identified via the "Manufacturer" and "Order
Number" fields.

06_epl-mak.bmp

Fig. 6-96: EPLAN macro

Enter the name of the EPLAN macro for the device displayed above.

When this option box is selected, the system will no longer issue a prompt
when missing macro assignments are detected.

Menu "Parameterization Memory ... Write ASCII File …
INTERBUS Data (*.SVC)"
With this command you write the data of the opened project in an ASCII
file (*.SVC). The SVC file contains the complete parameterization and is
required for controller boards without parameterization memory (e.g. IBS
PC ISA SC/I-T).

The information contained in the SVC file is identical to the
parameterization data transferred to the parameterization memory of the
controller board (e.g. IBS S5 DSC/I-T) when the parameterization is
saved.

The IB Loader executes the INTERBUS system’s parameterization
process by interpreting an ASCII file (the SVC file) and transferring the
services and parameters stored in this file to the controller board. Data is
transferred via a serial port or the PC’s data bus.

Parameters

Macro Name

Do not display this dialog again.

IB Loader
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The SVC file contains firmware/PCP services and their parameters
separated by the entry "#CMD#". When booting from the parameterization
memory, the commands (services) executed are the same as those
transferred from the SVC file when booting with the IB Loader.
�&0'� �)LUVW�VHUYLFH�OLQH

��[�������6HUYLFH�FRGH �KHUH��$ODUPB6WRSB5HTXHVW�

��[������1XPEHU�RI�SDUDPHWHUV

�&0'� �)LUVW�VHUYLFH�OLQH

��[�������6HUYLFH�FRGH �KHUH��6HWB9DOXHB5HTXHVW�

��[������1XPEHU�RI�SDUDPHWHUV

��[������3DUDPHWHU��

��[������3DUDPHWHU��

��[������3DUDPHWHU��

The IB Loader is an EXE file for DOS, WIN 3.1x and WIN NT. The IB
Loader is also available as DLL for WINDOWS (16 and 32 bit). This DLL
(Dynamic Link Library) can be called e.g. from your application program.
When calling up your IB Loader you need to transfer some parameters
and the name of the SVC file to it.

By entering the IB Loader in the AUTOEXEC.BAT or putting in the
AUTOSTART group the INTERBUS is parameterized each time the host
PC boots.

Use:
,%/2$'(5�,%&20��&�?7(67�69&

to transfer the file "TEST.SVC" to the controller board via the serial port
"COM1".

Menu "Parameterization Memory ... Description ..."
The parameterization memory is used for resident storage of INTERBUS
parameterization, program and diagnostic data. The parameterization
memory may be differently structured depending on the controller board.
The product line ranges from pluggable ICs and plug-in boards up to
permanently installed ICs. All parameterization memories are flash
EPROMs which can be written to and read by IBS CMD G4.

In this dialog box you write in the parameterization memory. The "Name"
is also displayed in the representation area. Furthermore, there is an input
box for remarks and one for the name of the author of the
parameterization memory contents.

06_be-par.bmp

Fig. 6-97: Parameterization memory description

SVC File Structure

Operating the IB Loader
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Menu "Parameterization Memory ... Format"
Formatting the parameterization memory deletes its entire contents.

06_paraform.bmp

Fig. 6-98: Format parameterization memory

If no error occurs during formatting of the parameterization memory, the
following message appears:

06_parafor2.bmp

Fig. 6-99: Parameterization memory successfully formatted

During formatting the controller board displays: SCANDISK.
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Menu "Parameterization Memory ... Read"
In addition to the parameterization data the entire project can also be
stored in the parameterization memory. The parameterization data is
required by the controller board to start INTERBUS according to your
parameterization. The project files (*.BG4, *.INI) can be restored from the
parameterization memory by IBS CMD G4.

If you have saved your project in the parameterization of the controller
board with restorability, this command reads out the project with the files
*.BG4, *.INI and, if available, *.ZWT.

06_para-les.bmp

Fig. 6-100: Read parameterization memory

The entries displayed in the info boxes "Created by:", "Last updated by:"
and "Comment:" refer to menu "Project\Description". The data entered
there is displayed in the dialog box.

Note: Not all controller boards have a parameterization memory. For
PC controller boards with no parameterization memory the
parameterization can be stored as an ASCII file on the PC
drives.
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Menu "Parameterization Memory ... Write"
With this command, you write the project opened in IBS CMD G4 into the
controller board’s parameterization memory. Besides the bus structure
also the user functions, events, process data descriptions with their
assignments are transferred to the controller board.

The parameterization data can be booted directly from the
parameterization memory when starting up the controller board.

In addition to the parameterization data the entire project (*.BG4, *.INI
etc.) can be stored in the parameterization memory. Whether you want to
save the entire project in the parameterization memory and thus ensure
the restorability of the project in IBS CMD G4 is decided in the following
dialog box.

06_para-sch.bmp

Fig. 6-101: Write parameterization memory

Note: Not all controller boards have a parameterization memory. For
PC controller boards with no parameterization memory the
parameterization can be stored as an ASCII file on the PC
drives.
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Menu "Parameterization Memory ... Compare"
With this command, you compare the project opened in IBS CMD G4 with
a project in the controller board’s parameterization memory. File name,
date and comment of the projects are displayed in a dialog box.

The "State" line shows whether the two projects are identical after the
comparison.

06_para-ver.bmp

Fig. 6-102: Compare projects
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Menu "Parameterization Memory ... File"
Besides the parameterization and the project files which can read back,
you can also store other user files in the controller board’s
parameterization memory. Certain PCP devices (e.g. operating and
display devices) can load and use these user files directly from the
parameterization memory via special PCP services.

Start by selecting the user files and specifying whether they are to be
saved in the parameterization memory in compressed or uncompressed
format. The currently selected file set is compared with the file set in the
parameterization memory prior to being saved there. Files missing in the
current file set may be deleted from the parameterization memory. Files
that already exist can be overwritten.

06_men-date.bmp

Fig. 6-103: Menu "File"

Menu "Parameterization Memory ... File ... Select"
Start by selecting the files you want to save in the parameterization
memory. The files you select can be on any drive or in any directory.

06_dat-p1.bmp

Fig. 6-104: Selecting files
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This input box displays the files on the current drive in the selected
directory. Double-click on a file to add it to your file set.

Select the directory containing files you want to add to your file set.

Select the drive containing the files you want to select.

Specify the file type of the files displayed in the "File Name" input area.

The files (incl. The drive and path) you have added to the file set are
displayed here. Double-click on a file to remove it from the selection.

Buttons

This button is used to add the file selected in the "File Name" area to your
file set. You can also add a file by double-clicking on it.

Click this button to add all the files displayed in the "File name" area to
your file set.

This button is used to remove the file selected in the "Selected Files" area
from your file set. You can also remove a file by double-clicking on it.

File Name

Directory

Drives

File Type

Selected Files

Add

All

Remove
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Menu "Parameterization Memory ... File ... Read"
You can use this command to read files from your controller board’s
parameterization memory and put it in the directory specified in "Save In".

The dialog box shows the files available in the controller board’s
parameterization memory. To select and save a file in the selected
directory, click on it.

06_dat-p5.bmp

Fig. 6-105: Reading files

Project description

The name of the author of the file set that was last saved in the
parameterization memory is displayed here.

Comments on the file set that is currently in the parameterization memory
are shown in this display box.

This table shows which files are in your controller board’s
parameterization memory.

The name of the file in the parameterization memory is displayed here.

You can see here whether the file in the parameterization memory is
compressed or not.

This column shows the date of the original file.

The file size displayed here is the size of the uncompressed file.

The path to the directory and the drive where the files in the
parameterization memory will be stored are displayed here. You can
specify a default directory in "Options … Settings … General" or use
"Directory" to select a different path.

Author:

Comment:

Stored Files in the Project:

File Name

Status

File Date

File Size

Save In
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Buttons

You can use this button to change the drive and directory where the files
from the parameterization memory are to be stored.

06_dat-p7.bmp

Fig. 6-106: Select destination directory

After selecting the files and a destination directory, click this button to
start the read operation. If the file already exists in the destination
directory, you can choose to save it in a different directory with another
name.

06_dat-p6.bmp

Fig. 6-107: Reading user files

Click this button to overwrite the file in the destination directory with the
file in the parameterization memory.

This button opens the Windows Save dialog box. You can use it to save
the file from the parameterization memory in a different directory with a
different name.

Directory

Read

Overwrite

New Name …
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Menu "Parameterization Memory ... File ... Write"
You can use this command to write the files in the current file set to the
parameterization memory. The current file set is displayed and you can
select the files to be written in compressed or uncompressed format to
the parameterization memory.

06_dat-p2.bmp

Fig. 6-108: Writing user files to the parameterization memory

Project description

Enter your name in this box.

Enter comments about the file set.

Current project:

The name of the currently loaded project file is displayed here. Each row
of the following table represents a file in the current file set.

The file name, the path and the drive from which the file is written to the
parameterization memory are displayed here.

This column shows the date of the original file.

The file size displayed here is the size of the uncompressed file.

Select this option if you want the file to be saved in the parameterization
memory in a compressed format. Please consider that files used by PCP
devices must not be compressed, because otherwise they cannot be
used by the devices.

Buttons

When you click on this button, the system will start by comparing the files
in the current file set with the files in the parameterization memory. After
the files have been compared, the relevant files are written to the
parameterization memory.

Author:

Comment:

File Name

File Date

File Size

Compressed

Write



INTERBUS Configurator CMD Menu Structure 6-93

DOK-CONTRL-IBS*CMD****-AW01-EN-P

Click this button to access the dialog box for selecting the files to be
written to the parameterization memory.

Before a file in the parameterization memory is overwritten, the following
message will be displayed to prompt whether you wish to overwrite the file
or not.

06_dat-p3.bmp

Fig. 6-109: Overwriting a file

Click this button to overwrite the file in the parameterization memory.

Click this button, if you don’t want to overwrite the file in the
parameterization memory.

Click this button, if you want to overwrite all files in the parameterization
memory with file names identical to those in your file set.

Before the file set is actually transferred, a dialog box will appear to show
you which files in the parameterization memory will be deleted or
overwritten and which will remain unchanged.

06_dat-p4.bmp

Fig. 6-110: User files in the parameterization memory

Select

Yes

No

Overwrite All
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Project description

The name of the author of the file set that was last saved in the
parameterization memory is displayed here.

Comments on the file set that is currently in the parameterization memory
are shown in this display box.

Stored files in the project:

This table shows which files are in your controller board’s
parameterization memory.

The name of the file in the parameterization memory is displayed here.

You can see here whether the file in the parameterization memory is
compressed or not.

This column shows the date of the original file.

The file size displayed here is the size of the uncompressed file.

The result of the file comparison is displayed in this column. The following
attributes exist for the files in the parameterization memory:

The file is in the file set and in the parameterization memory. However,
you have decided not to overwrite the file in the parameterization memory.

The file is not in the file set. Therefore, the file is deleted in the
parameterization memory.

The file is in the file set and in the parameterization memory. However,
you have decided not to overwrite the file in the parameterization memory.

Additionally, the total number of files and their file sizes (uncompressed)
is displayed.

Note: Files with the "delete" attribute are deleted from the
parameterization memory.

Author:

Comment:

File Name

Status

File Date

File Size

Attribute

Overwrite

Delete

Do Not Overwrite
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Menu "Preprocessing ... Variables"
In this dialog box you can create variables that are made available to the
"Preprocessing" add-on program. After creating a variable you must
assign the required process data description.

Note: Note the relationship between data type and process data
length. For example, a 8 bit process data item could be a SINT
or a BYTE.

06_variab.bmp

Fig. 6-111: Program variables

To create the first variable, click on the empty table and press then the
<Ins> key. You can also use the "Insert Variable" command from the
context menu (right mouse button).

To create other variables with the keyboard, you must first mark a line
number (<Cursor left> key). Press the <Ins> key, when the line number of
the whole line is marked.

If you insert a variable with the context menu, it is not necessary to mark
the line. If the insertion mark is in the last line of the table, you can also
create variables by pressing the <ENTER> key.

Enter an unambiguous name for your variable in this column. You use this
variable names in the "Preprocessing" add-on program or in PROGRAM
WORX.

Here you can select the desired data type from a selection box. Note that
you can only assign the variables to process data descriptions of the
correct length.

1 bit (BOOL)

8 bit (BYTE, SINT)

16 bit (WORD, INT)

32 bit (DWORD, DINT, REAL)

Enter the letter "Q" for output data and the letter "I" for input data in this
column to define your variable as an input or output variable.

If you want to assign a specific default value to a variable, you can specify
this value here. You must specify the initial value according to the syntax:
Datatype#Value.

In this column you can switch the Multiple Assignment for the respective
process data description ON or OFF. If several process data descriptions
have an assignment, each one must be capable of multiple addressing.

Creating the First Variable

Creating a New Variable

Variable Name

Data Type

Q/I

Initial Value

MA
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In this column the variables are linked with process data descriptions. Use
the "Direct Link …" command from the context menu to input the
assignment.

Option boxes

If you have restricted the representation of the variables in the "Filter"
dialog box, you can activate or deactivate the filter function with this option
box.

Buttons:

When you press this button, the context menu of the dialog box opens.
The commands of this menu allow you to edit the variables in the dialog
box.

Context Menu "Preprocessing Variables"
The "Variables" dialog box has a context menu for comfortable operation.
Like the other context menus, you call up this menu with the right mouse
button or with <SHIFT>+<SPACE> or <SHIFT>+<F10>.

06_kon-vor.bmp

Fig. 6-112: Context menu "Variables"

This command inserts a new line in the dialog box above the marked line.
Every line represents a variable.

Deletes the marked line from the dialog box.

With this menu item you open a dialog box which offers you the process
data descriptions available for the marked variable (matching in the data
length).

With this menu item, you open a dialog box for filtered representation of
the variables.

Assignments

Filtered

Edit

Insert Variable

Delete Variable

Direct link

Filter
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Dialog Box Filter (Variables)
Here you select the options that restrict the representation of the
variables. Only the variables matching all the requirements specified here
are displayed.

Several options can be selected simultaneously.

06_filter.bmp

Fig. 6-113: Filter for variables

With this filter setting you can specifically display the variables of a certain
program instance.

Display all variables which match the corresponding search filter. The
asterisk character "*" is used as a wild card.

Example: "a*" shows all variables beginning with "a".

Display of all variables with specified data type such as BOOL, BYTE,
WORD, etc.

Display of all variables with specified data direction (input or output data).

Display of all with specified addressing (with or without direct link).

Note: The displayed variables are possibly not complete when the
option "filtered" is active in the variable box.

Program Instance Name

Variable Name

Data Type

Data Direction

Addressing Type
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Dialog Box "Process Data Assignments"
In this dialog box you can assign process data descriptions to
preprocessing variables.

Only process data descriptions that correspond in terms of length to the
variables selected beforehand are displayed.

06_durchga.bmp

Fig. 6-114: Process data assignment

The names of the variables can be automatically generated based on the
name of the process data description assigned. The automatic name
generation is only active while the variable has no name. In addition to the
name of the process data description assigned, the variable name can
also contain the device number. You can specify whether the device
number is placed in front of or after the name of the process data
description.
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Menu "Preprocessing ... Description ..."
In this dialog box you describe the (process data) preprocessing. The
"Name" is also displayed in the representation area. Furthermore, there is
an input box for remarks and one for the name of the author.

In the "IBS CMD G4" software, the preprocessing consists of FBDE =
Functional Block Diagram Editor. With the FBDE you are able to create
programs in the "FBD" programming language and execute them on the
controller board.

06_be-fbde.bmp

Fig. 6-115: Preprocessing description

Menu "Preprocessing ... Programming"
With this menu item, you start the "Preprocessing" Add-on program with
which you can realize the preprocessing of the process data in a graphic
editor. The graphic editor offers you the possibility of creating a program
in the "FBD" (Function Block Diagram) programming language. This
program is used for preprocessing your INTERBUS data.

Menu "Preprocessing ... Import"
You can import GLV files with this menu item. GLV files contain
definitions of global variables for the preprocessing of process data. You
save the global variables in a file in order to make them available to
several projects.

Import and export of the GLV files takes place in a Windows standard
dialog box for file selection.

Rules for Assigning Variable names according to
IEC 1131-3
A variable name must be specified with at least one and at the maximum
31 characters. The first 30 characters must be unambiguous.

The variable name may only contain alphanumeric characters (A-Z, a-z,
0-9) and underscores (_). Special characters are not permitted.

The first character of the variable name may not be a digit.

The first character of the variable name may not be an underscore (_).
However, there may not be two underscores at the beginning of the
variable name.

No keywords may be used.
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Reserved Keywords according to IEC 1131-3
The following keywords (according to IEC 1131-3) may not be used as
variable names:

A ABS, ACOS, ACTION, ADD, AND, ANDN, ANY, ANY_BIT,
ANY_DATE, ANY_INT, ANY_NUM, ANY_REAL, ARRAY, ASIN, AT,
ATAN

B BOOL, BUSY, BY, BYTE

C CAL, CALC, CALCN, CASE, CD, CDT, CLAIM, CLK, CONCAT,
CONFIGURATION, CONSTANT, COS, CTD, CTU, CTUD, CU, CV

D D, DATE, DATE_AND_TIME, DELETE, DINT, DIV, DO, DS, DT,
DWORD

E ELSE, ELSIF, END_ACTION, END_CASE, END_CONFIGURATION,
END_FOR, END_FUNCTION, END_FUNCTION_BLOCK, END_IF,
END_PROGRAM, END_REPEAT, END_RESOURCE, END_STEP,
END_STRUCT, END_TRANSITION, END_TYPE, END_VAR,
END_WHILE, EN, ENO, EQ, ET, EXIT, EXP, EXPT

F FALSE, F_EDGE, F_TRIG, FIND, FOR, FROM, FUNCTION,
FUNCTION_BLOCK

G GE, GT

I IF, IN, INITIAL_STEP, INSERT, INT, INTERVAL

J JMP, JMPC, JMPCN

L L, LD, LDN, LE, LEFT, LEN, LIMIT, LINT, LN, LOG, LREAL, LT,
LWORD

M MAX, MID, MIN, MOD, MOVE, MUL, MUX

N N, NE, NEG, NOT

O OF, ON, OR, ORN

P P, PRIORITY, PROGRAM, PT, PV

Q Q, Q1, QU, QD

R R, R1, R_TRIG, READ_ONLY, READ_WRITE, REAL, RELEASE,
RE-PEAT, REPLACE, RESOURCE, RET, RETAIN, RETC, RETCN,
RE-TURN, RIGHT, ROL, ROR, RS, RTC, R_EDGE

S S, S1, SD, SEL, SEMA, SHL, SHR, SIN, SINGLE, SINT, SL, SQRT,
SR, ST, STEP, STN, STRING, STRUCT, SUB

T TAN, TASK, THEN, TIME, TIME_OF_DAY, TO, TOD, TOF, TON, TP,
TRANSITION, TRUE, TYPE

U UDINT, UINT, ULINT, UNTIL, USINT

V VAR, VAR_ACCESS, VAR_EXTERNAL, VAR_GLOBAL,
VAR_INPUT, VAR_IN_OUT, VAR_OUTPUT

W WHILE, WITH, WORD

X XOR, XORN
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Menu "Configuration Frame"

Menu "Configuration Frame" Read Again"
This menu item reads in the configuration frame activated on the
controller board. An already loaded bus configuration is overwritten.

06_konein.bmp

Fig. 6-116: Read configuration frame

ATTENTION

⇒ If the controller board is in the "READY" state, the
connected configuration is read in by "Create
Configuration". All data of the loaded project will be
lost.

Menu "Configuration Frame …" Description"
The configuration frame contains the bus topology, the process data
descriptions and their assignments, the group assignment and other
parameters which determine the configuration of the bus.

With this menu item you describe the configuration frame. For this
purpose, you can enter a name, remarks and an author. The entry in the
input box "Name" is also displayed in the representation area.

06_be-kon.bmp

Fig. 6-117: Configuration frame description
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Menu "Configuration Frame …" Compare"
The active configuration frame on the controller board is compared with
the configuration frame IBS CMD G4. If there is a difference between the
two configuration frames and if this difference is allocated to a device, the
device is marked and an appropriate message is displayed.

06_konver.bmp

Fig. 6-118: Compare configuration frame
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Menu "Device ..."

Menu "Device ... Description ..."
With this dialog box you can create a description for a marked device. A
device is an unit participating in data traffic via the INTERBUS.

The entries after "Manufacturer Name" can be taken, for example, from
the data sheet or determined in "Options … Print Device Description".

06_be-teil.bmp

Fig. 6-119: Device description

Display/Edit boxes:

The number is displayed for the consecutively numbered INTERBUS
devices.

The device number indicates the number of the bus device. It consists of
the bus segment number and the position number within the bus (e.g.
1.3).

You can combine individual bus segments to form groups. It is also
possible to define alternative groups. Thus, the group number is
composed of: [group] - [alternative].

Here you can describe the station's position in which the device is used
(e.g. hall 4, switch cabinet 2).

You can assign a Service Info to an INTERBUS device, in order to identify
them clearly and quickly in case of a malfunction. The Service Info has a
maximum of 12 characters. The service information of the individual
INTERBUS devices are saved in the configuration frame and are,
therefore, available in system operation on the controller board. The
service information of the devices causing the malfunction can be
displayed on the (hardware or software) LCD. To edit the service
information according to your requirements, you have to select the option
"Assign Individually" in the "Service Info" selection box.

Consecutive Number

Device Number

Group Number

Station Name

Service Info
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In this selection box you can select the device data that you want to use
as service information. You can choose e.g. "Station Name" in the
selection box, if you want to use the first twelve characters in the station
name for the Service Info. The station name is then copied automatically
into the "Service Info" box.

Here you assign a name to the device (e.g. limit stop switch group 3 or
motor current M1 to M4).

Here the name of the manufacturer appears. This entry is taken from the
device data base.

Here you can see the product designation of the device (e.g. IB ST 24
BK-T). This entry is taken from the device data base.

Here the order number of the device is displayed provided it as a Phoenix
Contact product.

The ID Code is the low-order byte of the device code which describes the
function of the device.

The profile number codes a certain device function within a device
specification, such as DRIVECOM, ENCOM or MMICOM. A device is
clearly assigned to a specification by the profile number.

This entry shows how many bits the device occupies within the process
data channel.

This entry shows how many words the device occupies within the
parameter data channel. If you open the dialog box on a device with a
variable parameter data channel length, you can select the length of this
parameter data channel in this selection box.

Enter here the communication reference (CR) of the device. The CRs
start at 2 and must be assigned without interruption in ascending order.
Thereby, the position of the PCP device in the bus system is irrelevant.

The communication reference (CR) identifies an INTERBUS device in the
parameter data channel (PCP). To send a PCP service to a device, its CR
must be specified.

The Input box "CR" is only available for devices with parameter data.

Option box:

In this option box you can gray out the device in the configuration frame.
This means that the data from or for this device is not taken into account
by the controller board in the data transmission.

When this option is checked, the device is displayed in box display mode.

"Service Info" Selection Box

Device Name

Manufacturer Name

Device Type

Order No.

ID Code

Profile Number

Process Data Channel

Parameter Channel

CR

Gray out Device

Box Display
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Dialog Box "Parameter Channel ..."
In the "Parameter Channel" dialog box you determine the services that
the controller board supports for the marked PCP node.  These services
can be executed by the controller board at a request of the PCP node.

You can enter a comment and assign the services and message lengths
to the standard values.

06_parakan.bmp

Fig. 6-120: Parameter channel

Enter the total message lengths in bytes into the input box. The message
lengths marks the transmit and receive buffer of a PCP node. A service
sent from or to a PCP node may not exceed a maximum length.

These two buttons set the settings for message lengths and supported
parameter data channel services to standard values. The standard value
is 64 bytes for the message lengths as well as "Read" and "Write" as
supported parameter data channel services.

Depending on the selected PCP services a hexadecimal number code
displayed.

PCP nodes with permanently defined programs exist that send a
predefined confirmation specified by their program back on REQUEST. In
addition, there are so-called "intelligent" PCP nodes in which you can
create the program (an application program) yourself. In application
programs running on these devices you must acknowledge the response
bit with the confirmation bit after receiving an INDICATION.

Message Lengths

Standard
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Dialog Box "Interface Type for Bus Terminal Mode"
With the "Interface Type for Bus Terminal Mode" you determine with
which INTERBUS interfaces the device is equipped. Hereby, a distinction
is made between the incoming interface (IN1), the outgoing interface
(OUT1) and the branching interface (OUT2).

INTETBUS interfaces are e.g.  2-wire remote bus, fiber optics remote
bus, 8-wire local bus, etc.

06_fern-sch.bmp

Fig. 6-121: Interface Selection

If you use an interface that does not correspond to any preset interface
type, you should use the "Universal" interface type.

Note: If the wrong interface type is selected, you receive an error
message. However, the device will be positioned and the
connection drawn with a dotted line to indicate the wrong
interface type. If the device interface is set to "Universal" on
one side of a connection, a different interface type is not
indicated.
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Dialog Box "Display"
In this dialog box you can select an icon that will be visible in standard
display mode and set the color and width of the box display.

06_mod-bild.bmp

Fig. 6-122: Presentation

You can use "Icon Library" to assign an icon to the device. This icon is
only visible in the standard display mode.

You can take an icon either from the standard library or from the
manufacturer-specific library. Icon libraries have the file name extension
ICL (Icon Library). Besides the icon libraries, you can also assign
individual icons. These icons have the file name extension "ICO".

Press this button to select the desired icon library in a file selection dialog
box.

To use the standard icon library, click this button.

Custom Icons:

To create your own icons, you need to draw the icon first using an icon
editor. Then, a Windows DLL has to be created using a suitable compiler
an the file name extension has to be changed from DLL to ICL. The IBS
CMD G4 CD-ROM contains a detailed description on  how to do this
together with a demo program.

Icon Library

Select

Standard
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Box Presentation

These settings control how the INTERBUS appears in the box display.
You can choose a color for the ID strip and set the width of the device
(narrow, standard, wide).

06_box_har.bmp

Fig. 6-123: Box presentation"

Groups and alternatives

You can join individual devices to groups, in order to switch all devices on
and off at the same time. A group may also include devices that do not
follow consecutively. If you switch off a group, all devices of this group
and the devices depending on these devices (e.g. the corresponding local
bus branch) are switched off.

All devices within a local bus segment (except the bus terminal) must
have the same group number.

06_gruppen.bmp

Fig. 6-124: Groups

You can switch a group on and off with the firmware service
Control_Active_Configuration_Request (0713 hex ).

The device number is then transferred to the firmware service.

ATTENTION

⇒ If the device to be switched off is assigned to a
group, this group is completely switched off. When
you switch off a bus terminal, always switch off all
the following remote bus devices including the local
bus on the bus terminal module.

Note: The group number consists of group and alternative with the
syntax: GROUP - ALTERNATIVE.

Groups
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The "Group" parameter assigns a device or local bus segment to a group.

An alternative is a self-contained part of the bus configuration that can be
activated at a certain position alternatively to the rest of the bus
configuration.

You can define alternative bus segments within a group. According to the
requirements one of the defined alternatives can be connected.

Note: An alternative group can only be connected to a remote bus
device.

06_alternat.bmp

Fig. 6-125: Alternatives

Group

Alternative
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Menu "Device ... Process Data"
A process data description describes the process data of a device.

Name,

data direction,

data length,

and the assigned destinations (addresses, variables, direct links).

Each process data description is represented by one line in the process
data dialog box. For example, you can create one process data
description for one single bit of a digital device or a channel of an analog
device. So, you have the possibility to assign process data specifically to
addresses or linking them which each other.

Note: If you open the process data dialog box from the "Controller
Board" element, you will see the process data descriptions of
all devices in the current INTERBUS project. If you open the
"Process Data" dialog box from a device, you will only see the
process data descriptions of that device.

06_adr-teil.bmp

Fig. 6-126: Process data dialog box of a device

Process Data Descriptions
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Columns in the process data dialog box:

Marks the position of the process data within a standard process data
description (entire process data channel length) of the device.

06_p-lage.bmp

Fig. 6-127: Location of process data

The position of data is represented by vertical bars. Every bar represents
one bit. Long bars mark the bits used in this process data description,
small bars mark the unused bits.

The process data name clearly designates the selected process data
description.

This is a display specifying whether this is input (I) or output (O) data.

Enter the process data length in bit in this input box.

Enter here the byte number of the standard process data description at
which the selected process data description has to be started.

For process data descriptions < 8 bit you can specify here at which the bit
of the specified byte the process data description is to be started.

If you want to assign several addresses or variables to a process data
description, you have to activate the option box "MA" = Multiple
Assignment.

This column serves to enter the assignments. These are variables,
addresses or also other process data descriptions. Use the context menu
to select the assignments or enter the assignment directly.

Display:

This display shows the whole process data channel length that is
assigned by one device in the INTERBUS process data channel. Thereby,
the process data channel length of the device’s process data description
you have selected is displayed.

Buttons:

When you press this button, the context menu of the dialog box opens.
The commands of this menu allow you to edit the process data
descriptions in the dialog box.

Option box:

If you have restricted the representation of the process data descriptions
in the "Filter" dialog box, you can activate or deactivate the filter function
with this option box.

Location

Process Data Name

I/O

Length

Byte

Bit

MA

Assignments

Standard Device Data

Edit

Filtered
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6.5 Menu "Options ..."

IBS CMD G4 enables add-on programs to be linked. The add-on
programs include monitors, parameterization and diagnostics programs
that are supplied by device manufactures in connection with their device
descriptions.

06_m1-extra.bmp

Fig. 6-128: Menu "Options ..."

Menu "Options ... Add-on Programs … Activate ..."
An add-on program is activated by this menu item. The activated program
extensions are listed as additional menu items in the "Edit",
"Configuration", "Monitor", and "Diagnostics" menus. The context menus
are also adapted in accordance with the activated add-on programs.

06_aktivire.bmp

Fig. 6-129: Activate add-on programs

The add-on program is available as a DLL (Dynamic Link Library). You
can select the desired DLL using a file selection dialog box (Windows
standard).

Add-on Programs
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Menu "Options ... Add-on Programs … Deactivate"
Use this command to deactivate add-on programs and remove them from
the menu.

06_deaktivi.bmp

Fig. 6-130: Deactivate add-on programs

Click-on the add-on program to be removed and confirm with "OK".
Deactivation of add-on programs may be useful when you want to replace
an add-on program with an add-on program with a similar function or if
your system resources are insufficient for all add-on programs.

Menu "Options ... Device Description … Create"
To create a device description for the IBS CMD G4 database, you must
first have inserted a device in the bus topology or have marked a device
from the bus configuration. Insert a new device with "Insert with ID code".

Starting with the inserted and/or marked device you generate a new
device description for the IBS CMD G4 database with this menu item.

The following dialog boxes are not transferred or filled out in the new
device description:

• Station name

• Device name

This two entries are only displayed in the bus configuration and not
transferred to the device database.

Preconditions:

Function:
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06_teil-bib.bmp

Fig. 6-131: Create device description

Device description

Here you specify in which device group you want to insert the new device
description. You can assign the device description, for example, to the
device groups Phoenix, MMICOM, DRIVECOM, etc., or create your own
device group by entering a new name for this group in the "Device Group"
input box.

Here you enter the name of device manufacturer (e.g. Phoenix Contact).

Here you enter the product designation of the device (e.g. IB ST 24 BK-
T).

The profile number codes a certain device function within a device
specification, such as DRIVECOM, ENCOM or MMICOM. A device is
clearly assigned to a specification by the profile number.

With the buttons

• Interface Type …

• Icon …

• Parameter Channel …

you make further setting.

After you have confirmed the dialog box with "OK", the device description
is inserted in the database and is available for other projects.

Device Group

Manufacturer Name

Device Type

Profile Number
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Menu "Options ... Device Description … Print"
You can print the device description with this menu item. Select a device
from the device database by making an appropriate preselection in the
boxes "Group", "Manufacturer", "Type", or "ID Code".

A description of the with the most important data is printed.

06_druck2.bmp

Fig. 6-132: Print device description

Menu "Options ... Device Description … Delete"
A device description can be deleted from the device database with this
menu item.

Menu "Options ... Device Description … Import"
An import function permits to use the device database and self-created
device descriptions from older IBS CMD versions (Version 1.x). With this
command you can import specific device descriptions available in the IBS
CMD 1.x format.

If the device description already exists in the IBS CMD 4.x database, an
appropriate message is output.

06_teiln-im.bmp

Fig. 6-133: Import device description
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Menu "Options ... Device Description … Export"
The export function has the function to provide the device database of
IBS CMD Version 4.x for older IBD CMD versions (Version 1.x). With this
command you can convert individual device descriptions specifically into
the DHS format (file name: *.DSH) of the older CMD version.

06_teiln-ex.bmp

Fig. 6-134: Export device description

You can save the device previously selected in the IBS CMD 4.x device
database in a dialog box (as you are used to from IBS CMD 1.x) in the
database.

To do this, enter "Manufacturer Name", "Device Group", and "Device
Type" or select the desired entries from the existing entries.

Note: When making new entries, make sure that the MS-DOS file
name conventions are observed. Blank,
* ? . and other special characters are not allowed in file name
entries.
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Menu "Options ... Reset CRs"
With this command you establish the standard counting order for the
communication references (CR) for all PCP-capable devices. This order
determines that the first PCP node in the bus configuration (seen from the
controller board) is assigned CR=2 (the 2nd PCP node is assigned CR=3,
etc.).

Basically, you can determine the counting order yourself as long as one
PCP node is assigned CR=2 and all following CRs are assigned
consistently, i.e. without gaps (until every PCP node has a CR). The CR
of a device is assigned in the device description. Accordingly to that, the
references in the application program are assigned to the devices, i.e.
memory addresses.

If you suspect or determine that the manual CR assignment is
inconsistent and manual checking appears too complex, use this
command to quickly and reliably assign the CRs automatically in the way
described above.

Your application program must be changed accordingly!

With the aid of the PCP (Peripherals Communication Protocol) data is
transmitted via the parameter data channel. This data is used, for
example, for configuration and parameterization of PCP nodes such as
counters, frequency inverters, operator interfaces, etc.

Menu "Options ... Extended Scope of Functions"
This menu item is password protected.

The extended scope of functions is available when you enter the correct
password.

Only actions which cause a change in the configuration data are
permissible and marked as editable in the extended scope of functions.

06_password.bmp

Fig. 6-135: Password request

A password is only requested if you have assigned one. Otherwise, you
reach the extended scope of functions without being asked to enter a
password.

In the menu " Options …  Settings" you can assign a password at any
time if you know the old password.

PCP
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Menu "Options ... Settings"
With this menu item you go to a dialog box in which you can make global
settings for IBS CMD G4.

The dialog box consists of several "file cards". When you click-on a file
card in the top section, the dialog part of this card is displayed.

The "Settings" consists of the following file cards:

• Driver

• Device Database

• General

• Process Data

• Database (general)

• Password

06_einstell.bmp

Fig. 6-136:  Settings
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Menu "Options ... Settings ... Driver"
In this dialog box you select the communication path between IBS CMD
G4 and the controller board.

06_einst-tr.bmp

Fig. 6-137: Settings "Driver"

Communication between IBS CMD G4 and controller board:

The PC (on which IBS CMD is running) and the controller board
communicate via a serial connection. Connect one the serial ports of your
PC (COM1 to COM4) with the diagnostic interface on the front panel of
the host controller board. The connection is realized by a serial
connecting cable. This communication path is available in PLC controller
boards. Concerning PLC controller boards only one communication path
is available.

Driver selection and parameterization

To select a driver, first click-on the driver in the "Installed Drivers"
selection box. Confirm your selection the "Select" button.

In order to specify the communication path in more detail click-on the
"Connect" button. Here you will get different dialog boxes depending on
the selected driver.

Here you can see the drivers available on your PC.

• DriverIBSISASC – driver for communicating via the data bus (IBS PC
ISA SC/I-T)

• RS-232 driver for communicating via the serial interfaces.

To activate a driver, click-on one of the drivers and confirm the selection
with the "Select" button.

The selected active driver is displayed in this info box.

This info box shows you to which communication path (COM1, COM2 ...)
or to which controller board (PC card1, PC card2 ...) the driver is set at
present.

Installed Drivers

Active Driver

At
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Buttons

With this button you confirm the selection made in the "Installed drivers"
box.

With this button you call a dialog box to select the communication
connection. You can select a free serial interface of your PC for
communication via the serial interfaces. For communication via the data
bus of the PC you can select the desired controller board if there are
several controller boards in a PC.

You can change the driver parameters with this button. The first time you
open the dialog box you will see the standard values for the selected
driver.

Dialog Box "Select Connection" for the "RS-232" Driver
Select the serial interface with which you have connected the controller
board here.

06_einst-t3.bmp

Fig. 6-138: Select serial interface

Dialog Box "Driver settings" for the "RS-232" Driver
In this dialog box you set the communication parameters of the serial
interface.

06_einst-t4.bmp

Fig. 6-139: Setting the serial interface

Select

Connect …

Settings ...
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Menu "Options ... Settings ... Device Database"
You can set messages and search criteria of the device database in this
dialog box.

06_einst-te.bmp

Fig. 6-140: Settings "Device Database"

Link with description"

After you have read in the physical bus topology with the command "Read
Again" you can link the read in devices with descriptions from the device
database. If a device with variable process data length is available for
linking, a message is displayed indicating this. You can display these
messages by marking the option box.

You can use one of the installed databases as the basis for the "Link With
Description" command.

You can select the database you want to use for linking devices in this
selection box.

After you have read in the physical bus topology with the command "Read
Again" you can link the read in devices with descriptions from the device
database. You can restrict these links to a certain device group by
specifying this here.

If you insert a multiple device via "Insert with Description" in your bus
topology you can have a message displayed in this option box. A multiple
device is a device with more than one ID code which cannot be
understood as one device within the bus system.

In this selection box you can specify the device database you want to use
for creating and importing device descriptions.

Here you select the drive which represents your CD-ROM drive. This
specification is used to enable the software to get access to the electronic
product directory which lists product data of various manufacturers.

Display Devices with Variable
Process Data Length

Active Database

Restrict to Device Group

Message when Inserting Multiple
Devices

Active Database for Device
Descriptions

Electronic Product Directory
From CD-ROM:
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Menu "Options ... Settings ... General"

06_einst-al.bmp

Fig. 6-141: Settings "General"

Use this option to switch the function key bar on and off. If the option is
selected, the function key bar is visible.

06_f-leiste.bmp

Fig. 6-142: Function key bar

With this option you can set whether an action or service result is to be
displayed or not. If the option is selected, the service results are
displayed. After you have activated the option "Display Service Results
(Confirmation)", you have to execute the parameterization again to
activate the option.

Actions are services assigned with parameters which have been defined
with a fixed name under IBS CMD G4.

You can see the service results with code, name and parameters in the
following dialog box.

Display function keys

Display Service Results
(Confirmation)
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06_dienster.bmp

Fig. 6-143: Show service results

If the service is a confirmed service (Request), the request for a service is
followed by a service result (Confirmation). Activate this option, if you
want to see this service result.

06_dienst.bmp

Fig. 6-144: Service primitives

Mark this option box, if you want a request from IBS CMD G4 when
changing the operating states.

IBS CMD G4 has the operating states:

• Configuration (Offline)

• Configuration (Online)

• Diagnostics

• Monitoring

Mark this option to use the Service Info. The Service Info is assigned to
the INTERBUS devices in order to identify these clearly and quickly in
case of a malfunction. You can enter the Service Info for the respective
device under "Device Description". After you have activated the option
"Use Service Info", you have to execute the parameterization again to
activate the option.

When this option is selected, the system benchmark figures are checked,
when you choose commands such as "Check Parameterization" and "Run
Parameterization". The system benchmark figures contain information on
the INTERBUS’s hardware specification such as:

• max. number of PCP devices

• max. number of devices in the INTERBUS

• Max. number of devices per bus terminal module (peripheral bus) and
so on.

Ask for Change of CMD Mode

Use Service Info

Check System Benchmark
Figures
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IBS CMD G4 uses standard paths in which projects, user files and icon
libraries are searched for or saved. If you want to adapt these standard
paths to your requirements, you can set the desired path with the
"Search" button in a dialog box or enter it directly in the input box.

06_pfade.bmp

Fig. 6-145: Select directory

You can enter the standard path for the project files in this box. If you use
the "Save" menu command, the files BG4, MES, STC, INI of your project
are saved in the standard path.

You can store any (user) files in the controller board’s parameterization
memory. These files are responsible, for example, for controlling operator
interfaces and indication elements. You set the standard path for user
files in this box.

The icons used for representing devices are saved in ICL files (icon
libraries). Set the search path for icon collection here.

Standard Paths

Projects

User Files

Icon Library
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Menu "Options ... Settings ... Database (general)"
Besides the internal IBS CMD G4 database, you can also use databases
from other manufacturers or databases created by yourself for "Link
Description" or "Insert With Description". To use additional device
databases, you need to declare this in your computer’s ODBC
environment (Open Database Connectivity). The ODBC environment is
located in the Windows Control Panel.

06_einst-ag.bmp

Fig. 6-146: Settings "Database (general)"

All registered databases are displayed as "available". Select only
databases when you know that they are device databases.

Menu "Options ... Settings ... Process Data"
Here you specify the address range of the PLC or the PC in which you
want to write the INTERBUS data. The address range must be specified
in the typical written form for the respective host system.

06_einst-pr.bmp

Fig. 6-147: Settings "Process Data"
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If you restrict the address range, the program sequence is accelerated in
some dialog boxes (e.g. in the assignment of addresses to process data
descriptions). For example, you can restrict the address range to P
addresses in a S5 controller board, if you do not want to use the Q and E
addresses or if these addresses are not available.

Menu "Options ... Settings ... Password"
In this dialog box you can assign a password or change an existing
password. This password is requested when changing to the extended
scope of functions. The length of the password is a maximum of ten
characters. The entered password does not appear on the screen, but is
represented by a row of stars ("*").

06_einst-pa.bmp

Fig. 6-148: Settings "Password"

Enter an existing password here. When you create a password for the
first time, this entry remains empty. You can only create a new password,
if you know the old password.

Enter the new password here.

Enter the password a second time to confirm it.

Old Password

New Password

Enter New Password Again
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6.6 Menu "? ..."

06_m1-hilf.bmp

Fig. 6-149: Menu "? ..."

Menu "? ... Contents"
Use this command to go to the table of contents of the help file. Here you
will get help for all menu items, dialog boxes, and for operating IBS CMD
G4.

Note: With the "Help" button in the dialog boxes, you can go directly
to the help page available for the dialog box. You can also call
up context-sensitive help at any time using the "F1" function
key.

Menu "? ... Operating Instructions"
Use this menu item to get help for:

• Operation and display elements,

• Selection of menus and menu entries or

• Operation of dialog boxes.

Menu "? ... Firmware Library"
The firmware library gives you an overview and detailed explanations of
services and error messages of the Generation 4 firmware and of PCP
services.

Menu "? ... First Steps"
This menu item contains a guide to help you through the most important
functions of IBS CMD G4. The most frequently used commands are
explained by examples and diagrams.

Menu "? ... Using Help"
Use this command to start the standard Windows help.

This will give you general information about working with Help systems
under MS Windows.
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Menu "? ... About"
In this dialog box you get information about the version, serial number,
product designation, an date of creation of your IBS CMD G4 version.

06_info.bmp

Fig. 6-150: About
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7 Diagnostics

7.1 General Information

The "Diagnostics" mode offers you fast and effective help during start-up,
error localization and elimination in the system. Defective bus devices,
defective connections or errors in the sensors and actuators can then be
processed and eliminated with the easy-to-use editing features of IBS
CMD G4.

05_desi-1.bmp

Fig. 7-1: Diagnostics

A special feature of this program is the statistical error evaluation running
in the background, which gives you information on the error resistance of
the system (e.g. to electromagnetic interference) as messages (e.g.
module errors) and transmission errors are automatically recorded.

Messages and statistic data are only recorded, if there is a connection to
the controller board and IBS CMD G4 is in the "Diagnostics" operating
state.
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7.2 Main Window "Diagnostics

From the diagnostics main window you can call messages and statistics
of the INTERBUS system and set options of the diagnostics program.

07_diaghaup.bmp

Fig. 7-2: Main window "Diagnostics"

Function key bar:

The function key bar has the task to enable a faster program operation.
The most important menu commands are included in the function key bar
as buttons.

Current message displays in the main window:

Note: The contents of the display in the "Error" and "State" boxes
are read from the "Diagnostics status register". The display of
the device number on the right of the "Error" box is derived
from the "Diagnostics parameter register".

This box displays the last device, where an error occurred.

This displays, for example, whether the bus is running or whether data
transmission was stopped.

The last incoming message is described in detail in this info box.

Buttons

The message history can be called with this button. The current state is
displayed in the following box. If messages exist, the area contains the
display Filled, otherwise the message Empty.

The transmission statistics can be switched on or off with this button. The
current state is displayed in the following box.

Error

Status

Current Message

Messages (Online)

Statistics (Online)
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7.3 Menu "Commands Diagnostics"

07_diagmen.bmp

Fig. 7-3: Main window "Diagnostics"

Settings ...

Close

07_diagm-1.bmp

Fig. 7-4: Menu "Diagnostics"

Message History …

Evaluate Message File …

Message Types

07_diagm-2.bmp

Fig. 7-5: Menu "Messages"

Record Statistics (Online) …

Evaluate Statistics File …

Top Ten ...

Last Peripheral Error …

Reset Statistics Counter

07_diagm-3.bmp

Fig. 7-6: Menu "Statistics"

Bus System Messages

07_diagm-4.bmp

Fig. 7-7: Menu "Window"

Diagnostics

Messages:

Statistics:

Window
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Contents

Using Help

07_diagm-5.bmp

Fig. 7-8: Menu "? ..."

Menu "Diagnostics ... Settings ..."
You can make the basic diagnostics settings in this dialog box.

The add-on program "Diagnostics" stores the data in two data types.
These are the statistics file with the file extension *.STC and the message
file with the extension *.MES. You can analyze the contents of these files
under the menu items "Evaluate Message File" or "Evaluate Statistics
File".

07_diageins.bmp

Fig. 7-9: Settings

Here you can enter the seconds after which the statistic data is read out
cyclically of the controller board. Only the number of individual cycles is
read out in cyclic reading. If the number of defective cycles has changed
and a message is output, the data is entered in the statistic file.

Statistics file

Here you see the drive, the path and the name of the current statistics file.

With this button you get a file selection dialog box from which you select
an existing file or in which you can create a new statistics file. The file
name extension *.STC is defined for the statistic files and cannot be
changed.

?

Update Automatically After

Save As:

Select File
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07_diagdat.bmp

Fig. 7-10: Save statistic file

With this button you delete the current statistics file after a security
prompt.

07_diagloe.bmp

Fig. 7-11: Delete STC file?

Is this option active, the current statistic data is only saved after it was
commented.

If this option is active, the statistic data is saved after every change. Only
a change in the number of defective cycles causes the statistic data to be
saved. Every occurring malfunction generates a further entry with
date/time stamp in the statistic file.

You can cancel saving the statistic data after a certain time and/or if the
statistics file has reached a certain size.

Message file:

Here you see the drive, the path and the name of the current message
file.

With this button you get a file selection dialog box from which you select
an existing message file or in which you can create a new message file.

With this button you delete the current message file after a security
prompt.

Menu "Diagnostics ... Close"
With this menu item, you return to the main program of IBS CMD G4. The
diagnostics program is not terminated by this menu command, but
remains resident on the background memory.

Delete File

Save after Entering Comment

Save after Every Change in
Statistic Data

Stop Saving

Save As:

Select File

Delete File
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Menu "Messages … Messages (Online) ..."
In this dialog box you see the messages that are received during the
current online session. In addition, these messages are sent and stored in
the message file. If there is already a message file with the same name,
the data is appended to the existing file. The message histories of the
current and previous online sessions can be viewed in the "Evaluate
Message File" dialog box.

07_diagpic.bmp

Fig. 7-12: Structure of the message file

07_diaghist.bmp

Fig. 7-13: Messages (Online)

Here you see the drive, the path and the name of the current project file.

The current system date and time are shown in these two info boxes.

Project

Curr. Date/time



INTERBUS Configurator CMD Diagnostics 7-7

DOK-CONTRL-IBS*CMD****-AW01-EN-P           

With these two buttons you can print either a message overview or
individual detailed messages.

With this button you go to the "Settings" dialog box. You can determine
the memory options of the diagnostics in this dialog boxes.

The occurring messages are listed in this table. All incoming messages
are saved in the message file with a consecutive number (No.), a date
(Date) and time stamp (Time). Every message is tagged with a name that
characterizes the type of message. If you select a message entry with the
mouse, detailed information about the message appears in the
"Information on Message" info box.

In the "Information On message" dialog box the message selected in the
display box above is represented in detail. You get detailed information
about the meaning, error code and cause of the message, as well as any
remedy hints and further information.

Menu "Messages … Evaluate Message File ..."
All incoming messages of the controller board are saved in a message file
(*.MES). With the "Evaluate Messages" dialog box you can view and
analyze any message file.

Messages are controller board messages to IBS CMD G4. Messages can
only be received during an online session, i.e. not in "Configuration
(Offline)" mode. For example, the controller board sends a message in
case of a reconfiguration request or in the event of an error.

An error is an event that disturbs the normal bus operation. An error need
not necessarily lead to a bus stoppage.

Example: The failure of a peripheral power supply leads to an error, but
not to a bus stoppage.

07_diagausw.bmp

Fig. 7-14: Evaluate message files

Print

Change Setting

No./Date/Time/Message

Information On Message
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Message file

Here you see the drive, the path and the name of the current message
file. The message file of the current project is selected as default.

With this button you get a file selection dialog box from which you can
select an existing message file or in which is displayed in the "Evaluate
Message" dialog box.

With this button the current message file is deleted after a security
prompt.

07_diagmelo.bmp

Fig. 7-15: Delete file?

Here you see the list of incoming messages in the current message file.
The messages are consecutively numbered and include the date and time
of their occurrence. The last column shows the message type. If you
select a message entry with the mouse, detailed information about the
message appears in the "Information on Message" info box.

If you have selected a message in the list above, you get detailed
information about the meaning, error code and cause of the selected
message, as well as any remedy hints and further information.

With these two buttons you can print either a message overview or
individual detailed messages.

File

Change ...

Delete File

Message Display Box

Information On Message

Print
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Menu "Messages … Message Types ..."
In this dialog box you can select which message types are taken into
account and reported by the diagnostics.

If certain message types are unimportant for you, remove the
corresponding ’x’ in the option box.

07_diag-typ.bmp

Fig. 7-16: Message types

Messages of the bus system

This message is generated, if a device reports an error. This is the case,
for example, when the power supply fails on a local bus module.

This message is generated, if an error occurs in transmission of a PCP
service. The "Abort" service leads to a break in the connection to the
concerned PCP node.

This message is generated, if Reject_Indication occurs. An illegal service
that cannot be transmitted is internally rejected with a "Reject_Indication".
A Reject_Indication does not lead to a break in the connection to a PCP
node.

Messages of the Diagnostic Status Register

This message is generated, when the bus cycles are started or stopped.

This message is generated, when a bus segment is switched on or off.
For example, a bus segment (local bus) can be switched off after an
error. The rest of the INTERBUS system remains operable.

This message is generated, when the "Warn" bit (bit 5) is set in the
diagnostic status register. The bit is set, if no INTERBUS cycles could be
executed successfully beyond the bus warning time.

Module Status

PCP Abort

PCP Reject

Bus Status (RUN/STOP)

Bus Segment Disabled (BSA)

Bus Warning Time Expired
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This message is generated, when the "Warn" bit (bit 6) is set in the
diagnostic status register. The bit is set, if the INTERBUS transmission
quality deteriorates more than a certain degree.

Operating status

This message is generated, if the operating state of the IBS CMD G4
changes. There are the operating states "Configuration (online)",
"Monitoring" and "Diagnostics".

Menu "Statistics … Record Statistics ..."
In this dialog box you can trace the record of the statistic data. The
number of individual cycle types is updated at regular intervals and
occurring errors/messages are assigned to bus segments and devices.

07_diagstat.bmp

Fig. 7-17: Record statistics

Overview

The number of INTERBUS cycles is displayed here in six info boxes. At
the top you see the total number of cycle types and below the number of
defective cycles.

The types of cycle are next to each other:

Transmission cycles = identification cycles + data cycles.

Cycles required to identify the bus system. The physical process image is
available in the controller board memory after an identification system and
after certain errors. Identification cycles are executed during start-up the
INTERBUS system and after certain errors.

Process data, parameter data and some data for handling the protocol
are transmitted in data cycles. In one data cycle, not only the data of the
devices is transmitted to the controller board (input data), but also the
data of the controller board to the devices (output data).

Bus Quality Bit

Display Changes

Transmission Cycles:

Identification Cycles:

Data Cycles:
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Here the ratio of defective to error-free cycles is evaluated by a defined
(non-linear) algorithm and graphically displayed.

Bus Segment Statistics

In this info box you can select individual bus segments with the mouse.
The devices in the bus segment in question (e.g. the local bus devices on
one bus terminal) are then displayed in the "Device Statistics" info box.

The number of messages and errors is displayed numerically as well as
graphically. The bus segment containing the most errors is marked with a
bar that fills out the entire box. The bus segments with fewer errors are
marked with bars of proportionately smaller size.

Device statistics

Depending on the selected bus segment in the info box "Bus Segment
Statistics", you see the devices in this bus segment.

The number of messages and errors is displayed numerically as well as
graphically. The device with the most errors is marked with a bar that fills
out the entire box. The devices with fewer errors are marked with bars of
proportionately smaller size.

Settings

You see the name of the statistics file in the "Save In File" info box.

The "Statistics" info box shows you whether the statistics functions are
active.

With this button you go to the "Settings" dialog box.

With this option box, you can set, whether the entries in the info boxes are
to be cyclically updated.

In this dialog box the ten devices with the most errors are displayed.
These devices are determined by the controller board and read out when
calling the dialog box. The function is only available in the "Diagnostics"
operating state.

Please use this button to enter a comment at any time. Each time a
comment is entered, a new entry is written into the statistics file. The
entries can be analyzed using the command "Evaluate Statistics File".

07_diagkomm.bmp

Fig. 7-18: Comment statistic entry

Transmission Quality

Save In File

Statistics

Change Setting

Update Window

Top Ten ...

Comment …



7-12 Diagnostics INTERBUS Configurator CMD

           DOK-CONTRL-IBS*CMD****-AW01-EN-P

Menu "Statistics … Evaluate Statistics ..."
In this dialog you can select individual entries from the statistics file and
determine the errors that have occurred, the transmission quality, the
number of cycles, and possible error locations.

07_diagstau.bmp

Fig. 7-19: Evaluate statistics

Note: All displayed statistical data from the current statistics file
refers to the line selected in the "Entries" box. Every entry has
a date and time stamp and may optionally include a comment.

Note: The display is not updated because an existing file is
evaluated in this dialog box.

Overview

The number of individual INTERBUS cycles is displayed here in six info
boxes.

At the top you see the total number of cycle types and below the number
of defective cycles. The types of cycle are next to each other:

Transmission cycles = identification cycles + data cycles.

Cycles required to identify the bus system. The physical process image is
available in the controller board memory after an identification cycle.
Identification cycles are executed during the start-up of the INTERBUS
system and after certain errors.

Transmission Cycles:
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Process data, parameter data and some data for handling the protocol
are transmitted in the data cycles. In one data cycle, not only the data of
the devices is transmitted to the controller board (input data), but also the
data of the controller board to the devices (output data).

Here the ratio of disruptive cycles to error-free cycles is evaluated by a
defined (non-linear) algorithm and graphically displayed. The display
refers to the last entry in the statistics file, and therefore, always shows
the current transmission quality.

Bus Segment Statistics

In this info box you can select individual bus segments with the mouse.
The devices in the bus segment in question (e.g. the local bus devices on
one bus terminal) are then displayed in the "Device Statistics" info box.

The number of messages and errors is displayed numerically as well as
graphically. The bus segment with the most errors is marked with a bar
that fills out the entire box. The bus segments with fewer errors are
marked with bars of proportionately smaller size.

Device statistics

Depending on which bus segment you have selected in the upper info box
"Bus Segment Statistics", you can see the devices in the selected bus
segment.

The number of messages and errors is displayed numerically as well as
graphically. The device with the most errors is marked with a bar that fills
out the entire box. The devices with fewer errors are marked with bars of
proportionately smaller size.

In this info box you can see the comment of the selected entry in the
statistics file.

To modify and create a comment on any statistics file entry, please use
this button.

07_diagkom2.bmp

Fig. 7-20: Change comment

Settings

You can also evaluate other statistics files by calling a file selection dialog
box with this button. The info box above this button shows the currently
selected file.

Every time the statistic data is changed (error or comment) another entry
is generated in the statistics file. You can mark these entries in this
selection box. The entry’s data is then displayed in the appropriate info
boxes above the entry.

This info box shows you how many entries there are in the statistics file.

Data Cycles:

Transmission Quality

Comment:

Comment …

Other File

Entries

Amount
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Menu "Statistics … Last Peripheral Error ..."
In this dialog box the last occurred local bus errors are displayed. For
example, a local bus error is caused by a defective fuse or a missing local
supply voltage.

The function is only available in the "Diagnostics" operating state.

Menu "Statistics … Top Ten ..."
In this dialog box the ten devices with the most errors are displayed.
These devices are determined by the controller board and read out when
calling the dialog box. The function is only available in the "Diagnostics"
operating state.

Menu "Statistics … Reset Statistics Counter"
You can use this menu item to delete all the statistical data like TOP Ten
and Peripheral Bus Malfunctions stored on the controller board. You can
access the command on the controller board’s context menu under
"Control".

Menu "Window … Bus System Messages"
As soon as a message arrives from the controller board, the following
message window is displayed.

07_diagmeld.bmp

Fig. 7-21: Bus system messages"

This message window shows all messages of the bus system from the
current message. If there are more than four entries, you can view the
previous messages by means of the scroll bar.

Buttons

If you do not need diagnostics immediately for the current error, you can
switch the message dialog box into the background with this button. The
incoming messages can be viewed and evaluated later at any time.

This button changes to the "Diagnostics" add-on program.

With this option box you can activate or deactivate the recording of the
messages. Messages occurring when the message recording is switched
off are not saved.

Menu "? ... Using Help"
Use this command to start the standard Windows help. This will give you
general information about working with Help systems under MS Windows.

Window in Background

Do to Diagnostics

Message Recording Active
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7.4 Keyboard Assignment "Diagnostics"

Help (in the "?" menu)

Settings ... ( in the "Diagnostics" menu)

Evaluate Message File ... (in the "Messages" menu)

Evaluate Statistics File ... (in the "Statistics" menu)

Close (in the "Diagnostic" menu)
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8 Monitor

Note: The monitors "Address Monitor" and "Display IBS DSC" are in
the context menu of the controller board. The preprocessing
monitor is in the next context menu of the "Preprocessing"
element and is only available in the "IBS CMD G4" software.

8.1 Address Monitor

With the address monitor you can visualize data which was assigned to
the addresses of the PLC or PC. In addition to the INTERBUS process
data all register contents can be displayed and written which were
assigned to addresses.

08_moniadre.bmp

Fig. 8-1: Address monitor

Here you determine with which data width the addresses of the PLC or
PC are to be displayed.

You have the choice between:

• Word = 16 bit display

• Byte = 8 bit display

• Bit = 1 bit display

Note: Data can only be transmitted to the controller board in the
"Word" view.

View
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Here you select the representation format of the data. You have the
choice between:

• Dec = decimal number format

• Hex = hexadecimal number format

• Bin = binary number format

Buttons

The data that you enter or change in the "Value" column is transmitted to
the controller board by this button. It is only possible to write data in the
"Word" view.

The data that you enter or change in the "Value" column is transmitted to
the controller board by this button. The last state of the data is displayed
again.

Display Box

Depending on the operating state different display and input facilities are
available in the address monitor. The current restrictions are shown in this
display box. You can use all input and display options when you change to
the "Monitoring" operating state.

Display area

Here the PLC and PC address is displayed. The bit number is added to
the address in the "Bit" display.

This display identifies whether it is input (I) or output (O) data.

In this column you can see the data (usually process data) at the
respective PLC or PC address. The data is displayed in the number
format set in the dialog box "Format".

Assignment

Here you see with which data the respective address is assigned.
Unassigned addresses are assigned as "<FREE>". Data which are longer
than the respective address are marked with <CONTAINS>. Furthermore,
a multiple assignment is indicated by the display "<MULTIPLE
ASSIGNMENT>".

You can filter the displayed addresses. You can, for example, just have
displayed the input data addresses or only the addresses of the user
displayed, depending on the assignment of the addresses. To filter the
addresses select the "Address Selection" command in the system menu
of the address monitor.

08_adr-kon.bmp

Fig. 8-2: System menu "Address Monitor""

Format

Write

Undo

Status

Address

I/O

Value
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Address Selection
You can filter the displayed addresses. You can, for example, just have
displayed the input data addresses or only the addresses of the user
displayed, depending on the assignment of the addresses. Mark the
option boxes that you want to see in the address monitor.

08_mon-eins.bmp

Fig. 8-3: Address selection

1. Input Process Data

Process data that transmitted by the INTERBUS network to the controller
board.

2. Output Process Data

Process data transmitted by the INTERBUS network to the controller
board.

3. Standard Register"

If you select this option, the addresses that are assigned with standard
function registers are displayed.

4. User Functions"

The start, status and result bits of all user functions are displayed with this
option.

5. Function Parameters (input)

Select this option to display addresses that are assigned with input
parameters of a user function. You can assign single parameters of a
user function specifically to addresses in order to change these
parameters dynamically.

6. Function Parameters (output)

Select this option to display addresses that are assigned with input
parameters of a user function.

7. Events"

With this option the addresses of the indication and the confirmation bit of
all results are displayed.
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8. Event Parameters (input)

Select this option to display addresses that are assigned with input
parameters of an event. You can assign single parameters of an event
specifically in order to change parameters dynamically.

9. Event Parameters (output)

Select this option to display addresses that are assigned with input
parameters of an event.

8.2 Digital Process Data Monitor

This monitor can be accessed from the context menu of any INTERBUS
device with process data. The device’s process data is displayed digitally
as yellow and gray squares. You can open a separate monitor for every
process data description.

08_digimon.bmp

Fig. 8-4: Digital process data monitor

The monitor’s title bar indicates the device the device for which the
monitor is open. The device number is displayed.

Here you can select the desired process data description on this device.
Open the select box to see a list of the process data names available for
the device in question.

This input box displays the process data value as hexadecimal value.

This input box indicates whether the process data is input or output data.

The process data display area is divided up into rows and columns. Rows
represent bytes, columns represent bits. The size of the monitor is based
on the default process data length of the device for which the monitor has
been opened. Thus, all process data boxes are always displayed.
Process data that match the selected process data description are
displayed in gray when the bit is not set, and in yellow when the bit is set.
Process data beyond the selected process data description is displayed in
black.

Depending on the selected process data description, the entire input or
output range of devices with input and output data is displayed.

Title Bar

Name

Value

Data Direction

Display Area
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08_digimon2.bmp

Fig. 8-5: Change output process data description

If you have set an output process data description on a control or
computer address, the "Change …" button will become active as soon as
the process data description in question is set in the monitor. Then, you
can change the output process data in a further dialog box.

Note: Note that the bits set in the monitor may be overwritten in the
next bus cycle, if a preprocessing or application program is
running.

Change data

This dialog box indicates the names of the process data description for
which the "Change" dialog box has been opened.

This input box displays the set process data value as hexadecimal value.

Like the Display Area, the Set Area is divided up into rows and columns.
You can set and reset bits by clicking on them. The changes in the
process data will only apply when you press "OK" to confirm. Device
process data that are beyond the selected process data description are
displayed as black squares.

This button sets all bits to "1".

This button sets all bits to "0".

Change ...

Name

Value

Set Area

All On

All Off
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8.3 Device States

This monitor allows you to (de)activate and jumper individual devices and
local bus winding.

08_t-zu01.bmp

Fig. 8-6: Device states

The device’s logical number is displayed here. The sequence in which the
devices are displayed in the dialog box corresponds to the logical
sequence in the bus configuration.

The device’s "ID Code", "Station Name" and "Device Name" data are
displayed in these columns.

The device is taken into account in the configuration frame and transfers
data to the controller board. A deactivated device is logically jumpered
and physically integrated in the bus configuration. You can activate and
deactivate a device as you require. Thereby, all local bus devices
depending on this device will be activated and deactivated.

Select this option box to exclude the device from the configuration frame.
A bus configuration with jumpered devices can only be set back into full
operation after the device has been physically removed. When a device is
jumpered, all local bus devices depending on this device are deactivated
and can be only re-activated after the jumpered device has been
removed.

Note: You can select a device in the bus configuration by double-
clicking on its entry in the "Device States" dialog box.

Edit device states

Select these option fields to specify which state the devices marked in the
list should have. You can also select several devices in the device list by
pressing the <CTRL>-key while clicking on the devices.

This option displays how many devices you have selected at the moment.

Device #:

ID Code, Station Name, Device
Name

Activated

Jumpered

Activate, Jumper

Selected
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After selecting the required devices and the device states in the option
boxes, you can apply your selection by pressing this button. As long as
you don’t select other device entries or don’t change these options in the
meantime, you can restore the last state by pressing the "Undo" button.

Possible device states

Activated: Yes

Jumpered: Yes

This state is not possible. An active device can not be
jumpered.

Activated: Yes

Jumpered: No

The device is actively integrated in the bus configuration
and transfers its data to the controller board.

Activated: No

Jumpered: Yes

The device is not active and does not transfer data to
the controller board. The device has been removed from
the configuration frame and thus, has been physically
deactivated. If a local bus device is set in this state, all
the other devices in the local bus winding automatically
assume the state "Activate: No". These deactivated (not
jumpered) devices can only be re-activated after the
jumpered device has been physically removed.

Activated: No

Jumpered: No

The device and all its local bus devices are logically
deactivated. The device and all its local bus devices are
logically deactivated.

Execute / (Undo)
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8.4 Preprocessing / Monitoring

With this monitor the states of the individual inputs and outputs at the
used function blocks are displayed within the graphical editor of the
(process data) preprocessing.

The user interface of this monitor is identical with the programming
environment of the preprocessing. However, only the menu commands
appropriate to change the display and variables are active.

08_fbdmoni.bmp

Fig. 8-7: Preprocessing / Monitoring
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9 Preprocessing

9.1 General Information

You have the possibility of linking INTERBUS process data using the
"Preprocessing" (process data preprocessing) tool. To do so, process
data is available via variable names in this add-on program. These
variables can be interlinked by numerous logic blocks. The output
variables are then re-assigned to a process data item or several process
data.

The add-on "Preprocessing" generates a ZWT-file from the worksheets
created here. The data stored in this file is transferred by IBS CMD G4 to
the controller board (when writing the configuration) together with bus
configuration. Addressing, etc.

09_konzept.bmp

Fig. 9-1: Overview

Example:

For this example, a simple link of four input bits (A,B,C,D), three function
blocks (2* AND, 1* OR) and one output bit is used.

The four input bits may come from a device with digital inputs. The output
bit linked via these four input bits could then be connected with digital
outputs.

09_beispiel.bmp

Fig. 9-2: Simple programming example

ATTENTION

⇒ With increasing size of the preprocessing program
the bus cycle time is getting longer. The
programmed functions are executed between two
INTERBUS cycles. So, after programming check the
bus cycle time and optimize – if necessary – the
preprocessing program or shift some functions in
your application program.
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9.2 Main Window

09_hauptf.bmp

Fig. 9-3: Main window "Preprocessing"

The main window "Preprocessing" basically consists of:

• Menu bar

• Toolbar

• Status line

Other areas are the worksheet and the scroll bar areas.

9.3 Menu structure

09_m-xxxx.bmp

Fig. 9-4: Menu bar
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9.4 Menu "File ..."

09_m-datei.bmp

Fig. 9-5: Menu "File"

Menu "File ... Save"

With this menu command you can save the worksheets of the
current session.

The menu bar of the preprocessing indicates if the worksheets
have been modified. If the title bar contains a "*", the worksheets
were changed. The command "Save" is only available after a
modification of the worksheet.

09_titelz.bmp

Fig. 9-6: Modified worksheet

Menu "File ... Back to CMD"
This command exits "Preprocessing" and returns to the main IBS CMD
G4 program. "Preprocessing" is not removed from the working storage.

Note: Use this command to switch between IBS CMD G4 and
"Preprocessing".

Menu "File ... Exit"
This command exits "Preprocessing" and returns to the main IBS CMD
G4 program. "Preprocessing" is removed from the working storage.

09_beend.bmp

Fig. 9-7: Exit "Preprocessing"
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If one of the worksheets was changed, you will receive a warning.

09_bear-end.bmp

Fig. 9-8: Save changes?

9.5 Menu "Edit ..."

09_m-bear.bmp

Fig. 9-9: Menu "Edit"

Menu "Edit ... Next WS"

This command changes to the next worksheet, if one exists.

You can create and manage worksheets with the "WS manag."
command.
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Menu "Edit ... Prev. WS"

This command changes to the next worksheet, if one exists.

You can create and manage worksheets with the "WS manag."
command.

Menu "Edit ... WS manag."

In every project you can create several worksheets, where you
split your function blocks, for example, info functional groups. You
can move easily between the individual pages with "Next WS"
and "Prev. WS".

With this dialog box you can create , rename, delete and remove
worksheets.

09_arbeit-m.bmp

Fig. 9-10: Worksheet management

Here you can change the name of the selected worksheet or enter a new
name. The name may not exceed 8 characters and has to adhere to MS
DOS file name conventions . It must also start with an alphabetic
character.

Here the existing worksheets are listed.

Buttons:

Creates a new worksheet. First, enter the name of the new worksheet in
the input box and then press this button. If a worksheet of the same name
already exists, this command cannot be executed.

Input Box

Display Box

New
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Changes the name of the selected worksheet. The currently visible
worksheet cannot be renamed.

09_umbenen.bmp

Fig. 9-11: "Delete" not possible

Deletes the selected worksheet. The currently visible worksheet cannot
be deleted.

Moves the selected worksheet up in the order of worksheets. The
command is inactive, if the selected worksheet is at the top.

Moves the selected worksheet down in the order of worksheets. The
command is inactive, if the selected worksheet is at the bottom.

Moves directly to the selected worksheet. This exits the dialog.

Menu "Edit ... Undo"

This command cancels the last action or command.

Menu "Edit ... Cut"

This command cuts out the selected objects and puts them into
the clipboard. The command can only be selected, if objects are
marked.

Use this command, if you want to remove objects and replace
them somewhere else. To copy/duplicate objects, use the
commands "Copy".

Menu "Edit ... Copy"

This command copies/duplicates the selected objects. After
copying the object, it can be placed in the marked position with
the "Paste" command.

Menu "Edit ... Paste"

If objects were stored in the clipboard with "Copy" and "Cut", they
can be inserted in the marked position with the "Paste" command.

Change

Delete

Move Up

Move Down

Go to
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Menu "Edit ... Delete"

This command deletes the selected objects. The objects are not
into the clipboard. If you want to re-use the removed objects
somewhere else, select the command "Cut".

The command can only be selected, if objects are marked.

Menu "Edit ... Copy To"
You can save individual worksheets and their contents into a file. The files
have file name extension*.GP and can be saved in any directory with a
standard Windows dialog box.

09_gp-save.bmp

Fig. 9-12: Save as GP file …

Menu "Edit ... Insert From"
This command inserts a saved GP file into an empty worksheet. GP files
(*.GP) hold the contents of any single worksheet. You can save process
data links as a file with the "Copy" command.

Menu "Edit ... Delete Worksheet"
This command deletes all objects on the worksheet. After executing this
command you have an empty worksheet.

Note: Only the contents of the worksheet are deleted and not the
worksheet itself. To delete the worksheet, use the "Delete"
button in the "WS manag." dialog box.
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Menu "Edit ... Find"

With this command you can search for texts, variable names, or
constants on the current worksheet.

09_su-nur.bmp

Fig. 9-13: Find

Matches are only displayed, if the whole word was found. The word "OUT"
in "OUTput" is not displayed, if this option box is marked.

Lower and upper case letters are distinguished, if this option box is
marked. If no matches or no other matches were found, the following
message is displayed:

09_such.bmp

Fig. 9-14: No matches found

Match Whole Word Only

Match Case
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Menu "Edit ... Find and Replace"

With this command you can search for texts, variable names, or
constants on the current worksheet and replace them with
another term.

09_su-ers.bmp

Fig. 9-15: Find and Replace

Matches are only displayed, if the whole word was found. The word "OUT"
in "OUTput" is not displayed, if this option box is marked.

Lower and upper case letters are distinguished, if this option box is
marked.

If no matches or no other matches were found, the following message
appears:

09_such.bmp

Fig. 9-16: No matches found

Menu "Edit ... Mark All Objects"
The command selects all objects (blocks, text, links, variables, etc.), so
that these can be edited as a group, i.e. moved, copied or deleted.

Match Whole Word Only

Match Case
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Menu "Edit ... Mark Objects"

This command enables you to select, place and move objects
with the mouse. As long as this command is active, a
corresponding entry is displayed in the status line (MARK) and the
corresponding button in the toolbar is framed in red.

If you want to select several objects, hold down the <Shift> key
and click on the desired objects with the mouse.

You can also select several objects by moving the mouse with the
pressed left mouse button over the desired objects, thus drawing
a frame around the objects.

The insertion point is displayed as a cross:

09_cur-kre.bmp

Fig. 9-17: Cursor: Insert point

Menu "Edit ... Link Objects"

With this command you connect the inputs and outputs of the
(function) blocks to each other. Click-on an input or output and
drag then the mouse in the desired direction. If you have to or
want to run connecting lines around other blocks, click-on the
desired branching point and then change by 90°

As long as the command is active, a corresponding entry is
displayed in the status line (LINK) and the corresponding button in
the toolbar is framed in red.

09_cur-ver.bmp

Fig. 9-18: Cursor representation when command is activated

Menu "Edit ... Open Object"
As yet, this command has no function.
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Menu "Edit ... Object Properties"
This dialog box shows the properties of an object. If a block is marked,
the "Function/Function Block" dialog box appears, if an input or output is
marked, the "Formal Parameter" dialog box appears.

The "Formal Parameter" indicates an input or output of a block.

09_ob-eigen.bmp

Fig. 9-19: Properties "Function Block"

09_formpara.bmp

Fig. 9-20: Formal parameter
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9.6 Menu "Object ..."

09_m-obje.bmp

Fig. 9-21: Menu "Object"

Menu "Object ... Function/Function Block"

With this dialog box you can select a function or function block
from the block database. The block is inserted at the previously
marked position after confirming the dialog box with "OK".

09_ob-einf.bmp

Fig. 9-22: Paste object

With this dialog box you can select the desired block.

Here you enter the graphic size of the block. Blocks with several inputs
(e.g. AND) are automatically enlarged, if you increase the number of
inputs.

Set this option, if you want to see the data type of the individual inputs and
outputs (e.g. BOOL, ANY_NUM, etc.) in the "Formal Parameters" info
box.

Set this option, if you want to see the type of the individual inputs and
outputs (e.g. VAR_INPUT or VAR_OUTPUT) in the "Formal Parameters"
info box.

The inputs and outputs of the block selected under "Name" are displayed
here. In addition, the type or data type is displayed depending on the
setting.

Buttons:

In this dialog box the name, type and data type of the formal parameter
are displayed. In addition, you can negate the inputs/outputs in some
blocks or determine whether the formal parameters are to react to an
edge.

Name

Height

Show Data Type

Show Type

Formal Parameter

FP>>
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09_formpara.bmp

Fig. 9-23: Formal parameter

Deletes an input or output.

Duplicates the selected input or output of the current block. This function
is not available in all blocks.

Menu "Object ... Variable"

In this dialog box you get the variables defined in IBS CMD G4.
Process data descriptions that you have defined in IBS CMD G4
for "Preprocessing" are here contained in a selection list.

09_variable.bmp

Fig. 9-24: Variable selection

The selection box contains the variables defined in IBS CMD G4 which
are available to "Preprocessing".

Set which variable type is to be displayed in the "Variable Name" box
here.

Here you select whether you want to link the variable to an input or an
output. The variable name is displayed to the left or right of the connection
point depending on the selection.

The data type is displayed here.

You can assign start values to variables and memories set when starting
the INTERBUS network.

This specifies an input or output variable.

Here you can see whether the variable is linked and with which process
data item.

Delete FP

Double FP

Variable Name

Filter

Link

Type

Init

Block

Info
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Menu "Object ... Constant"

With this command you can define constants. You must specify
the constant in a dialog box according to the syntax: Data
Type#Value

Furthermore, you must determine whether the constant is to be
linked with an input or an output.

09_const.bmp

Fig. 9-25: Constant

You can use BOOL, BYTE, WORD and DWORD.

Menu "Object ... Text (Comment)"

With this command you can create a comment text line which is
inserted at the marked position (with the cross).

04_komment.bmp

Fig. 9-26: Comment

With the "Font>>" button, you can select the desired font from a standard
dialog box with which the comment is to be created. All fonts installed
under Windows are available here.
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Menu "Layout"

09_m-ansi.bmp

Fig. 9-27: Menu "View ..."

Menu "Layout ... Toolbar"
This command displays or hides the toolbar. If the menu command is
selected, the toolbar is displayed.

09_leiste.bmp

Fig. 9-28: Toolbar

Not all commands are available all the time. The execution of some
commands is subject to certain factors (e.g. that a block is marked).
Those buttons that are not available are displayed in a two-dimensional
form.

09_verfueg.bmp

Fig. 9-29: Representation of buttons



9-16 Preprocessing INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P

Menu "Layout ... Status Line"

09_status2.bmp

Fig. 9-30: Status line

The status line is at the bottom of the screen.

The status line gives you the following information:

• Error messages and other information

• Selected tool
"MARK" to place the marking cross "LINK" to select the linking tool

• Mouse pointer coordinates
at present 104/59

• Available working storage

Menu "Layout ... WS Size"
In this dialog box you can enter the size of the current worksheet.
Depending on the size, the pages will be divided into several pages by
margins. You can display and hide the margins as required.

09_abgross.bmp

Fig. 9-31: Worksheet size

Menu "Layout ... Zoom Range"

Select this command to enlarge a defined area.

After selecting the command, the cursor changes its appearance.
Select a corner of the desired section of the image you want to
enlarge and pull the mouse with the left mouse button pressed to
the opposite corner of the desired image section. The marked
area is displayed, when you release the mouse button.

Cursor representation for this command:

09_cur-zoo.bmp

Fig. 9-32: Cursor: Zooming
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Menu "Layout ... Zoom In"

You can enlarge the display of the worksheet step by step with
this command.

This command operates in a fixed zoom range. If you try to
exceed the boundaries of this zoom range, the following message
appears:

09_zoomber.bmp

Fig. 9-33: End of zoom range

Menu "Layout ... Zoom Out"

You can reduce the display of the worksheet step by step with this
command.

This command operates in a fixed zoom range. If you try to
exceed the boundaries of this zoom range, the following message
appears:

09_zoomber.bmp

Fig. 9-34: End of zoom range

Menu "Layout ... Previous View"
This command takes you back to the last zoom range. If you have
selected an overview representation (small zoom range) and a detail
representation (large zoom range), you can conveniently change between
the two representations with this command.

Menu "Layout ... Default Size"
This command zooms the worksheet to default size. From the default size
you can zoom in the worksheet five times or zoom out four times, before
reaching the end of the zoom range.

Menu "Layout ... Redraw"
When drawing connecting lines and placing function blocks, it may be
necessary to refresh the representation area. Use the following menu
item: When this command is executed, the worksheet is redrawn on the
screen with all the current settings.
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Menu "Layout ... Grid"
With this menu command you can display a dot matrix (grid) as a
positioning and drawing aid. The mouse cursor snaps directly to these
grid points or intermediate values depending on the zoom factor.

Menu "Layout ... Page Borders"
The dimensions set under "Worksheet Size" is divided into the
appropriate number of 190x227 boxes outlining the margins. This division
is merely for better structuring of the worksheet and has no influence on
the functions.

09_seiteran.bmp

Fig. 9-35: Page borders

Menu "Layout ... Online Layout"
This command is only active, if you start the add-on program with
the monitor functions of IBS CMD G4.

In this dialog box, you can configure, how variables are displayed
in the preprocessing monitor.

09_onl_lay.bmp

Fig. 9-36: Online layout
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Show values

Select this option to hide the value of the variables. When "No Values" is
selected, the options under "Boolean Values" are unavailable.

If you select this option, only the values and not the names of the
variables are displayed.

Select this option box, if you want to display the value of the variables
besides the variable names.

Select this option box, if you want to display the value of the variables
under the variable name.

Boolean values

Selecting this option box will enable the "Text-Type Boolean Values" and
"Numeric Boolean Values". When this option is not checked, Boolean
variables are not displayed explicitly; they are merely represented by the
colors "red" = "1" = "TRUE" and "blue" = "0" = "FALSE".

The value of the Boolean variables is displayed as text – "TRUE" or
"FALSE".

The value of the Boolean variables is displayed numerically as "0" or "1".

9.7 Menu "Make ..."

09_m-uebers.bmp

Fig. 9-37: Menu "Make"

Menu "Make ... Compile All"

The command compiles all worksheets and checks their contents
for errors.

If errors occur in the compiling process, these are stored in an
error file. You can view the error file with the "Prev. Error" and
"Next Error" commands.

09_kompili.bmp

Fig. 9-38: Compiler message

No Values

Only Values

Value Beside Symbol

Value Below Symbol

Explicit Boolean Values

Text-Type Boolean Values

Numeric Boolean Values
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Menu "Make ... Check Unit"
The command compiles the current worksheets and checks its contents
for errors. Possible errors are false or missing variables and constants,
defective or unwired inputs/outputs, etc.

09_kompili.bmp

Fig. 9-39: Compiler message

Menu "Make ... Next Error"

The errors found during the compiling process are saved in an
error file. This command shows you the next error in the error file.

The errors are displayed in the status line. At the same time, the
mouse arrow points to the object in which the error has occurred.
Start and end of the error file are shown accordingly.

09_status.bmp

Fig. 9-40: Text display in the status line

Menu "Make ... Prev. Error"

The errors found during the compiling process are saved in an
error file. This command shows you the previous error in the error
file.

The errors are displayed in the status line. At the same time, the
mouse arrow points to the object in which the error has occurred.
Start and end of the error file are shown accordingly.
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9.8 Menu "? ..."

09_m-hilfe.bmp

Fig. 9-41: Menu "? ..."

Menu "? ... Contents"
Use this command to go to the table of contents of the help file. Here you
will find help on all menu items and dialog boxes as well as on the
operation of "Preprocessing".

Note: With the "Help" button in the dialog boxes, you can go directly
to the help pages available for the respective dialog box. You
can also call up context-sensitive help at any time using the
"F1" function key.

Menu "? ... Use Help"
Use this command to start the standard Windows help. This will give you
general information about working with Help systems under MS Windows.

Menu "? ... About"
In this dialog box you get information about the current version of your
add-on program "Preprocessing".

09_info-v.bmp

Fig. 9-42: Program and manufacturer information
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9.9 Overwrite Variables

You can use the following dialog boxes to simulate different system states
by overwriting variables in the preprocessing monitor. To access the
preprocessing monitor, click-on "Monitoring" in the "Preprocessing"
context menu.

Your preprocessing program is displayed in the open preprocessing
monitor using the graphic configuration you defined.

To overwrite a variable open the dialog box by double-clicking on it with
the right mouse button. Depending on whether the selected variable is a
Boolean or an alphanumeric variable one of the following dialog boxes will
appear:

Dialog box to force (overwrite) Boolean variables:

09_force01.bmp

Fig. 9-43: Overwrite Boolean variables

Dialog box to force (overwrite) numeric variables:

09_force02.bmp

Fig. 9-44: Overwrite numeric variables

You can enter the variable’s value in this edit box (alphanumeric variables
only). Enter numeric values in decimal format.

Operation

The variable to be forced is only one time overwritten to the bus system.
The value of the forced variable is only valid for a single bus cycle as it is
overwritten by value from the process image in the next cycle.

Select this option box to prevent the forced variable from being
overwritten by the preprocessing program.

Press this button to reset the forced variables to the their original values
or to reset them to the current values in the preprocessing image.

Value

Overwrite

Fix

Reset
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9.10 Data Types

The data types "ANY_INT" and "ANY_REAL" are summarized under
"ANY_NUM".

ANY_BIT - Group

Type Length (bits)

BOOL 1 0 or 1

BYTE 8 Bit pattern No number

WORD 16 Bit pattern No number

DWORD 32 Bit pattern No number

ANY_INT - Group

Type Length (bits) Example

SINT 8 Integer -123.0 or -123

INT 16 2#101111 (dual)

DINT 32 16#2F (hex)

ANY_REAL - Group

Type Length (bits) Example

REAL 32 Floating point 12.7 or 1.27E1
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9.11 Blocks

Bit-by-Bit Boolean Link:

AND (and)

OR (or)

NOT (not)

XOR (exclusive or)

Arithmetic Operators:

ADD (addition)

MUL (multiplication)

SUB (subtraction)

DIV (division)

MOVE (assignment)

MOD (modulo; reminder of an integer division)

Arithmetic Comparisons:

GT (greater than)

GE (greater than or equal to)

EQ (equal to)

LE (lower than or equal to)

LT (lower than)

NE (not equal to)

Type Conversions

BCD_TO_* Type conversion from BCD code

BOOL_TO_* Type conversion from BOOL

BYTE_TO_* Type conversion from BYTE

DINT_TO_* Type conversion from DINT

DWORD_TO_* Type conversion from DWORD

INT_TO_* Type conversion from INT

REAL_TO_* Type conversion from REAL

SINT_TO_* Type conversion from SINT

WORD_TO_* Type conversion from WORD

TRUNC_* Deletion of decimal places

Bit Manipulation:

SHL Shift left

SHR Shift right

ROL Rotate left

ROR Rotate right
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Numeric Functions:

SQRT Square root

ABS Absolute value

NEG Negation

Selection Functions:

MAX_* Maximum input value

MIN_* Minimum input value

LIMIT_* Maximum or minimum input value

SEL Selection of two input values (general)

SEL_* Selection of two input values (special)

Bistable Elements:

SR SR flip-flop

RS RS flip-flop

Edge Recognition:

R_TRIG Recognizes rising edge

F_TRIG Recognizes falling edge

Counter:

CTD Down counter

CTU Up counter

CTUD Up/down counter

G3 Functions:

RESET_OUT_IN01

RESET_OUT_IN10

RESET_OUT_IN01_SW

RESET_OUT_IN10_SW
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Bit-by-Bit Boolean Link
These are the four standard blocks of the Boolean Logic.

AND
AND logic

09_be-and.bmp

Fig. 9-45: AND block

OR
OR logic

09_be-or.bmp

Fig. 9-46: OR block

NOT
NOT logic

09_be-not.bmp

Fig. 9-47: NOT block
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XOR
EXCLUSIVE OR logic

09_be-xor.bmp

Fig. 9-48: XOR block

All input and output parameters are of "ANY_BIT" type.

09_be-xxxxx.bmp

Fig. 9-49: Number and type of inputs

You can also adapt the individual blocks to your requirements by varying
the number of inputs and/or negating individual inputs.
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Arithmetic Operators:

ADD
Addition

09_be-add.bmp

Fig. 9-50: ADD block

Input parameter:

ANY_NUM

Output parameter:

ANY_NUM

MUL
Multiplication

09_be-mul.bmp

Fig. 9-51: MUL block

Input parameter:

ANY_NUM

Output parameter:

ANY_NUM

SUB
Subtraction

09_be-sub.bmp

Fig. 9-52: SUB block

Input parameter:

ANY_NUM

Output parameter:

ANY_NUM
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DIV
Division

09_be-div.bmp

Fig. 9-53: DIV block

Input parameter:

ANY_NUM

Output parameter:

ANY_NUM

MOD
Modulo; reminder of an integer division

09_be-mod.bmp

Fig. 9-54: MOD block

Input parameter:

ANY_NUM

Output parameter:

ANY_NUM

MOVE
Assignment; A gets the value of E.

09_be-move.bmp

Fig. 9-55: MOVE block

Input parameter:

ANY_NUM, ANY_BIT

Output parameter:

ANY_NUM, ANY_BIT
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Arithmetic Comparison

GT
Greater than

09_be-gt.bmp

Fig. 9-56: GT block

Input parameter:

ANY_NUM

Output parameter:

BOOL

GE
Greater than or equal to

09_be-ge.bmp

Fig. 9-57: GE block

Input parameter:

ANY_NUM

Output parameter:

BOOL

EQ
Equal to

09_be-eq.bmp

Fig. 9-58: EQ block

Input parameter:

ANY_NUM

Output parameter:

BOOL
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LE
Lower than or equal to

09_be-le.bmp

Fig. 9-59: LE block

Input parameter:

ANY_NUM

Output parameter:

BOOL

LT
Lower than

09_be-lt.bmp

Fig. 9-60: LT block

Input parameter:

ANY_NUM

Output parameter:

BOOL

NE
Not equal to

09_be-ne.bmp

Fig. 9-61: NE block

Input parameter:

ANY_NUM

Output parameter:

BOOL
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Type Conversion

*_TO_*
The type conversion functions convert the data types:

• BOOL

• BYTE

• INT

• SINT

• DINT

• WORD

• DWORD

• REAL

from one to the other.

The block designation is then:

Source data type_TO_destination data type

For example, the conversion of INT to BYTE

09_be-i2b.bmp

Fig. 9-62: INT_TO_BYTE block

BCD_TO_DINT
Type conversion from BCD code to DINT

09_be-bcd.bmp

Fig. 9-63: BCD_TO_DINT block

Input parameter:

DWORD

Output parameter:

DINT
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TRUNC_*
Truncation

The functions

• TRUNC_DINT

• TRUNC_INT

• TRUNC_SINT

are available.

09_be-trun.bmp

Fig. 9-64: TRUNC_INT block

Input parameter:

ANY_REAL

Output parameter:

DINT, INT, SINT (depending on the selected block)
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Bit Manipulation

SHL
Shift left

09_be-shl.bmp

Fig. 9-65: SHL block

Input parameter IN:

ANY_BIT

Input parameter N:

ANY_INT

Output parameter A:

ANY_BIT

SHR
Shift right

09_be-shr.bmp

Fig. 9-66: SHR block

Input parameter IN:

ANY_BIT

Input parameter N:

ANY_INT

Output parameter A:

ANY_BIT
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ROR
Rotate right

09_be-ror.bmp

Fig. 9-67: ROR block

Input parameter IN:

ANY_BIT

Input parameter N:

ANY_INT

Output parameter A:

ANY_BIT

ROL
Rotate left

09_be-rol.bmp

Fig. 9-68: ROL block

Input parameter IN:

ANY_BIT

Input parameter N:

ANY_INT

Output parameter A:

ANY_BIT
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Numeric Functions

ABS
Absolute value

09_be-abs.bmp

Fig. 9-69: ABS block

Input parameter E:

REAL

Output parameter A:

REAL

NEG
Negation

09_be-neg.bmp

Fig. 9-70: NEG block

Input parameter E:

ANY_NUM

Output parameter A:

ANY_NUM

SQRT
Square root

09_be-sqrt.bmp

Fig. 9-71: SQRT block

Input parameter E:

REAL

Output parameter A:

REAL
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Blocks Selection Functions
Connection designations:

MN Default ’Minimum value’

MX Default ’Maximum value’

A Output

IN Input value

E1 Input value 1

E2 Input value 2

The functions MIN, MAX, LIMIT are available for the following data types:

DINT, INT, REAL, SINT

For INT e. g. MAX_INT, MIN_INT and LIMIT_INT

MAX_*
Maximum input value

09_be-max.bmp

Fig. 9-72: MAX_* block

MIN_*
Minimum input value

09_be-min.bmp

Fig. 9-73: MIN_* block

LIMIT_*
Maximum or minimum input value

09_be-limi.bmp

Fig. 9-74: LIMIT_* block
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SEL
Select an input value from two input values by using the "G" bit. This
block can be utilized for all ANY_NUM data types.

09_be_sel1.bmp

Fig. 9-75: SEL block

Input parameter G:

BOOL

Input parameter IN0, IN1:

ANY_NUM

Output parameter A:

ANY_NUM

SEL_*
Select an input value from two input values by using the "G" bit.

09_be_sel2.bmp

Fig. 9-76: SEL_* block

Input parameter G:

BOOL

Input parameter IN0, IN1, output parameter A:

DINT, REAL, SINT depending on the selected block.
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Bistable Elements:

SR
Memory block (flip-flop)

prior setting

09_be-sr.bmp

Fig. 9-77: SR flip-flop

Input parameter SET1:

BOOL

Input parameter RESET:

BOOL

Output parameter Q1:

BOOL

RS
Memory block (flip-flop)

prior resetting

09_be-rs.bmp

Fig. 9-78: RS flip-flop

Input parameter SET:

BOOL

Input parameter RESET1:

BOOL

Output parameter Q1:

BOOL
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Edge Recognition:

R_TRIG
Recognition of a rising edge

09_be-rtri.bmp

Fig. 9-79: R_TRIG block

Input parameter CLK:

BOOL

Output parameter Q:

BOOL

F_TRIG
Recognition of a falling edge

09_be-ftri.bmp

Fig. 9-80: F_TRIG block

Input parameter CLK:

BOOL

Output parameter Q:

BOOL

Counters
Connection designations:

CV Current counter value

PV Maximum/minimum value

Q TRUE, if CV has reached the maximum/minimum value
PV.

RESET Sets CV to 0

LOAD Sets CV to PV

QU TRUE, when CV has reached the maximum value.

QD TRUE, when CV has reached the minimum value.

CU Starts up counter.

CD Starts down counter.
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CTU
Up counter (from 0 to PV)

09_be-ctu.bmp

Fig. 9-81: CTU block

Input parameter CU, RESET:

BOOL

Input parameter PV:

INT

Output parameter Q:

BOOL

Output parameter CV:

INT

CTD
Down counter (from PV to 0)

09_be-ctd.bmp

Fig. 9-82: CTD block

Input parameter CD, LOAD:

BOOL

Input parameter PV:

INT

Output parameter Q:

BOOL

Output parameter CV:

INT
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CTUD
Up/down counter (between 0 and PV)

09_be-ctud.bmp

Fig. 9-83: CTUD block

Input parameter CU, CD, RESET, LOAD:

BOOL

Input parameter PV:

INT

Output parameter QU, QD:

BOOL

Output parameter CV:

INT

G3 Functions:
Generally, process data from the PLC or the PC (HOST_IN) and to the
bus (BUS_OUT) cannot be influenced in a buffered instance. To provide
this possibility of additional influence, the reset functions were formerly
developed as part of the firmware (Generation 3) and are now available
as function blocks in the "Preprocessing" add-on program.

Function:

The bit at HOST_IN is passed directly to BUS_OUT. This is the normal
connection between the host system and the INTERBUS system. You can
influence this direct connection with the RESET input because the
RESET input has a higher priority than the HOST_IN. The HOST_IN bit is
only routed to BUS_OUT with a rising edge.

This block exists respectively for a rising edge (Reset_OUT_IN01 and
Reset_OUT_IN01_SW) and for a falling edge (Reset_OUT_IN10 and
Reset_OUT_IN10_SW) of the RESET input.
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RESET_OUT_IN01

09_be-in01.bmp

Fig. 9-84: RESET_OUT_IN01 block

Discrete structure:

09_be-g301.bmp

Fig. 9-85: Discrete structure of the RESET_OUT_IN01

RESET_OUT_IN10

09_be-in10.bmp

Fig. 9-86: RESET_OUT_IN10 block

Discrete structure:

09_be-g302.bmp

Fig. 9-87: Discrete structure of the RESET_OUT_IN10

The two following blocks have an additional enable input. This input has
to be set for the RESET bit to be effective.
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RESET_OUT_IN01_SW

09_be-in01s.bmp

Fig. 9-88: RESET_OUT_IN01_SW block

Discrete structure:

09_be-g303.bmp

Fig. 9-89: Discrete structure of the RESET_OUT_IN01_SW

Reset_OUT_IN10_SW

09_be-in10s.bmp

Fig. 9-90: RESET_OUT_IN10_SW block

Discrete structure:

09_be-g304.bmp

Fig. 9-91: Discrete structure of the RESET_OUT_IN10_SW
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Toolbar "Preprocessing"

Save File

Compile All

Compile Worksheet

Zoom Out

Zoom In

Zoom Area

Paste Object

Copy Object

Cut Object

Delete Object

Undo

Mark Object

Create Connection Lines
With this button you can connect individual blocks with each
other.

Add Text
With this button you can add describing text to your worksheet.

Insert Block

Assign Input/Output Variables

Define Constant

Previous Worksheet

Worksheet Management

Next Worksheet

Previous Error

Next Error

Find

Find and Replace



9-46 Preprocessing INTERBUS Configurator CMD

DOK-CONTRL-IBS*CMD****-AW01-EN-P

9.12 Keyboard Assignment

Help (in the "?" menu)

Redraw (in the "Layout" menu)

Grid (in the "Layout" menu)

Mark All Objects (in the "Edit" menu)

Page Borders (in the "Layout" menu)

Delete (in the "Edit" menu)

Exit (in the "File" menu)

Copy (in the "Edit" menu)

Link Object (in the "Edit" menu)

Select Object (in the "Edit" menu)

Save (in the "File" menu)

Paste (in the "Edit" menu)

Cut (in the "Edit" menu)

Undo (in the "Edit" menu)

Previous View (in the "Layout" menu)

Default Size (in the "Layout" menu)

Zoom Out (in the "Layout" menu)

Zoom In (in the "Layout" menu)

Function/Function Block (in the "Object" menu)

Text (in the "Object" menu)

Variable (in the "Object" menu)
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10 Miscellaneous

10.1 Message Dialog

The message dialog provides you with information on type and origin

• of an event,

• a malfunction, or

• an error.

10_hinweis1.bmp

Fig. 10-1: Message dialog without details

You can close the message dialog with "OK" or have detailed information
displayed with the "Detail" button.

10_hinweis2.bmp

Fig. 10-2: Message dialog with details
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Double-click on the picture icon in the dialog box to see the message
codes and the name of the file in which it is stored.

10_meldklik.bmp

Fig. 10-3: Message code and file

10.2 Bus Editor

<CTRL>+<x> Cuts the selected device

<CTRL>+<c> Copies the selected device

<CTRL>+<v> Pastes the selected device

You can also paste a device from the Windows Clipboard into another
text-based application. You don’t paste the device data as device icon, but
as text.

Example:

Bus terminal No

Device Local bus

ID Code 126

Process data channel length 64 [bit]

Parameter channel length 0 [bit]

Profile number 0h

Incoming interface (IN1) ST local bus

Outgoing interface (OUT1) ST local bus

Branching interface (OUT1) None

Manufacturer name Phoenix Contact

Device type IB ST 24 AI 4/SF

Group PHOENIX

Icon library PHOENIX.ICL

You can select several devices simultaneously and move, copy and
delete them.

When a device is moved, it may be attached to an interface of the same
type. If the device cannot be inserted at the interface in question, the
system will search for another, acceptable interface (e.g. on a double bus
terminal like the IBS ST 24 BK RB-T).

To select a range of consecutive devices, click the first device in the
range and press the <SHIFT>-key. Without releasing the <SHIFT>-key,
click on the last device in the range. This will select all the devices
between the first and the last one.

Message Code, Message File

Using Keyboard Shortcuts to
Cut, Copy and Paste

Pasting in Other Applications

Selecting Multiple Devices

To Select a Range of Devices
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To select specific devices in your bus configuration, press the <CTRL>-
key, click on the desired device without releasing the <CTRL>-key. To
move the selected item, drag it to its new location in the bus configuration.

To move or copy devices you can move the mouse to drag and drop them
to the desired location in the bus configuration. To do this, click on the
marked device with the left mouse button and drag the device to its new
location without releasing the mouse button. The device will be inserted at
the point where you release the left mouse button.

Appearance of the cursor during Drag and Drop

Moving a device

Moving several devices

Copying a device

Copying several devices

You can configure and set the width of the bus display. For example, you
might set a maximum width, when working at a lower resolution or for a
clear print-out. If the display width for the loaded bus configuration is not
sufficient, the bus display will be re-formatted as shown below. You can
set the display width in the "Settings" dialog box of the "View" menu.

06_busda.bmp

Fig. 10-4: Bus representation

To Select a Specific Device

Drag and Drop

Setting the Display Width
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10.3 Bus Representation in Case of an Error

This yellow symbol indicates failure messages of a device and
is displayed on the device that caused the message.

This red symbol indicates that an error was found during the
configuration frame check and/or the parameterization. The
detected device has, for example, a different ID code or a
different process data channel length. The symbol is placed
directly on the device causing the error.

This red symbol signals an error that has led to the bus being
switched of. If the fault is localized, the bus terminal of the
affected bus segment is covered by this symbol. In addition to
that, the bus line to the incoming interface of the bus terminal is
displayed in a different color. Since the bus can no longer run
from this position, all subsequent devices are represented as
inactive (device icon in gray and text in italics).

This representation indicates that the device is inactive. If a
specific device is hidden, it is also represented in this way.

In the case of operation errors of IBS CMD G4 and messages of the
controller board you will be provided with information in a message box.

10_sym-ina.bmp

Fig. 10-5: Inactive device

In the case of operation errors of IBS CMD G4 and messages of the
controller board you will be provided with information in a message box.
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Error display in the box display.

10_box_per.bmp

Fig. 10-6: Peripheral error

The device appears yellow when a peripheral error occurred (e.g. error in
the peripheral power supply). This error does not result in a bus stop.

10_breite.bmp

Fig. 10-7: Bus error

The device appears red when a bus error has occurred that results in a
bus stop.

10.4 Connecting Lines of the Bus Lines

Copper remote bus lines

Fiber optic remote bus lines

Installation remote bus

Incompatible interface types

Copper local bus line

Bus line for IB-ST compact stations

INTERBUS loop connecting line

In the operating states "Configuration (offline)", Configuration (online)",
and "Monitoring" the bus lines are displayed in black. Among other things,
you will recognize the "Diagnostics" operating state by the green remote
bus lines.
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10.5 Mouse menu / Context menu

With the left mouse button you can select (focus) an element (project,
PLC/PC, controller board, parameterization memory, configuration frame,
device). If you press the right mouse button on the marked element, a
context menu appears containing the commands available for this
element.

The context menu is divided into up to four areas which are also displayed
in the menu bar.

10_mausmen.bmp

Fig. 10-8: Mouse menu / context menu

Context menu items such as: Cut, Copy, Paste, Delete

Context menu items such as: Process Data, Description

Context menu items such as: Address Monitor, Display IBS DSC

Context menu items such as: Bus Diagnostics

Edit

Configuration

Monitoring

Diagnostics
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10.6 Explanation of the Product Designations

Product designations for INTERBUS products from Phoenix Contact are
structured according to an uniform scheme.

You can derive the following information from the module designations:

10_codes.bmp

Fig. 10-9: Product designations

Design

SL INTERBUS installation local bus

RT RemoteTerminal

ST SmartTerminal

CB ControllerBoard

IP Degree of protection IP65

IPKIS Degree of protection IP67 KIS

IPKES Degree of protection IP67 KES

SAB Sensor/actuator box

Voltage

24 24 V

120 120 V

etc.

Task

D Digital device

A Analog device

BK Bus terminal

CBK Installation remote bus terminal

PT Resistance thermometer

UTH Thermocouples

V24 Serial connection V24/RS232

CNT Counter

RELS Relay outputs
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Direction

I Input

O Output

IO In-/Output

Number of inputs/outputs

8 8 inputs or outputs

32 32 inputs or outputs

etc.

Connection method

/2 2-wire connection

/4 4-wire connection

etc.

Example:

IB ST 24 DO 32/2

Bus type: SmartTerminal

Voltage: 24 V

Signal form: Digital

Direction: Output

Outputs: 32

Connection
method:

2-wire
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10.7 Keyboard Assignment

Main Program

Print ..." (in the "File" menu)

Operating State … (in the "File" menu)

Save (in the "File" menu)

Open  (in the "File" menu)

Replace  (in the "Edit" menu)

Compressed Representation  (in the "View" menu)

Search ..." (in the "Edit" menu)

Description (in the "Configuration" menu)

Exit  (in the "File" menu)

Insert with Description  (in the "Edit" menu)

Delete  (in the "Edit" menu)

Cut  (in the "Edit" menu)

Copy  (in the "Edit" menu)

Paste  (in the "Edit" menu)

Undo  (in the "Edit" menu)

Process Data/Variables (in the "Configuration" menu)

Address Monitor  (in the "Monitor" menu)

Exit  (in the "File" menu)

Call up context menu
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(Default) actions  6-43
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?  7-3

A
ABS block  9-36
Absolute value  9-36
Actions of the Start-Up With Physical Addressing parameterization  6-42
Actions of the Start-Up With Processing parameterization  6-41
ADD block  9-28
Addition  9-28
Add-on programs  5-7
Address monitor  8-1
Address selection  8-3
Analog address range  6-71
AND block  9-26
AND logic  9-26
ANY_BIT - Group  9-23
ANY_INT - Group  9-23
ANY_NUM  9-30
ANY_REAL - Group  9-23
Appropriate use

Introduction  2-1
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Basic principles  5-1
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Canceling Menus  5-10
Change comment  7-13
Check

Hardware  5-8
Comment statistic entry  7-11
Communication paths  5-4

Serial interface  5-4
Slot  5-4

Compiler message  9-19
Configuration  5-5

INTERBUS  4-1
Configuration data  6-78
Connect

Serial interface  5-4
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Context menu  5-4, 10-6
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CTU block  9-41
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Process data  6-67
Device labeling  6-64
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Device statistics  7-11, 7-13
Device types  5-2
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Example of a process data description  6-68
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F_TRIG block  9-40
Files

Other files  5-11
Project files  5-11

Firmware version  6-66
Function key bar  5-9
Function parameters (input)  8-3
Function parameters (output)  8-3
Function table  6-54

G
G3 functions  9-25, 9-42
GE block  9-30
General operating instructions  5-9
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H
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Hardware requirements  5-8
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Hints for using this manual  1-1

I
IB-Loader  6-82
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IEC 1131-3  6-99, 6-100
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Consequences, Discharge of liability  2-1
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Programming interface WinPCL  4-13
INTERBUS-S Club e.V.  5-7
Interrupt mode  6-33
Interrupt mode of the host system  6-34
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Keyboard assignment  9-46, 10-9
Keyboard assignment Diagnostics  7-15

L
LE block  9-31
Legal Authority  1-2
LIMIT_* block  9-37
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Local bus  5-3
Local bus size  6-21
Location of process data  6-111
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LT block  9-31
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Main window

Diagnostics  7-2
Main window Diagnostics  7-3
Main window Preprocessing  9-2
MAX_* block  9-37
Menu  7-15
Menu ?

About  6-128
Contents  6-127
Firmware library  6-127
First steps  6-127
Operating instructions  6-127
Using help  6-127

Menu bar  5-9
Menu Commands Diagnostics  7-3
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Context menu Edit parameterization  6-37
Context menu Preprocessing variables  6-96
Context menu Process data  6-70
Controller board ... (Device ...) Device registration  6-63
Controller board ... Control ...  6-47
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Controller board ... Parameterization ... Import ...  6-45
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Dialog box Action editor  6-39
Dialog box Action library  6-38
Dialog box Address assignment  6-74
Dialog box Automatic assignment  6-72
Dialog box Bit selection events  6-57
Dialog box Bit selection user function  6-55
Dialog box CSV options  6-80
Dialog box Device registration (Automatic)  6-64
Dialog box Direct link/variables  6-73
Dialog box Display  6-107
Dialog box Edit parameter  6-59
Dialog box Filter (Process data)  6-75
Dialog box Filter (variables)  6-97
Dialog box Interface type for bus terminal mode  6-106
Dialog box Operating mode options  6-32
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Dialog box Parameterization data  6-45
Dialog box Process data assignments  6-98
Dialog box Search error location  6-73
Dialog box Settings ... Bus mode  6-31
Dialog box Settings ... Controller board  6-34
Dialog box Settings ... I/O coupling  6-35
Dialog box Settings ... Standard register  6-27
Parameter channel ...  6-105
Parameterization memory ... Compare  6-87
Parameterization memory ... Description ...  6-83
Parameterization memory ... File  6-88
Parameterization memory ... File ... Read  6-90
Parameterization memory ... File ... Select  6-88
Parameterization memory ... File ... Write  6-92
Parameterization memory ... Format  6-84
Parameterization memory ... Read  6-85
Parameterization memory ... Write  6-86
Parameterization memory ... Write ASCII file ... EPLAN data (*.EPL)  6-80
Parameterization memory ... Write ASCII file ... INTERBUS data (*.SVC)  6-82
Parameterization memory ... Write ASCII file ... Project data (*.CSV)  6-77
Parameterizations, actions and their services  6-41
PLC/PC ... Description  6-25
Preprocessing ... Description  6-99
Preprocessing ... Import  6-99
Preprocessing ... Programming  6-99
Preprocessing ... Variables  6-95
Program ... Description ...  6-25
Project ... Description  6-23
Project ... EPLAN viewer ...  6-24
Project ... Export project data (<Project_name>.PEX)  6-24
Standard function Start register / Status register / Parameter register  6-29

Menu Diagnostics  7-3
Menu Diagnostics ...

Close  7-5
Settings ...  7-4

Menu Edit ...
Copy  6-8
Cut  6-8
Delete  6-9
Dialog Box Define process data length  6-12
Dialog box Device database  6-13
Insert with description  6-11
Insert with ID code  6-10
Link with description  6-14
Paste  6-9
Re-assigning device numbers  6-16
Replace  6-9
Search ...  6-8
Undo  6-7

Menu File ...
Conversion instructions (BUS -> BG4)  6-4
Delete ...  6-5
Exit  6-6
New  6-3
Open ...  6-3
Operating state  6-2
Print ...  6-5
Save  6-4
Save As ...  6-4

Menu Messages  7-3
Menu Messages ...

Evaluate message file ...  7-7
Message types ...  7-9
Messages (Online) ...  7-6
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Menu Options ...  6-112
Add-on programs ... Activate ...  6-112
Add-on programs ... Deactivate  6-113
Device description ... Delete  6-115
Device description ... Export  6-116
Device description ... Import  6-115
Device descriptions ... Create  6-113
Device descriptions ... Print  6-115
Dialog box Select connection for the RS-232 driver  6-120
Dialog box Settings for the RS-232 driver  6-120
Extended scope of functions  6-117
Reset CRs  6-117
Settings  6-118
Settings ... Database (general)  6-125
Settings ... Device database  6-121
Settings ... Driver  6-119
Settings ... General  6-122
Settings ... Password  6-126
Settings ... Process data  6-125

Menu Statistics  7-3
Menu Statistics ...

Evaluate statistics ...  7-12
Last peripheral error ...  7-14
Record statistics ...  7-10
Reset statistics counter  7-14
Top ten ...  7-14

Menu structure  6-1
Menu structure Preprocessing  9-2
Menu View ...  6-17

Box display  6-18
Dialog box Display options  6-20
Reduced representation  6-17
Refresh  6-21
Settings …  6-19

Menu Window  7-3
Menu Window ...

Bus system messages  7-14
Message code  10-2
Message dialog  10-1

with details  10-1
without details  10-1

Message file  10-2
Messages  7-3
MIN_* block  9-37
MOD block  9-29
Monitor  8-1
Monitoring  5-6
Monitoring times  6-32
Mouse menu  10-6
MOVE block  9-29
Moving around in the dialog box  5-10
MUL block  9-28
Multiplication  9-28

N
NE block  9-31
NEG block  9-36
Negation  9-36
NOT block  9-26
Not equal to  9-31
NOT logic  9-26
Numeric functions  9-25
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O
Operating and display elements  5-9
Operating states of the controller board  6-47, 6-48
Operating status  5-7, 5-9
Operation with the keyboard  5-10
OR block  9-26
OR logic  9-26
Output process data  8-3
Overwrite Boolean variables  9-22
Overwrite numeric variables  9-22
Overwrite variables  9-22

P
Parameterizations  6-36
Parameters  6-40
Peripheral error  10-5
Possible device states  8-7
Preporcessing

Menu Make ... Prev. error  9-20
Preprocessing  8-8, 9-1

Menu ? ... About  9-21
Menu ? ... Contents  9-21
Menu ? ... Use help  9-21
Menu Edit ... Copy  9-6
Menu Edit ... Copy To  9-7
Menu Edit ... Cut  9-6
Menu Edit ... Delete  9-7
Menu Edit ... Delete Worksheet  9-7
Menu Edit ... Find  9-8
Menu Edit ... Find and Replace  9-9
Menu Edit ... Insert From  9-7
Menu Edit ... Link Objects  9-10
Menu Edit ... Mark All Objects  9-9
Menu Edit ... Mark Objects  9-10
Menu Edit ... Next WS  9-4
Menu Edit ... Object Properties  9-11
Menu Edit ... Open Object  9-10
Menu Edit ... Paste  9-6
Menu Edit ... Prev. WS  9-5
Menu Edit ... Undo  9-6
Menu Edit ... WS manag.  9-5
Menu File ... Back to CMD  9-3
Menu File ... Exit  9-3
Menu File ... Save  9-3
Menu Layout ... Default size  9-17
Menu Layout ... Grid  9-18
Menu Layout ... Online layout  9-18
Menu Layout ... Page borders  9-18
Menu Layout ... Previous view  9-17
Menu Layout ... Redraw  9-17
Menu Layout ... Status line  9-16
Menu Layout ... Toolbar  9-15
Menu Layout ... WS size  9-16
Menu Layout ... Zoom in  9-17
Menu Layout ... Zoom out  9-17
Menu Layout ... Zoom range  9-16
Menu Make ... Check unit  9-20
Menu Make ... Compile all  9-19
Menu Make ... Next error  9-20
Menu Object ... Constant  9-14
Menu Object ... Function/Functions Block  9-12
Menu Object ... Text (comment)  9-14
Menu Object ... Variable  9-13

Presentation  5-6, 6-107
Process Data Descriptions  6-110
Process data dialog box  6-110
Process data name  6-111
Process data type  6-72
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Product designations  10-7
Program description  5-4
Programming interface WinPCL

Declaration editor  4-14
I/O editor  4-13

Project files  5-11
Project structure  5-10

Q
Quick-start CMD and WinPCL  4-1

R
R_TRIG block  9-40
RAM  5-8
Record statistics  7-10
Replacement Mode  6-65
Representation area  5-9
Reserved keywords according to IEC 1131-3  6-100
RESET_OUT_IN01 block  9-43
RESET_OUT_IN01_SW block  9-44
RESET_OUT_IN10 block  9-43
RESET_OUT_IN10_SW block  9-44
ROL block  9-35
ROR block  9-35
Rotate left  9-35
Rotate right  9-35
RS flip-flop  9-39
Rules for assigning variable names according to IEC 1131-3  6-99

S
Safety Instructions for Electric Drives and Controls  3-1
SEL block  9-38
SEL_* block  9-38
Selecting menu items  5-10
Selecting menus  5-10
Selection functions  9-25
Service  6-39
SHL block  9-34
SHR block  9-34
Software  5-4
Software tool IBS CMD G4  4-1

Communication path settings  4-5
Component selection  4-1
Create new project  4-3
Offline/Online operation  4-2
Parameterization memory  4-12
Password entry  4-2
Proceedings INTERBUS configuration  4-2
Process data assignment  4-8
Read in Configuration frame  4-6
Save project  4-11
Select controller board type  4-3
Standard and function register  4-9
Starting-up Behavior/Parameterization of the INTERBUS  4-10

SQRT block  9-36
Square root  9-36
SR flip-flop  9-39
Standard function register  6-27
Standard register  8-3
Statistics  7-3
Status line  5-9
Structure of a service  6-58
SUB block  9-28
Subtraction  9-28
Syntax of the assignments  6-69
System menu Address monitor  8-2
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T
Toolbar preprocessing  9-45
Topology  5-3
TRUNC_INT block  9-33
Type conversion  9-32
Type conversions  9-24
Type of replacement  6-65

U
Use  See appropriate use and inappropriate use
User functions  8-3
User group  1-1

W
Window  7-3
Wiring  5-1
Worksheet size  9-16

X
XOR block  9-27

Z
Zooming  9-16
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13 Service & Support

13.1 Helpdesk

Unser Kundendienst-Helpdesk im Hauptwerk Lohr
am Main steht Ihnen mit Rat und Tat zur Seite.
Sie erreichen uns

- telefonisch: +49 (0) 9352 40 50 60
über Service Call Entry Center Mo-Fr   07:00-18:00

- per Fax: +49 (0) 9352 40 49 41

- per e-Mail: service@indramat.de

Our service helpdesk at our headquarters in Lohr am
Main, Germany can assist you in all kinds of inquiries.
Contact us

- by phone: +49 (0) 9352 40 50 60
via Service Call Entry Center Mo-Fr 7:00 am - 6:00 pm

- by fax: +49 (0) 9352 40 49 41

- by e-mail: service@indramat.de

13.2 Service-Hotline

Außerhalb der Helpdesk-Zeiten ist der Service
direkt ansprechbar unter

+49 (0) 171 333 88 26
oder +49 (0) 172 660 04 06

After helpdesk hours, contact our service
department directly at

+49 (0) 171 333 88 26
or +49 (0) 172 660 04 06

13.3 Internet

Unter www.indramat.de finden Sie
ergänzende Hinweise zu Service, Reparatur und
Training sowie die aktuellen Adressen *) unserer
auf den folgenden Seiten aufgeführten Vertriebs-
und Servicebüros.

Verkaufsniederlassungen

Niederlassungen mit Kundendienst

Außerhalb Deutschlands nehmen Sie bitte zuerst Kontakt mit
unserem für Sie nächstgelegenen Ansprechpartner auf.

*) http://www.indramat.de/de/kontakt/adressen
Die Angaben in der vorliegenden Dokumentation können
seit Drucklegung überholt sein.

At www.indramat.de you may find additional
notes about service, repairs and training in the
Internet, as well as the actual addresses *) of our
sales- and service facilities figuring on the following
pages.

sales agencies

offices providing service

Please contact our sales / service office in your area first.

*) http://www.indramat.de/en/kontakt/adressen
Data in the present documentation may have become
obsolete since printing.

13.4 Vor der Kontaktaufnahme... - Before contacting us...

Wir können Ihnen schnell und effizient helfen wenn
Sie folgende Informationen bereithalten:

1. detaillierte Beschreibung der Störung und der
Umstände.

2. Angaben auf dem Typenschild der
betreffenden Produkte, insbesondere
Typenschlüssel und Seriennummern.

3. Tel.-/Faxnummern und e-Mail-Adresse, unter
denen Sie für Rückfragen zu erreichen sind.

For quick and efficient help, please have the
following information ready:

1. Detailed description of the failure and
circumstances.

2. Information on the type plate of the affected
products, especially type codes and serial
numbers.

3. Your phone/fax numbers and e-mail address,
so we can contact you in case of questions.
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13.5 Kundenbetreuungsstellen - Sales & Service Facilities

Deutschland – Germany vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Vertriebsgebiet Mitte
 Germany Centre

Rexroth Indramat GmbH
Bgm.-Dr.-Nebel-Str. 2 / Postf. 1357
97816 Lohr am Main / 97803 Lohr

Kompetenz-Zentrum Europa

Tel.: +49 (0)9352 40-0
Fax: +49 (0)9352 40-4885

S E R V I C E

C A L L  E N T R Y  C E N T E R
MO – FR

von 07:00 - 18:00 Uhr

from 7 am – 6 pm

Tel. +49 (0) 9352 40 50 60
service@indramat.de

S E R V I C E

H O T L IN E
MO – FR

von 17:00 - 07:00 Uhr
from 5 pm - 7 am

+ SA / SO

Tel.: +49 (0)172 660 04 06
o d e r  /  o r

Tel.: +49 (0)171 333 88 26

S E R V I C E

ERSATZTEILE / SPARES
verlängerte Ansprechzeit
- extended office time -

♦ nur an Werktagen
- only on working days -

♦ von 07:00 - 18:00 Uhr
- from 7 am - 6 pm  -

Tel. +49 (0) 9352 40 42 22

Vertriebsgebiet Süd
 Germany South

Rexroth Indramat GmbH
Landshuter Allee 8-10
80637 München

Tel.: +49 (0)89 127 14-0
Fax: +49 (0)89 127 14-490

Gebiet Südwest
 Germany South-West

Bosch Rexroth AG
Vertrieb Deutschland – VD-BI
Geschäftsbereich Rexroth Indramat
Regionalzentrum Südwest
Ringstrasse 70    /   Postfach 1144
70736 Fellbach   /    70701 Fellbach

Tel.: +49 (0)711 57 61–100
Fax: +49 (0)711 57 61–125

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Beckerstraße 31
09120 Chemnitz

Tel.: +49 (0)371 35 55-0
Fax: +49 (0)371 35 55-333

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Regionalzentrum Ost
Walter-Köhn-Str. 4d
04356 Leipzig

Tel.: +49 (0)341 25 61-0
Fax: +49 (0)341 25 61-111

Vertriebsgebiet West
 Germany West

Bosch Rexroth AG
Vertrieb Deutschland
Regionalzentrum West
Borsigstrasse 15
40880 Ratingen

Tel.: +49 (0)2102 409-0
Fax: +49 (0)2102 409-406

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Regionalzentrum Mitte
Waldecker Straße 13
64546 Mörfelden-Walldorf

Tel.: +49 (0) 61 05 702-3
Fax: +49 (0) 61 05 702-444

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Walsroder Str. 93
30853 Langenhagen

Tel.: +49 (0) 511 72 66 57-0
Service: +49 (0) 511 72 66 57-256
Fax: +49 (0) 511 72 66 57-93
Service: +49 (0) 511 72 66 57-95

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Kieler Straße 212
22525 Hamburg

Tel.: +49 (0) 40 81 955 966
Fax: +49 (0) 40 85 418 978
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Europa (West) - Europe (West)

vom Ausland: (0) nach Landeskennziffer weglassen, Italien: 0 nach Landeskennziffer mitwählen
from abroad:    don’t dial (0) after country code, Italy:    dial 0 after country code

Austria - Österreich

Bosch Rexroth GmbH
Bereich Indramat
Stachegasse 13
1120 Wien

Tel.: +43 (0)1 985 25 40
Fax: +43 (0)1 985 25 40-93

Austria – Österreich

Bosch Rexroth G.m.b.H.
Gesch.ber. Rexroth Indramat
Industriepark 18
4061 Pasching

Tel.: +43 (0)7221 605-0
Fax: +43 (0)7221 605-21

Belgium - Belgien

Bosch Rexroth AG
Electric Drives & Controls
Industrielaan 8
1740 Ternat
Tel.: +32 (0)2 5830719
- service: +32 (0)2 5830717
Fax: +32 (0)2 5830731
 indramat@boschrexroth.be

Denmark - Dänemark

BEC A/S
Zinkvej 6
8900 Randers

Tel.: +45 (0)87 11 90 60
Fax: +45 (0)87 11 90 61

Great Britain – Großbritannien

Bosch Rexroth Ltd.
Rexroth Indramat Division
Broadway Lane, South Cerney
Cirencester, Glos GL7 5UH

Tel.: +44 (0)1285 863000
Fax: +44 (0)1285 863030
 sales@boschrexroth.co.uk
 service@boschrexroth.co.uk

Finland - Finnland

Bosch Rexroth Oy
Rexroth Indramat division
Ansatie 6
017 40 Vantaa

Tel.: +358 (0)9 84 91-11
Fax: +358 (0)9 84 91-13 60

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
Avenue de la Trentaine
BP. 74
77503 Chelles Cedex

Tel.: +33 (0)164 72-70 00
Fax: +33 (0)164 72-63 00
Hotline: +33 (0)608 33 43 28

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
1270, Avenue de Lardenne
31100 Toulouse

Tel.: +33 (0)5 61 49 95 19
Fax: +33 (0)5 61 31 00 41

France - Frankreich

Bosch Rexroth S.A.
Division Rexroth Indramat
91, Bd. Irène Joliot-Curie
69634 Vénissieux – Cedex
Tel.: +33 (0)4 78 78 53 65
Fax: +33 (0)4 78 78 53 62

Italy - Italien

Bosch Rexroth S.p.A.
Via G. Di Vittoria, 1
20063 Cernusco S/N.MI

Tel.: +39 02 2 365 270
Fax: +39 02 700 408 252378

Italy - Italien

Bosch Rexroth S.p.A.
Via Paolo Veronesi, 250
10148 Torino

Tel.: +39 011 224 88 11
Fax: +39 011 224 88 30

Italy - Italien

Bosch Rexroth S.p.A.
Via del Progresso, 16 (Zona Ind.)
35020 Padova

Tel.: +39 049 8 70 13 70
Fax: +39 049 8 70 13 77

Italy - Italien

Bosch Rexroth S.p.A.
Via Mascia, 1
80053 Castellamare di Stabia NA

Tel.: +39 081 8 71 57 00
Fax: +39 081 8 71 68 85

Italy - Italien

Bosch Rexroth S.p.A.
Viale Oriani, 38/A
40137 Bologna

Tel.: +39 051 34 14 14
Fax: +39 051 34 14 22

Netherlands – Niederlande/Holland

Bosch Rexroth B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 65 14 83
 indramat@hydraudyne.nl

Netherlands - Niederlande/Holland

Bosch Rexroth Services B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 67 78 14

Norway - Norwegen

Bosch Rexroth AS
Rexroth Indramat Division
Berghagan 1          or: Box 3007
1405 Ski-Langhus     1402 Ski

Tel.: +47 (0)64 86 41 00
Fax: +47 (0)64 86 90 62
 jul.ruud@rexroth.no

Spain - Spanien

Bosch Rexroth S.A.
Divisiòn Rexroth Indramat
Centro Industrial Santiga
Obradors s/n
08130 Santa Perpetua de Mogoda
Barcelona
Tel.: +34 9 37 47 94 00
Fax: +34 9 37 47 94 01

Spain – Spanien

Goimendi S.A.
División Rexroth Indramat
Parque Empresarial Zuatzu
C/ Francisco Grandmontagne no.2
20018 San Sebastian

Tel.: +34 9 43 31 84 21
- service: +34 9 43 31 84 56
Fax: +34 9 43 31 84 27
- service: +34 9 43 31 84 60
 sat.indramat@goimendi.es

Sweden - Schweden

Rexroth Mecman Svenska AB
Rexroth Indramat Division
- Varuvägen 7
(Service: Konsumentvägen 4, Älfsjö)
125 81 Stockholm

Tel.: +46 (0)8 727 92 00
Fax: +46 (0)8 647 32 77

Sweden - Schweden

Rexroth Mecman Svenska AB
Indramat Support
Ekvändan 7
254 67 Helsingborg

Tel.: +46 (0) 42 38 88 -50
Fax: +46 (0) 42 38 88 -74

Switzerland West - Schweiz West

Bosch Rexroth Suisse SA
Département Rexroth Indramat
Rue du village 1
1020 Renens

Tel.: +41 (0)21 632 84 20
Fax: +41 (0)21 632 84 21

Switzerland East - Schweiz Ost

Bosch Rexroth Schweiz AG
Geschäftsbereich Indramat
Hemrietstrasse 2
8863 Buttikon
Tel. +41 (0) 55 46 46 111
Fax +41 (0) 55 46 46 222
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Europa (Ost) - Europe (East)

vom Ausland: (0) nach Landeskennziffer weglassen  
from abroad:    don’t dial (0) after country code

Czech Republic - Tschechien

Bosch -Rexroth, spol.s.r.o.
Hviezdoslavova 5
627 00 Brno

Tel.: +420 (0)5 48 126 358
Fax: +420 (0)5 48 126 112

Czech Republic - Tschechien

DEL a.s.
Strojírenská 38
591 01 Zdar nad Sázavou
Tel.: +420 616 64 3144
Fax: +420 616 216 57

Hungary - Ungarn

Bosch Rexroth Kft.
Angol utca 34
1149 Budapest

Tel.: +36 (1) 364 00 02
Fax: +36 (1) 383 19 80

Poland – Polen

Bosch Rexroth Sp.zo.o.
ul. Staszica 1
05-800 Pruszków

Tel.: +48 22 738 18 00
– service: +48 22 738 18 46
Fax: +48 22 758 87 35
– service: +48 22 738 18 42

Poland – Polen

Bosch Rexroth Sp.zo.o.
Biuro Poznan
ul. Dabrowskiego 81/85
60-529 Poznan

Tel.: +48 061 847 64 62 /-63
Fax: +48 061 847 64 02

Rumania - Rumänien

Bosch Rexroth Sp.zo.o.
Str. Drobety nr. 4-10, app. 14
70258 Bucuresti, Sector 2

Tel.: +40 (0)1 210 48 25
+40 (0)1 210 29 50

Fax: +40 (0)1 210 29 52

Russia - Russland

Bosch Rexroth
Wjatskaja ul. 27/15
125015 Moskau

Tel.: +7-095-785 74 78
+7-095 785 74 79

Fax: +7 095 785 74 77
 laura.kanina@boschrexroth.ru

Russia - Russland

ELMIS
10, Internationalnaya Str.
246640 Gomel, Belarus

Tel.: +375/ 232 53 42 70
Fax: +375/ 232 53 37 69
 elmis_ltd@yahoo.com

Turkey - Türkei

Bosch Rexroth Otomasyon
San & Tic. A..S.
Fevzi Cakmak Cad No. 3
34630 Sefaköy Istanbul
Tel.: +90 212 541 60 70
Fax: +90 212 599 34 07

Slowenia - Slowenien

DOMEL
Otoki 21
64 228 Zelezniki
Tel.: +386 5 5117 152
Fax: +386 5 5117 225
 brane.ozebek@domel.si
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Africa, Asia, Australia – incl. Pacific Rim

vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Australia - Australien

AIMS - Australian Industrial
Machinery Services Pty. Ltd.
Unit 3/45 Horne ST
Campbellfield , VIC 3061
Melbourne
Tel.: +61 (0) 393 590 228
Fax: +61 (0) 393 590 286
Hotline: +61 (0) 419 369 195
 terryobrien@aimservices.com.au

Australia - Australien

Bosch Rexroth Pty. Ltd.
No. 7, Endeavour Way
Braeside Victoria, 31 95
Melbourne

Tel.: +61 (0)3 95 80 39 33
Fax: +61 (0)3 95 80 17 33
 mel@rexroth.com.au

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
Wai Gao Qiao Free Trade Zone
No.122, Fu Te Dong Yi Road
Shanghai 200131 - P.R.China

Tel.: +86 21 58 66 30 30
Fax: +86 21 58 66 55 23
 roger.shi_sh@boschrexroth.com.cn

China

Bosch Rexroth (China) Ltd.
15/F China World Trade Center
1, Jianguomenwai Avenue
Beijing 100004, P.R.China

Tel.: +86 10 65 05 03 80
Fax: +86 10 65 05 03 79

China

Bosch Rexroth (China) Ltd.
A-5F., 123 Lian Shan Street
Sha He Kou District
Dalian 116 023, P.R.China

Tel.: +86 411 46 78 930
Fax: +86 411 46 78 932

China

Bosch Rexroth (Changzhou) Co.Ltd.
Guangzhou Repres. Office
Room 1014-1016, Metro Plaza,
Tian He District, 183 Tian He Bei Rd
Guangzhou 510075, P.R.China

Tel.: +86 20 8755-0030
+86 20 8755-0011

Fax: +86 20 8755-2387

Hongkong

Bosch Rexroth (China) Ltd.
6th Floor,
Yeung Yiu Chung No.6 Ind Bldg.
19 Cheung Shun Street
Cheung Sha Wan,
Kowloon, Hongkong

Tel.: +852 22 62 51 00
Fax: +852 27 41 33 44

alexis.siu@boschrexroth.com.hk

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. A-58, TTC Industrial Area
Thane Turbhe Midc Road
Mahape Village
Navi Mumbai - 400 701

Tel.: +91 (0)22 7 61 46 22
Fax: +91 (0)22 7 68 15 31

India - Indien

Bosch Rexroth (India) Ltd.
Rexroth Indramat Division
Plot. 96, Phase III
Peenya Industrial Area
Bangalore - 560058

Tel.: +91 (0)80 8 39 73 74
Fax: +91 (0)80 8 39 43 45

 rexbang@bgl.vsnl.net.in

Indonesia - Indonesien

PT. Rexroth Wijayakusuma
Building # 202, Cilandak
Commercial Estate
Jl. Cilandak KKO, Jakarta 12560

Tel.: +62 21 7891169 (5 lines)
Fax: +62 21 7891170 - 71

Japan

Bosch Rexroth Automation Corp.
Service Center Japan
Yutakagaoka 1810, Meito-ku,
NAGOYA 465-0035, Japan

Tel.: +81 (0)52 777 88 41
+81 (0)52 777 88 53
+81 (0)52 777 88 79

Fax: +81 (0)52 777 89 01

Japan

Bosch Rexroth Automation Corp.
Rexroth Indramat Division
1F, I.R. Building
Nakamachidai 4-26-44, Tsuzuki-ku
YOKOHAMA 224-0041, Japan

Tel.: +81 (0)45 942 72 10
Fax: +81 (0)45 942 03 41

Korea

Bosch Rexroth-Korea Ltd.
1515-14 Dadae-Dong, Saha-Ku
Rexroth Indramat Division
Pusan Metropolitan City, 604-050
Republic of South Korea

Tel.: +82 (0)51 26 00 741
Fax: +82 (0)51 26 00 747
 gyhan@rexrothkorea.co.kr

Malaysia

Bosch Rexroth Sdn.Bhd.
11, Jalan U8/82
Seksyen U8
40150 Shah Alam
Selangor, Malaysia

Tel.: +60 (0) 3 78 44 80 00
Fax: +60 (0) 3 78 45 48 00
 hockhwa@hotmail.com
 rexroth1@tm.net.my

Singapore - Singapur

Bosch Rexroth SDN BHD.
No.11, Jalan Astaka U8/82
Seksyen U8
40150 Shah Alam
Selangor Darul Ehsan

Tel.: +65 (0) 3 7844 8000
Fax: +65 (0) 3 7845 4800

 kenton.peh@boschrexroth.com.sg

South Africa - Südafrika

TECTRA Automation (Pty) Ltd.
71 Watt Street, Meadowdale
Edenvale 1609

Tel.: +27 (0)11 971 94 00
Fax: +27 (0)11 971 94 40
Hotline: +27 (0)82 903 29 23
 georgv@tectra.co.za

Taiwan

Rexroth Uchida Co., Ltd.
No.17, Lane 136, Cheng Bei 1 Rd.,
Yungkang, Tainan Hsien
Taiwan, R.O.C.

Tel.: +886 (0)6 25 36 565
Fax: +886 (0)6 25 34 754
 indramat@mail.net.tw

Thailand

NC Advance Technology Co. Ltd.
59/76 Moo 9
Ramintra road 34
Tharang, Bangkhen,
Bangkok 10230

Tel.: +66 2 943 70 62
        +66 2 943 71 21
Fax: +66 2 509 23 62
 sonkawin@hotmail.com
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Nordamerika – North America
USA
Hauptniederlassung - Headquarters

Bosch Rexroth Corporation
Rexroth Indramat Division
5150 Prairie Stone Parkway
Hoffman Estates, IL 60192-3707

Tel.: +1 847 6 45 36 00
Fax: +1 847 6 45 62 01
servicebrc@boschrexroth-us.com
 repairbrc@boschrexroth-us.com

USA Central Region - Mitte

Bosch Rexroth Corporation
Rexroth Indramat Division
Central Region Technical Center
1701 Harmon Road
Auburn Hills, MI 48326

Tel.: +1 248 3 93 33 30
Fax: +1 248 3 93 29 06

USA Southeast Region - Südwest

Bosch Rexroth Corporation
Rexroth Indramat Division
Southeastern Technical Center
3625 Swiftwater Park Drive
Suwanee, Georgia 30124

Tel.: +1 770 9 32 32 00
Fax: +1 770 9 32 19 03

USA SERVICE-HOTLINE

- 7 days x 24hrs -

+1-800-860-1055

USA East Region –Ost

Bosch Rexroth Corporation
Rexroth Indramat Division
Charlotte Regional  Sales Office
14001 South Lakes Drive
Charlotte, North Carolina 28273

Tel.: +1 704 5 83 97 62
+1 704 5 83 14 86

USA Northeast Region – Nordost

Bosch Rexroth Corporation
Rexroth Indramat Division
Northeastern Technical Center
99 Rainbow Road
East Granby, Connecticut 06026

Tel.: +1 860 8 44 83 77
Fax: +1 860 8 44 85 95

USA West Region – West

Bosch Rexroth Corporation
7901 Stoneridge Drive, Suite 220
Pleasant Hill, California 94588

Tel.: +1 925 227 10 84
Fax: +1 925 227 10 81

Canada East - Kanada Ost

Bosch Rexroth Canada Corporation
Burlington Division
3426 Mainway Drive
Burlington, Ontario
Canada L7M 1A8

Tel.: +1 905 335 55 11
Fax: +1 905 335-41 84
 michael.moro@boschrexroth.ca

Canada West - Kanada West

Bosch Rexroth Canada Corporation
5345 Goring St.
Burnaby, British Columbia
Canada V7J 1R1

Tel. +1 604   205-5777
Fax +1 604   205-6944
 david.gunby@boschrexroth.ca

Mexico

Bosch Rexroth S.A. de C.V.
Calle Neptuno 72
Unidad Ind. Vallejo
07700 Mexico, D.F.

Tel.: +52 5 754 17 11
+52 5 754 36 84
+52 5 754 12 60

Fax: +52 5 754 50 73
+52 5 752 59 43

Mexico

Bosch Rexroth S.A. de C.V.
Calle Argentina No 3913
Fracc. las Torres
64930 Monterey, N.L.

Tel.: +52 8 333 88 34...36
+52 8 349 80 91...93

Fax: +52 8 346 78 71
mario.quiroga@boschrexroth.com.mx

Südamerika –  South America
Argentina - Argentinien

Bosch Rexroth S.A.I.C.
"The Drive & Control Company"
Acassusso 48 41/47
1605 Munro
Prov. Buenos Aires

Tel.: +54 (0)11 4756 01 40
Fax: +54 (0)11 4756 01 36
victor.jabif@boschrexroth.com.ar

Argentina - Argentinien

NAKASE
Servicio Tecnico CNC
Calle 49, No. 5764/66
1653 Villa Balester
Prov. - Buenos Aires

Tel.: +54 (0) 11 4768 36 43
Fax: +54 (0) 11 4768 24 13
 nakase@usa.net
 nakase@nakase.com
 gerencia@nakase.com (Service)

Brazil - Brasilien

Bosch Rexroth Ltda.
Av. Tégula, 888
Ponte Alta, Atibaia SP
CEP 12942-440

Tel.: +55 (0)11  4414 56 92
+55 (0)11  4414 56 84

Fax sales: +55 (0)11  4414 57 07
Fax serv.: +55 (0)11  4414 56 86
 alexandre.wittwer@rexroth.com.br

Brazil - Brasilien

Bosch Rexroth  Ltda.
R. Dr.Humberto Pinheiro Vieira, 100
Distrito Industrial    [Caixa Postal 1273]
89220-390 Joinville - SC

Tel./Fax: +55 (0)47 473 58 33
Mobil: +55 (0)47 9974 6645
 prochnow@zaz.com.br

Columbia - Kolumbien

Reflutec de Colombia Ltda.
Calle 37 No. 22-31
Santafé de Bogotá, D.C.
Colombia

Tel.: +57 1 368 82 67
+57 1 368 02 59

Fax: +57 1 268 97 37
reflutec@inter.net.co
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